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Related Information Sources

Integration Repository
 The Oracle Integration Repository is a compilation of information about the service 
endpoints exposed by the Oracle E-Business Suite of applications. It provides a 
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets 
users easily discover and deploy the appropriate business service interface for 
integration with any system, application, or business partner. 

 The Oracle Integration Repository is shipped as part of the Oracle E-Business Suite. As 
your instance is patched, the repository is automatically updated with content 
appropriate for the precise revisions of interfaces in your environment. 

Online Documentation
All Oracle E-Business Suite documentation is available online (HTML or PDF).

• Online Help - Online help patches (HTML) are available on My Oracle Support.

• PDF Documentation - See the Oracle E-Business Suite Documentation Library for 
current PDF documentation for your product with each release. The Oracle E-
Business Suite Documentation Library is also available on My Oracle Support and 
is updated frequently.

• Release Notes - For information about changes in this release, including new 
features, known issues, and other details, see the release notes for the relevant 
product, available on My Oracle Support.

Oracle Advanced Planning Command Center User's Guide
This guide describes Oracle Advanced Planning Command Center. It unifies all the 
Advanced Planning applications, such as Demand Management, Real-Time Sales and 
Operations Planning, Strategic Network Optimization, Advanced Supply Chain 
Planning, Distribution Requirements Planning, and Inventory Optimization. It provides
a unified user interface and a single repository for all data. Its flexibility allows users to 
access data from external supply chain planning applications and make it available for 
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reporting and analysis within a unified user interface based on Oracle Business 
Intelligence - Enterprise Edition (OBI-EE).

Oracle Advanced Supply Chain Planning Implementation and User's Guide
Oracle Advanced Supply Chain Planning provides information about supply chain 
planning. Oracle Rapid Planning and Oracle Advanced Supply Chain Planning share 
many features.

Oracle Bills of Material User's Guide
This guide describes how to create various bills of materials to maximize efficiency, 
improve quality and lower cost for the most sophisticated manufacturing 
environments. By detailing integrated product structures and processes, flexible 
product and process definition, and configuration management, this guide enables you 
to manage product details within and across multiple manufacturing sites.

Oracle Collaborative Planning Implementation and User's Guide
This guide describes the information that you need to understand and use Oracle 
Collaborative Planning to communicate, plan, and optimize supply and demand 
information for trading partners across the supply chain.

Oracle Configurator Developer User Guide
This guide contains product documentation for the Oracle Configurator Developer user,
including an appendix of information about Oracle Configurator runtime user interface 
behavior. It describes how to build a configuration model by adding Model structure, 
defining rules, and creating a UI.

Oracle Demand Planning User's Guide
This guide describes how to use Oracle Demand Planning, an Internet-based solution 
for creating and managing forecasts.

Oracle Demantra Demand Management User's Guide
This guide describes the information you need to understand and use Oracle Demantra 
Demand Management.

Oracle Demantra Integration Guide
This guide describes technical information about integrating Demantra with other 
software applications.



xii

Oracle Demantra Sales and Operations Planning User's Guide
This guide describes the information you need to understand and use Oracle Demantra 
Sales and Operations Planning.

Oracle Demantra User's Guide
This guide describes the foundation information you need to understand and use 
Oracle Demantra products.

Oracle Global Order Promising Implementation and User's Guide
This guide describes how to use Oracle Global Order Promising for sophisticated, fast, 
accurate, and flexible order promising.

Oracle Inventory User's Guide
Oracle Inventory provides setup information for Oracle Rapid Planning.

Oracle Inventory Optimization User's Guide
This guide describes the comprehensive Internet-based inventory planning solution that
enables you to determine when and where to hold your inventories across the supply 
chain to achieve the desired customer service levels.

Oracle Order Management User's Guide
This guide describes the necessary information that you need to use and comprehend 
managing your orders.

Oracle Rapid Planning Installation Guide
This explains what you need to do to install Oracle Rapid Planning.

Do Not Use Database Tools to Modify Oracle E-Business Suite Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data 
unless otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data. 

Because Oracle E-Business Suite tables are interrelated, any change you make using an 
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Oracle E-Business Suite form can update many tables at once. But when you modify 
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you 
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle E-Business Suite. 

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite 
automatically checks that your changes are valid. Oracle E-Business Suite also keeps 
track of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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Overview: Rapid Planning

Rapid Planning Implementation and User's Guide: Parts
It has three parts:

• Overview: An overview of the Value Chain Planning suite, the Rapid Planning 
product, and the relationship between the Rapid Planning product and the 
Advanced Supply Chain Planning product.

• Implementation: The process to implement Rapid Planning. It includes how to use 
Rapid Planning to simulate solutions to late-breaking issues since the last Advanced
Supply Chain Planning run.

• Plan Analysis: The user interface views that you use to analyze and execute plan 
results and how to perform late demand diagnosis.

You also need:

• Oracle Value Chain Planning Collections Implementation Guide

• Oracle Rapid Planning Installation Guide

Value Chain Planning Suite
See: Oracle Value Chain Planning Collections Implementation Guide, Overview of Value 
Chain Planning Suite.

Planning Server Architecture
The planning server works with source (execution) systems. It receives supply and 
demand execution information from the source systems and releases supply orders to 
the execution systems.



1-2    Oracle Rapid Planning Implementation and User's Guide

Rapid Planning

Overview
You can create and launch plans in Oracle Rapid Planning. Analyze the results and 
release recommendations to the execution system.

You can also use Oracle Rapid Planning simulation. Copy and re-generate plans to:

• Create alternative scenarios

• Simulate them

• Compare metrics to help select the best one

Collections
Data comes to the planning server through the collections process.

Simulation Sets
After the collected data is in the planning server, you can use it to run a baseline supply 
plan.

You can copy the baseline plan as simulation plans and modify them to create 
alternative scenarios, for example, disable a component and change the working days.

You can change data individually or by using a mass update. Store your changes in 
simulation sets and apply them to the simulation plans.

Rapid Planning Solver
The planning solver is the engine that performs the planning process.

Rapid Planning Workbench
Use the Rapid Planning workbench to:

• View plan inputs

• Simulate changes

• Create, manage, and launch plans

It contains analytic displays and drill-down capabilities.

More than one planner can work on the same plan at the same time
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Plan Comparison Analytics
You can see key performance indicators and metrics:

• For one plan

• Compared among multiple plans

• For your favorites, for example, resources and suppliers

Use them to choose the best plan to use from among the alternative scenarios.

Embedded Analytics
Oracle Rapid Planning provides analysis for key business decisions, for example, clear-
to-build analysis and late demand diagnosis.

Using the clear-to-build analysis and simulation, you can:

• Determine which orders have all their material so that you can release them to 
production.

• Identify which critical orders you need to pull in to meet service level or revenue 
targets, and identify what changes you need to make to the schedule to 
manufacture them.

Using late demand diagnosis and constraint details, you can drill from a late order to 
the root cause then to actions to solve the issue.

Translate decisions into actions
You can release plan recommendations, for example, changed purchase orders, work 
orders, and transfer orders, to the execution system.

Integration with Oracle e-Business Suite
The data that Rapid Planning needs is part of the collected data that is common to all 
Oracle e-Business Suite Value Chain Planning Products.

You use the Rapid Planning Workbench to release recommendations and publish data 
from Rapid Planning to the e-Business Suite execution products.

Planning Solver
The planning solver is the engine that performs the planning process.

Since it emphasizes quickly solving issues and processing simulations, its plans' results 
may not be the same as Oracle Advanced Supply Chain Planning plans' results.
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Planning Method
The Planning Solver plans order-by-order based on demand priority.

Once the Planning Solver has planned an order, it locks the resources and material that 
it used so that other orders cannot use them. It rarely disturbs the plan for a higher 
priority order in the service of a lower priority order.

The Planning Solver attempts to minimize plan nervousness – small changes in input 
data causing large changes to output.

Unconstrained and Constrained Plans
You can run rapid plans that are:

• Unconstrained: You have unlimited capacity.

• Constrained – enforce capacity constraints: Capacity constraints take precedence 
over demand due dates.

Key Features
The Planning Solver plans:

• Alternates: Bills of material, components, and resources

• Effectivities: Component and process

• End item substitution

• Order modifiers

• Safety stock and safety lead time

• Coproducts and by-products

• Firm orders

• Planning time fence

• Calendars: Manufacturing, shipping, and carrier

• Supplier capacity

It does not plan:

• Hub and spoke planning

• Minimum transfer quantity
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• Aggregate resources

• Sequence dependent setups

• Shelf life

Planning Process

Run Collections
Collections run periodically based on business requirements.

The frequency of collection depends on how many and how critical are the transactions 
that you post in the e-Business Suite execution system. Oracle recommends that you run
either a targeted collection or a complete collection on a daily basis.

Plan Options
Before solving a plan, you set plan options. They control:

• Plan behavior

• The organizations

• The demands

There are some plan options that default from profile options.

Launch Plan
The Plan launch process starts the planning solver. It takes the data from the planning 
server, nets supplies, and schedules them.

You can plan in these modes:

• With snapshot: The solver retrieves collected data from the planning server. Use it 
for a complete re-plan or when the collected data is changed since the last re-plan.

• Without snapshot: The solver does not retrieve collected data from the planning 
server. Use it to re-plan after changes that you make in Rapid Planning Workbench.

• Incremental planning: The solver does not retrieve collected data from the planning
server. It freezes certain demands and supplies before netting.

When you launch plans with the option to save it to archive, you can analyze it in the 
APCC dashboards.
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Plan Analysis
Review APCC Demand and Supply Dashboards and RP metrics and KPIs on the Rapid 
Planning Workbench.

You can compare simulations with the baseline plan to help find the best scenario to 
release to the execution system.

Review and accept the plan recommendations and reschedules.

Release to Execution System
You or the planning solver can release planned orders and reschedule schedule receipts 
for make, buy, and transfer items to the e-Business Suite execution system. The release 
process creates purchase requisitions, work orders, and transfer orders. The reschedule 
process changes work orders, purchase requisitions, and purchase orders.

Implementation Steps Summary
To start using Rapid Planning, you use this process.

1. Architecture

You can use a centralized or decentralized deployment. You need to understand the
architecture and technical options.

2. Sizing Template

To size, use the ESG Reference Architecture sizing tool. You answer questions and 
it suggests a hardware and software configuration.

3. Installation and Configuration

You need to install and configure software in support of Oracle Rapid Planning.

4. Collections

This brings the input data that the solver needs from the execution system.

5. Integrations

You can integrate Rapid Planning with other Oracle products:

• Oracle Advanced Supply Chain Planning

• Oracle Demantra Demand Management

• Oracle Demantra Sales & Operations Planning

• Oracle Advanced Planning Command Center
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• Oracle Inventory Optimization

• Oracle Global Order Promising

6. Plan Definition and Modeling

You must decide whether to use unconstrained or constrained plans and set the 
plan options.

7. General Features

You evaluate Rapid Planning features and decide whether to use them. For 
example:

• Safety Stock

• Fixed Days Supply

• Enforce Sourcing Splits

• Clear To Build

• Demand Pull-ins, Upside Processing, and Order Priorities

• Phantoms

• Flow Manufacturing

• Daily Bucketing

• Firm Supplies

• Creating Supplies

• Alternate Supplies

• Bottleneck Resource Planning

• Substitution

• Supplier Capacity

• Planning Time Fence

• Configure to Order

• Default Order Sizing

8. User Interface Modeling
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The views, actions, exceptions, and metrics in Rapid Planning are the tools for your 
planners. Become familiar with them and decide on your processes.

9. Simulations

You can simulate unanticipated events in the business environment and respond to 
them. By comparing multiple simulation plans with the baseline plan, you can 
make the best decision for execution.

10. Best Practices

To have best performance of your Rapid Planning functions, attend to Oracle 
recommendations.
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Implementation: Rapid Planning and 

Advanced Supply Chain Planning

Implementation Decision
You can use either or both of Oracle e-Business Suite's products for supply planning--
Rapid Planning and Advanced Supply Chain Planner (ASCP). Here is some information
about the key features of each. Use it to make sure you have the capabilities that your 
business needs.

Questions Answers

Do you need supply planning that considers 
material and resource constraints to make a 
feasible supply plan?

Yes

Can you work with day level planning and 
not detailed scheduling?

Yes

Does your customer supply chain have many 
constraints and levels?

No

Do you want to do multiple simulations to 
solve planning issues?

Yes

Do you work to satisfy demands based on 
order priority?

Yes

If your business answers are like these, Rapid Planning should suit. If not, consider 
using Advanced Supply Chain Planning for baseline planning and Rapid Planning for 
simulating solutions to pressing planning issues.
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This table compares functions of Rapid Planning and Advanced Supply Chain 
Planning.

Business Requirement Rapid Planning Advanced Supply Chain 
Planning

Detailed scheduling, for 
example, process 
manufacturing

Daily buckets Monthly to minute buckets

Distribution planning 
requirements, for example, 
fair share

No Yes

Project netting No Yes

Customer specific sourcing 
rules

Limited Yes

Shelf life requirements Does not exclude supply 
when expiration occurs 
within the plan horizon

Yes

Plan comparisons Yes Limited

Simulation of alternate 
planning solutions

Yes No 

Editing plan inputs—
demand, supply, and master 
data (Demand, Supply and 
Master Data)

Yes Demand only

Analytics Yes No

Support for sales and 
operations planning process

Yes No

These are features that are available to you in Advanced Supply Chain Planning but not
Rapid Planning:

• Hub and spoke planning

• Peg supplies by demand priority

• Plan to request, promise, and schedule start dates
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• Selecting sales order ship methods

• Supplier flexfences

• Alternate resources for setup and run groups

• Prior and next resources

• Resource firming

• Batch resources

• Flow manufacturing

• Carrier capacity

• Sequence dependent setups

• Engineering change order use-up effectivity dates

• Forecast expiration

• Planned inventory points

• Distribution planning

• Repetitive manufacturing

• Ignore phantom routings

• Simultaneous and alternate resource pairs

• Oracle Project Manufacturing integration

• Oracle Process Manufacturing integration

• Constrained-Enforce demand due date

• Oracle Shop Floor Management integration

• Oracle Complex Maintenance, Repair, and Overhaul integration

• Cross-instance planning

• Cost-based optimization
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Implementation: Architecture

Step 1: Architecture
You can use a centralized or decentralized deployment. You need to understand the 
architecture and technical options.

Technical
The first release of Rapid Planning was a patch on top of release 12.1.1. The first official 
eBusiness Suite release containing Rapid Planning is 12.1.3.

Oracle Rapid Planning works with:

• Other Oracle Value Chain Planning products (destination) including Oracle 
Demantra

• Oracle E-Business Suite execution (source) products

• Oracle JD Edwards EnterpriseOne execution (source) products

• Third-party execution (source) systems

To find out the source and destination releases that work together, see Oracle Rapid 
Planning Release Notes. Navigate to Oracle E-Business Suite Documentation Web 
Library, Release 12.1 or Release 12.2. Click tab VCP and navigate to region Value Chain 
Planning Release Notes.

If the release notes say that certain versions of source and destination systems work 
together, it means that:

• Rapid Planning works in that configuration

• Collections to Rapid Planning works in that configuration

This graphic shows the Rapid Planning engine.
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Oracle WebLogic Server
You deploy Rapid Planning in two domains of the WebLogic Server:

• User interface: ADF components, for example faces and business components.

• Engine: Multiple managed servers that you can scale to handle as many plans as 
you need.

They communicate using web services.

Rapid Planning stores completed plans as binary files in the WebLogic Server. When 
you close a plan, the binary files remain. When you re-open a plan, Rapid Planning 
loads the data into the user interface.

You request Rapid Planning to save completed plans to the database. Use the Save Plan 
action.

When you save the plan, Rapid Planning selectively flushes records into the database. 
For example, it flushes the records from the Supply/Demand view that display in the 
view to table msc_supplies. The Cache Manager of the Rapid Planning solver eliminates
duplicates in the database.

Database Design
Rapid Planning uses the same base tables as Advanced Supply Chain Planning.

It does not use all of the tables that Advanced Planning uses.

There are Rapid Planning-specific columns in some tables, for example, those that Clear
to build and Demand Pull-in use.



Implementation: Architecture    3-3

Functional

Simulation Data Flow
While you perform Rapid Planning simulations, the plan data is in memory and not 
available in the base tables.

Updates that you make in the Rapid Planning UI, for example, demand priorities and 
demand due dates, go into memory as well.

Once you save a plan:

• Rapid Planning flushes the simulation data, for example, updates, planned orders, 
and exceptions, into the base tables.

• You can query it

Regenerative Planning
The data flow of regenerative plans or plans run with snapshot is similar to Advanced 
Supply Chain Planning.

The Plan ID is the reference for which data belongs to which plan. Records have Plan ID
after you save the plan.

Architecture and Deployment Configurations
See Oracle Value Chain Planning Collections Implementation Guide, Architecture.

To find patches, installation instructions, and an upgrade matrix, see MyOracleSupport 
note 746824.1: 12.x - Latest Patches and Installation Requirements for Value Chain Planning 
(aka APS Advanced Planning & Scheduling).

Profile Options
This table shows the Oracle Rapid Planning profile options.
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Profile Name Default Value Values Description

MSC: Rapid Planning
Consume Forecast 
with No Demand 
Class

Null Within Each Bucket, 
After Consuming 
Demand Class 
Specific Forecast, 
Null

This profile option 
specifies the order 
that the forecast 
consumption process 
should use to 
consume forecast 
entries when some of 
them have a demand 
class and some of 
them do not have a 
demand class. Valid 
values are:- Within 
Each Bucket: 
Consume forecast 
entries for the day on 
the sales order; it 
consumes entries 
with matching 
demand class first, 
then entries with no 
demand class. Then, 
it consumes forecast 
entries within the 
backward and 
forward consumption
days; for each day, it 
uses matching 
demand class first, 
then no demand 
class- After 
Consuming Demand 
Class Specific 
Forecast: The forecast 
consumption process 
starts by consuming 
forecast entries for 
the day on the sales 
order with matching 
demand class only. 
Then, it consumes 
forecast entries within
the backward and 
forward consumption
days with matching 
demand class only. If 
there is a remaining 
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Profile Name Default Value Values Description

sales order quantity, 
it repeats the process 
against forecast 
entries with no 
demand class, first on
the day on the sales 
order, then within the
backward and 
forward consumption
days.
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Profile Name Default Value Values Description

MSC: Rapid Planning
Group Planned 
Orders

None None, Demand Level,
Item Level

Determines if the 
planning solver 
groups planned 
orders of the same 
type.

It:

• Groups buy from
and transfer from
planned orders if
the planned 
orders have the 
same start and 
end dates.

• Does not group 
make at planned 
orders.

• Respects order 
modifiers.

Valid values are:

• None: Planned 
orders are not 
combined

• Demand Level: 
Combine 
planned orders 
for a single item 
demand

• Item Level: 
Combine all 
planned orders 
for an item
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Profile Name Default Value Values Description

MSC: Sourcing 
Variance Tolerance 

0.05 Positive number <= 1 Use this profile 
option to specify the 
tolerance that you 
allow between 
sourcing percentages 
and the actual 
percentages in a split 
sourcing window. If 
the difference is 
outside the tolerance, 
the planning solver 
issues exception 
message Sourcing 
split percentage 
violated.

MSO: Sourcing 
Allocation Window

7 Positive integer Use this profile 
option to divide the 
planning horizon in 
to windows. In each 
window, the planning
solver plans to meet 
the split sourcing 
percentages.

Rapid Planning 
Weblogic Server 
Home

Null For example,

/slot/xyz/abc/WL
S/11gNN/WLS_Home

The path of the 
Oracle Rapid 
Planning Weblogic 
server home.
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Profile Name Default Value Values Description

Released WIP Jobs: 
Consider in Clear to 
Build

No Yes/No Use this profile 
option to instruct the 
planning solver 
whether to calculate 
clear to build for 
released discrete jobs.
Valid values are:

• Yes: Calculate 
clear to build for 
released discrete 
jobs

• No: Do not 
calculate clear to 
build for released
discrete jobs

Safety Stock Lead 
Time Method

Safety Stock Percent Do not compute 
safety stock, Use 
Safety Stock Percent, 
Use Safety Stock 
Quantity

Use when you want 
to calculate safety 
stock by quantity.

Note: The Safety 
Stock Method is 
set to MRP 
PLANNED 
PERCENT.

Oracle Rapid Planning uses the MSC: profile options that you set on the Plan Options > 
Advanced tab. See Plan Options.

The planning solver uses these technical profile options. These are not included in the 
Plan Options > Advanced tab:

• MSC: 64 Bit Planner Platform

• MSC: Debug Mode

• MSC: Enable 64 Bit snapshot

• MSC: Hour UOM

• MSC: Snapshot Workers
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• MSC: Wait Time to Obtain Lock on Table or Partition for Snapshot Delete Worker 
(seconds)

These are other profile options that the planning solver uses. See Oracle Advanced Supply
Chain Planning Implementation and User's Guide:

• MRP: Plan Revenue Discount Percent

• MRP: Plan Revenue Price List

• MSO: Inventory Carrying Costs Percentage
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4
Implementation: Sizing Template

Step 2: Sizing Template
To size, use the ESG Reference Architecture sizing tool. You answer questions and it 
suggests a hardware and software configuration.

Overview
To size your hardware and software configurations, use the ESG Reference Architecture
sizing tool. You answer questions and it estimates what you need so that performance 
of your VCP applications is appropriate to match your expected volume.

The tool is based on standard, recommended practices and does not account for 
specialized or highly customized solutions. There can be performance dependencies on 
custom applications or on applications outside of the scope of the components the sizer 
questions and that have significant impact on system configuration. For example, a:

• Custom application deployed on a machine hosting a standard component

• Backend application that sends data or messages in bursts of communication with a
remote application and blocks the execution of automation processes.

You and your Oracle account team are responsible for deciding whether to implement 
the architecture proposed by the sizing tool.

You need to re-plan your size needs for as your plan size approaches the maximum 
limit of the resources that your system supports.

Implementation
See My Oracle Support note 1301231.1: How to Get System Sizing Help for Value Chain 
Planning (VCP) Applications

See Oracle Rapid Planning Installation Guide, System Requirements.



4-2    Oracle Rapid Planning Implementation and User's Guide

Input
The input details for Rapid Planning are similar to other Value Chain Planning 
applications with these differences:

• The middle tier sizing for Rapid Planning plans is critical. Review it carefully to 
make sure that you have adequate resources to run each plan successfully.

• All input parameters play an important part in the sizing. The Item-Organization 
combinations information is critical because it gives the sizer a sense of the plan 
data volume.

• A 32-bit operating system may be too small and will not likely scale in production.

Output
The estimate is for running one plan on one managed server. If you want to run or load 
plans in parallel, multiply this estimate by the number of plans to calculate for the 
WebLogic server total memory required.

See Oracle Rapid Planning Installation Guide, System Requirements, Server Hardware 
Requirements, Multi-tier Solution.

For information on horizontal scaling, see Oracle Rapid Planning Installation Guide, 
Horizontal Scaling.
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5
Implementation Installation and 

Configuration

Step 3 Installation and Configuration
You need to install and configure software in support of Oracle Rapid Planning.

Overview
Use installation and configuration involves:

• System requirements: The hardware, software, and network configurations that you
need.

• Pre-configuration; Things that you need to do after you apply the patch and before 
installation.

• Domains: Creating, setting, deploying, and starting domains, servers, and 
applications.

• Managed servers: Performing actions on manages servers.

• Upgrades: Applying patches.

• Properties, scripts, backups, best practices, and troubleshooting: Miscellaneous 
things to do and know.

• Horizontal scaling: Installing and configuring when your managed servers span 
multiple machines.
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Implementation
See Oracle Rapid Planning Installation Guide, Troubleshooting.
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6
Implementation: Collections

Step 4: Collections
This brings the input data that the solver needs from the execution system.

Overview
The plan input data comes from the execution (source or transaction) systems to the 
planning server.

The data from collections can come from these source systems:

• Oracle E-Business Suite execution products

• Oracle JD Edwards EnterpriseOne execution products: Financials, Forecasting, 
Order Management, Procurement, Inventory, Manufacturing, Configurator 

• Third-party systems

Implementation Decision

Questions Answers

Do you use E-Business Suite as your source 
system?

Yes, use regular collections.

No, use legacy collections.
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Questions Answers

Do you want an automated way that chooses 
the type and frequency of update or do you 
want to control these?

Automated, use continuous collections if your 
source system is E-Business Suite.

You control, use standard collections, with 
modes:

• Net-Change

• Targeted

• Complete Refresh

Implementation Steps
See Oracle Value Chain Planning Collections Implementation Guide. It includes information 
about the entities that the collection process collects.

For more information about Oracle:

• E-Business Suite execution products as a source of collected data, see 
MyOracleSupport note 746824.1: 12.x - Latest Patches and Installation Requirements for 
Value Chain Planning (aka APS Advanced Planning & Scheduling), Upgrade Matrix for 
VCP Products.

• JD Edwards EnterpriseOne execution products as a source of collected data, see 
MyOracleSupport note 1125094.1: Value Chain Planning Integration Documentation 
Library, Oracle E-Business Suite to EnterpriseOne, Oracle Value Chain Planning 
Integration Base Pack 3.1 -- Implementation Guide.
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7
Implementation: Integrations

Step 5: Integrations
You can integrate Rapid Planning with other Oracle products:

• Oracle Advanced Supply Chain Planning

• Oracle Demand Planning

• Oracle Demantra Demand Management

• Oracle Demantra Sales & Operations Planning

• Oracle Advanced Planning Command Center

• Oracle Inventory Optimization

• Oracle Global Order Promising

Overview
Rapid Planning integrates with other E-Business Suite Value Chain Planning 
applications.

It does not integrate with:

• Oracle Process Manufacturing

• Oracle Project Manufacturing: Project, task, Seibel

• Oracle Shop Floor Management
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Oracle Advanced Supply Chain Planning
You use Oracle Advanced Supply Chain Planning and Oracle Rapid Planning together 
to respond to unanticipated events between Advanced Supply Chain Planning runs.

See Simulating Plans from Oracle Advanced Supply Chain Planning.

Oracle Demand Planning
Use this product to develop consensus forecasts. You can use consensus forecasts to 
drive the supply plans.

However, you cannot do so if the plan is a baseline Oracle Advanced Supply Chain 
Planning plan. Use the consensus forecast to drive the Oracle Advanced Supply Chain 
Planning plan instead.

See also Oracle Demand Planning Implementation and User's Guide.

Oracle Demantra Demand Management
Use this product to develop consensus forecasts. You can use consensus forecasts to 
drive the supply plans.

However, you cannot do so if the plan is a baseline Oracle Advanced Supply Chain 
Planning plan. Use the consensus forecast to drive the Oracle Advanced Supply Chain 
Planning plan instead.

Demand Management Features
Global forecasts: You develop forecasts by item in Demantra Demand Management, use
them as input to Rapid Planning, and Rapid Planning distributes them to ship-from 
organizations.

Local forecasts: You develop forecasts by item-organization and use them as input to 
Rapid Planning.

Forecast spreading: Your forecasts in Demantra Demand Management are in week, 
month, or quarter buckets. You can pass these forecasts to Rapid Planning and:

• Net with the same buckets

• Have Rapid Planning spread the bucketed forecasts over daily buckets before it nets

See profile option MSC: Forecast Spreading Calendar.

Forecast consumption: Sales orders reduce forecasts. The planning solver consumes 
forecasts by:

• Item-customer
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• Item-customer-customer site

• Item-zone: Global forecasts only

• Item-zone-customer Global forecasts only

• Demand class

• Item-organization

Use the sales order line date that matches the meaning of your forecast dates:

• Schedule Ship Date

• Schedule Arrival Date

• Request Ship Date

• Request Arrival Date

• Promise Ship Date

• Promise Arrival Date

For consumption by demand class:

• If a sales order has a demand class, the solver consumes a forecast that has the same
demand class.

• If a forecast does not have a demand class, the solver uses its organization 
demand class.

• If a sales order does not have a demand class, the process uses its organization's
warehouse demand class.

• If you consume by demand class and have forecasts without demand classes, 
set profile option MSC: Rapid Planning Consume Forecast with No Demand 
Class.

Forecast explosion: Explode CTO model forecasts to option classes, options, and 
mandatory components. Either explode them in Demantra Demand Management or 
Rapid Planning.

Forecast consumption by bucket

Backward and forward consumption days: Use these if:

• You do not always have an exact match between the sales order line schedule dates 
and forecast entry dates.
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• Your forecast entry quantity is not always sufficient to cover the sales order 
quantities.

Implementation Steps
Navigate to the Plan Options view, Organizations tab.

In the Global Demand Schedules region:

• Select global forecasts

• Select consumption methods

In the Organizations region, select organizations.

In the Demand Schedule region:

• Select local forecasts

• Select consumption methods

Navigate to the Plan Options view, Main tab.

Select a forecast spreading method.

If you consume by demand class and have forecasts without demand classes, set profile 
option MSC: Rapid Planning Consume Forecast with No Demand Class.

See also Oracle Demantra Demand Management User Guide and Oracle Demantra 
Implementation Guide.

Oracle Demantra Sales and Operations Planning
Use this product to manage the forecast development and approval process.

Once you have agreed on consensus forecasts, you can upload them to Rapid Planning 
for additional simulation and planning.

You can use Rapid Planning plans including those that are simulations from baseline 
Oracle Advanced Supply Chain Planning plans, as Sales and Operations Planning 
supply scenarios.

Rapid Planning passes this information:

• Planned Production

• Constrained (Shipment) Forecast

• Planned Shipments

• Dependent Demand
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• On-Hand: Usable available on-hand only

• Safety Stock

• Available Standard (Resource) Capacity

• Required (Resource) Capacity

• Available Standard Supplier Capacity

• Required Supplier Capacity

Repeat this cycle until you have an operational plan.

See Demantra Sales and Operations Planning to Rapid Planning Integration in Oracle 
Demantra Integration Guide.

Implementation Steps
Navigate to the Plan Options view, Main tab.

Select Use for Sales and Operations Planning.

See also Oracle Demantra Sales and Operations Planning User Guide.

Oracle Advanced Planning Command Center
Use this product to view Oracle Rapid Planning information for supply chain analysis. 
This includes plans that are simulations from baseline Advanced Supply Chain 
Planning plans.

You can use it:

• As a business intelligence component

• As a way to narrow down supply chain problems and drill down for analysis

• To develop custom reports and dashboards

This is the sort of information that you can see:

• Supply Chain Analyst Dashboard Pages

• Supply Demand Plan Drilldowns

• Resource Plan Drilldowns

• Exceptions Reports Drilldowns

• Measures
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Implementation Steps
When you save a plan, set Publish analytics to APCC. See Basic Plan Actions, Save Plan.

See also Oracle Advanced Planning Command Center User's Guide.

Oracle Inventory Optimization
Use this product to determine when and where to hold your inventories across the 
supply chain to achieve the desired customer service levels

You can pass its target safety stock recommendations to Rapid Planning as demand.

Implementation Steps
Make the start dates and end dates of the Inventory Optimization forecast buckets the 
same as the start dates and end dates of the Rapid Planning planning buckets.

Navigate to the Plan Options view, Organizations tab.

In the Demand Schedule region, select an Inventory Optimization plan.

See also Oracle Inventory Optimization User's Guide.

Oracle Global Order Promising
Use this product to review projected supplies and suggest promise dates for sales 
orders.

Use Global Order Promising with a Rapid Planning plan as reference instead of an 
Advanced Supply Chain Planning plan as reference if you execute from your Rapid 
Planning plan.

Implementation Steps
Navigate to the Plan Options view, Main tab.

Select ATP Enabled.

See also Oracle Global Order Promising Implementation and User's Guide.

Oracle Collaborative Planning
Use this product to communicate, plan, and optimize supply and demand information 
with trading partners. See Oracle Collaborative Planning Implementation and User's Guide.

Oracle Collaborative Planning (CP) integrates with Oracle Rapid Planning. On the 
supplier collaboration side, you can publish order forecast and safety stock targets to 
suppliers from a Rapid Planning plan and receive supplier supply commits from 
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suppliers. On the customer side, you can publish supply commit information from the 
RP plan to CP. The integration of these two products allows you to forecast 
collaboration workflow between and enterprise and its trading partners.

The integration between CP with RP is very similar to the integration of CP with ASCP. 
The functional workflows are identical.

See the Oracle Advanced Supply Chain Planning Implementation and User's Guide.

Integration makes the following assumptions:

• Oracle Rapid Planning and Oracle Collaborative Planning are deployed on the 
same instance. 

• Rapid Planning plan has been saved. 

• Rapid Planning is able to read Supply Commits that are collected from CP to ODS 
using the Receive Supplier Capacity programs.

The collaboration between RP and CP supports supplier collaboration workflow and 
enables:

• Rapid Planning to publish Order Forecast to Collaboration Planning (Supplier 
Collaboration).

• Rapid Planning to publish Supply Commit to Collaboration Planning (Customer 
Collaboration).

Supplier Collaboration
The first step in a supplier collaboration workflow is to determine the requirements of 
the enterprise from its suppliers. Typically, you do this by planning for the enterprise 
demand in a supply plan that is internal capacity constrained, but is supplier capacity 
unconstrained. When this plan has completed, the requirements on suppliers are 
published from a supply plan to suppliers through a Collaboration platform.

As part of the publish process, planned buy requirements, which are established by the 
supply plan, are translated to Order Forecasts and then published to suppliers. 
Suppliers then evaluate these requirements to determine which ones can be satisfied 
using internal planning tools. Those that can be satisfied are uploaded into 
Collaborative Planning by the suppliers, reviewed by the user and modified, if 
necessary, using Collaborative Planning.

At regular intervals, the enterprise considers the supplier feedback in its next 
constrained planning run. The commit from suppliers that is uploaded into CP 
overrides supplier capacity that may have been established through approved supplier 
lists (ASL). The enterprise locks the resulting plan into for the current cycle. This 
process is repeated for every planning cycle.
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Customer Collaboration
Oracle Rapid Planning supports the customer collaboration workflow and allows Rapid
Planning to publish Supply Commit to customers, based on how supply is pegged to 
forecast or sales order demand. For information on the concurrent programs, refer to 
the Oracle Collaborative Planning Implementation and User's Guide. 

Order Forecast Collaboration
In this collaboration, the order forecast is published from a customer to the enterprise. 
The order forecast signifies a forecast of the quantity that the customer will order from 
the enterprise. In the collaboration cycle, an initial order forecast is first received by the 
enterprise in the collaboration plan. If necessary, the enterprise iterates with the 
customer to refine the order forecast. The order forecast is read in and planned for in 
supply planning.

After the order forecast is planned for in the supply planning engine, the enterprise 
must publish the quantity of forecast that it can satisfy to its customers – this is achieved
through the Publish Supply Commit process. Supply pegged to customer forecast as 
published from the supply plan to CP as "Supply Commit" against the customer.

Deployment of Rapid Planning and Collaborative Planning
Data within Rapid Planning exists in memory, and is available in the database (PDS) 
only when plans are saved through the Save Plan action in the Rapid Planning 
workbench. When data is published from Rapid Planning to CP, that is Publish Order 
Forecast to Suppliers, Supply Commit to Customers, the saved data from the Rapid 
Planning plan is referenced. 

It is possible that you may be running simulations in Rapid Planning, and at a 
particular point of time may want to publish the results to Collaboration Planning. If 
you launch Publish/Receive Programs without saving the plan data, there will be a 
message in the log file associated with the concurrent request, which will indicate that 
you need to save the Plan. 

Invoking Concurrent Requests from Advanced Planning Administrator

You can integrate with CP from within the Rapid Planning Workbench or as an 
Advanced Planning Administrator.

Once any of the programs or functions are selected, the Plan Name field selector must 
include all Rapid Planning plans and the existing ASCP plans. In addition, Rapid 
Planning plans must appear as selectable plans in the list of plans, along with other 
plans.
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8
Implementation: Plan Definition and 

Modeling 

Step 6: Plan Definition and Modeling
You must decide whether to use unconstrained or constrained plans and set the plan 
options.

Responsibility and Menus
The seeded responsibility for Rapid Planning planners is Supply Chain Simulation 
Planner.

It displays these menus:

• Plans, Inputs, and Simulations: The Rapid Planning workbench.

• Collections: Move execution system data to the planning server.

• Sourcing; Specify where item come from.

• Setup

• Other

Unconstrained and Constrained Plans
You can run unconstrained or constrained supply chain plans.

 Unconstrained Plans
An unconstrained plan:
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• Assumes infinite material and resource capacity.

• Overloads resource and supplier capacity.

• Backwards schedules resources from the demand due date. It schedules past due 
resource requirements on the plan run date using compression days. It does not use
planning unit of work.

• Aligns supplies with demand need by dates.

• Issues exception messages related to lead time, material, and resource capacity 
overload risks.

Use unconstrained plans if you:

• Have few material and resource capacity constraints

• Want to know when and how much capacity you need to meet all the demands on 
time

• Want to see the supplies that do not have enough lead time

To learn how the planning solver plans unconstrained plans, see these topics:

• Items to Plan

• General Planning Solver Scheduling

• Lead-time

• Supply Scheduling

Constrained Plans
A constrained plan:

• Balances capacity while meeting customer demand

• Plans around material, resource, and supplier resource constraints using planning 
unit of work.

It does not use compression days.

Use constrained plans if you want the plan to:

• Plan around capacity constraints for resources, suppliers, and lead time

• Schedule supplies with realistic completion

• Calculate the quantity of an item that you can produce to daily capacity
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• Issue exception messages to indicate constraints on the plan results

To learn how the planning solver plans unconstrained plans, see these topics:

• Items to Plan

• General Planning Solver Scheduling

• Lead-time

• Default Order Sizing and Planning Unit of Work

Items to Plan
This topic applies to unconstrained and constrained plans.

There are two plan options that determine the items that are included in the plan.

Planned Item Type: Specifies the subset of items that the planning engine should plan in
a particular plan run.

• MPS Planned: Include items with Planning Method of MPS Planned and MPS/MPP 
Planned

• MPP Planned: Include items with Planning Method of MPP Planned , MPS/MPP 
Planned, and MRP/MPP Planned

• MRP Planned: Include all planned items, that is, include all items unless Planning 
Method is Not Planned

• Distribution Planned: Include all items that are Distribution Planned. There is no 
separate distribution planning logic in Oracle Rapid Planning.

For Rapid Planning plans, you:

• Can use supply chain planning methods Master Production Schedule (MPS) and 
Material Requirements Plans (MRP):

• Cannot use the distribution planning methods Master Production Plans (MPP) and 
Distribution Plans (DRP)

Planned Items: Specifies the types of items that the planning engine should plan in a 
particular plan run:

• All Planned Items

• Demand Schedule items only: Only plan items that have demands. If the demand 
schedule includes substitute items, the planning solver plans them. If plan option 
Include Sales Orders is selected, include only sales orders against those items found
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in demand schedules.

• Demand Schedule and WIP components

• Demand Schedule Items and all sales orders: Plan all items that have demands as 
well as all items that have sales orders against them.

• Demand Schedule Items, WIP components and all sales orders

The largest possible item list is a plan where you select:

• Planned Item Type: MRP Planned

• Planned Items: All Planned Items

General Planning Solver Features
This topic applies to unconstrained and constrained plans.

It follows the item-organization Planning Time Fence:

• It does not set any planned order Suggested Due Dates earlier than Planning Time 
Fence Date.

• The planning engine uses Due Date to determine if the supply is earlier than, later 
than, or on Planning Time Fence Date.

• When planning for a firm supply, any upstream supplies can violate the planning 
time fence to be on time for the firm supply.

For profile option MSO: Firm Work Orders/Operations Within Time Fence, it always 
uses Yes, the default setting.

It follows the Demand Time Fence and the Release Time Fence.

It follows firm flags on supplies.

For planned orders, it does not select alternate BOM/Routings, alternate resources, 
alternate suppliers, alternate source orgs, substitute components and end item 
substitutes.

For scheduled receipts that use alternates, it does not change the alternate selection.

It follows order modifiers.

For definitions of these concepts, see Oracle Advanced Supply Chain Planning 
Implementation and User's Guide.
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Lead-time

Lead-time Introduction
Lead-times are portions of the span of time from recognizing the need for an order to 
receiving the goods to inventory.

This topic reviews the lead-times that the planing process uses to plan and schedule. It 
also explains concurrent processes, profile options, plan options, and planning 
parameters that affect lead-time calculations.

Setting Lead-times
Set lead-time values for the planning process to use in the following source system 
forms:

• Source instance > Oracle Inventory > Organization items form > Item attributes > 
Lead-time tabbed region

• Source instance > Oracle Purchasing > Approved Supplier List form

• Destination instance > Item Attributes Mass Maintenance form

The planning process does not use subinventory lead-times from Oracle Inventory. 
These values are for the Oracle Inventory Min-Max planning process.

Lead-time Item Attributes
This topic describes the lead-time item attributes. You define them:

• For each organization and not for the master organization

• In work days from the manufacturing calendar

For more information, see Oracle Inventory User's Guide.

Lead-time Item Attributes Definition
You can enter the following lead-time item attributes: 

• Preprocessing: The time required to place a purchase order or create a discrete job 
or schedule. This is also known as the paperwork or planning time.

• Fixed: The time required to complete the tasks to make an assembly that are 
independent of order quantity, for example, setup, fixed run time, or teardown 
times.

• Variable: The time required to complete the tasks to make an assembly that depend 
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on order quantity, for example, run time. Oracle Bills of Material concurrent 
processes calculate this time.

• Lead Time Lot Size: The typical quantity of the item that you buy, make or transfer. 
The default value is item attribute Standard Lot Size (set by Oracle Cost 
Management). 

Oracle Bills of Material concurrent process Calculate Manufacturing Lead Time 
uses this value to compute Processing.

• Processing: The time required for a supplier or your transfer from facility to deliver 
an item to your receiving dock or for you to manufacture an item. For make items, 
this is also known as manufacturing lead-time. For buy and transfer items, it 
includes in-transit time to your facility.

For transfer items, the planning engine only takes this lead time into account if the 
item is not planned at your source organization, If the item is planned at the source 
organization, the planning engine uses the lead times from the source organization.

• Postprocessing: For buy and transfer items, the time to receive from the receiving 
dock to inventory or for a make item from production to inventory.

For make items, the time to receive from production to inventory. It includes post-
production activities that you don't model in the item routing, for example, quality 
control analysis and shipping preparation activities. The planning process adds this
time to work orders that you have collected. Set it in the Item Attributes Mass 
Maintenance window, do not set it in the source using the Item Attributes window. 
By-products and coproducts cannot have Postprocessing lead time.

• Cumulative Manufacturing: For make items, the time required to make the item if 
you have all of the buy items in inventory and have to make all subassemblies and 
the item itself. 

• Cumulative Total: For make items, the time required to make the item if you have 
to purchase all of the buy items, make all subassemblies, and make the item itself. 

Lead-times and Order Dates
The lead-times define dates that are associated with planned orders and scheduled 
receipts for these items:

• Order date: The beginning of Preprocessing the date you should begin the 
processing to release the order.

• Start date: The end of Preprocessing and beginning of Processing; the date you, 
your supplier, or your ship from facility should begin work on the order.

• Dock date: The end of Processing and the beginning of Postprocessing. For buy and 
transfer orders, the date that the material should be on your receiving dock. For 
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make orders, the date that you should finish the operations. The supply of a by-
product and a coproduct is ready for downstream consumption on the dock date.

• Due date: The end of Postprocessing and the date that the material should be in 
your inventory. For make orders, put the on-hand on hold to account for the post 
processing lead time.

Lead-time Item Attributes and Lead Time Calculation Concurrent Processes
If you run the following Oracle Bills of Material concurrent processes, they can update 
lead-time values that you may have manually set: 

• Calculate Manufacturing Lead Time

• Calculate Cumulative Lead Time

• Rollup Cumulative Lead Time

These concurrent processes update the following lead-time item attribute fields:

• Fixed: Oracle Bills of Material concurrent process Calculate Manufacturing Lead 
Time calculates this time and update your manual entry for make items. It sums the
values in field Usage for lot-based, scheduled resources. 

• Variable: Oracle Bills of Material concurrent process Calculate Manufacturing Lead 
Times calculates this time and update your manual entry for make items. It sums 
the values in field Usage for item-based, scheduled resources. 

• Processing: The Oracle Bills of Material lead-time concurrent process Calculate 
Manufacturing Lead Time calculates this time and replaces your manual entry for 
make items. It uses calculation Fixed + (Variable * Lead Time Lot Size); if Lead Time
Lot Size does not have a value, it uses 1.

• Cumulative Manufacturing: The Oracle Bills of Material lead-time concurrent 
processes Calculate Cumulative Lead Time and Rollup Cumulative Lead Time 
calculates this time and replace your manual entry. For an assembly, they take each 
component's cumulative lead-time and subtract its operation lead-time offset in the 
assembly's routing. Then, they take the manufacturing lead-time of the assembly 
and add the largest adjusted cumulative manufacturing lead-time of its 
components.

• Cumulative Total: The Oracle Bills of Material lead-time concurrent processes 
Calculate Cumulative Lead Time and Rollup Cumulative Lead Time calculate this 
time and replace your manual entry. For an assembly, they take each component's 
cumulative lead-time and subtract its operation lead-time offset in the assembly's 
routing. Then, they take the manufacturing lead-time of the assembly, add the 
largest adjusted cumulative manufacturing lead-time of its components, and add 
the longest buy part lead-time of its components.
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Decimal lead-time quantities denote times less then one day and are the result of the 
lead-time divided by 24 hours.

For more information, see Oracle Bills of Material User's Guide.

Safety Lead Time
Safety lead-time is a lead-time that you add to the normal lead-time of make and buy 
items. You use it to instruct the planning process to schedule supplies in advance of the 
demand due dates that peg to them for the purposes of:

• Having an inventory buffer to protecting against fluctuations in lead-time, demand 
(for example, forecast error), and supply (for example, variable supplier lead times 
and irregular operation yields)

• Providing a time buffer to recover from fluctuations by taking longer to 
manufacture the original units or by manufacturing more units either to handle 
increased demand or to replace unsuitable parts from the original supply run

Safety lead-time is sometimes referred to as protection time or safety time

You can also complete supplies earlier than the demands that peg to them using 
transient safety stock levels. See the section Safety Stock in the Oracle Advanced Supply 
Chaining Planning Implementation and User's Guide. Use safety stock lead-time instead of 
transient safety stock if you want to have: 

• Lower average inventory level: Safety lead-time creates less excess supply because 
it creates safety stock from supplies pegged to actual demands rather than to 
additional safety stock level demands

• Less late-satisfied demands: There are no supplies pegged to additional safety stock
level demands that compete against actual demands for manufacturing and 
supplier capacity

Safety stock lead-time is:

• Used in constraint-based planning and is not available for unconstrained planning

• A soft constraint. If hard constraints prevent moving the supply due date to honor 
the safety lead-time, the planning process will not honor the safety lead-time

To set safety lead time:

• Set profile option MSO: Use Safety Lead Time to Yes

• For each item-organization, set item attribute Safety Stock Method to MRP Planned 
% then, in item attribute Safety Stock Percent, enter safety lead-time in days.

When the planning engine schedules a supply subject to safety lead-time, it:

• Creates planned orders based on demands
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• Pegs demands to these supplies and uses them to cover transient safety stock 
requirements

• Ignores safety lead-time in forward scheduling so as to meet demand due date

• Inflates the lead-time by the safety lead-time in backward scheduling to plan for 
receipt to stock.

This example shows how to analyze plan information for items subject to safety lead-
time:

• In the diagram, SS means safety stock and PAB means projected available balance.

• Profile option MSO: Use Safety Lead Time = Yes

• Item attribute Safety Stock Method = MRP Planned %

• Item attribute Safety Stock Bucket Days = 5

• Item attribute Safety Stock Percent = 200% = 2 days

• The planning engine ignored transient safety stock, pegged supplies to actual 
demands, and scheduled supplies two days earlier than the demand due dates of 
the demands that peg to them.

• Planned orders on day 4 are for quantities 400, 400, and 200.

• The first planned order of quantity 400 on day 4 is against the transient safety stock 
of quantity 400 on day 1.

• The second planned order of quantity 400 is against the increase in the transient 
safety stock to quantity 800 on day 3.

• A third planned order of quantity 400 is against the increase in the transient safety 
stock to quantity 1200 on day 5. The planning engine splits the planned order of 
quantity 400 into two planned orders of quantity 200 (according to profile option 
MSO: Demand Size Tolerance Before Splitting Planned Orders). The demand on 
day 6 pegs to one planned order of quantity 200; the demand on day 8 pegs to the 
other planned order of quantity 200. 
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This example shows the plan information for the same demand position but using non-
transient/transient safety stock planning. In the diagram, SS means safety stock and 
PAB means projected available balance.

If you use safety lead-time:

• You might accumulate too much material too early. However, resource constraints 
reduce the possibility. By using safety lead-time planning, the risk of accumulation 
should be lower than by using non-transient/transient safety stock planning.

• The planning process might suggest that you delay lower priority demands in order
to meet safety lead-time

Lead-time Item Attribute Notes
You can also view Preprocessing, Processing, Postprocessing, Fixed, and Variable 
among the items information.

The planning engine does not use Cumulative Manufacturing and Cumulative Total 
values. You may see them in lists of values when you are entering lead-times, for 
example, item attribute Planning Time Fence.

Total lead-time is not an item attribute. The planning process calculates it in 
unconstrained plans to determine an order's Order Date. It:

• Begins with the order's Due Date
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• Calculates total lead-time for the order as item Fixed + (Variable * Order quantity)

• Adds Preprocessing to calculate the order's Order Date 

The Calculate Manufacturing Lead-time concurrent process uses the same general 
calculation for Processing as the planning process uses for Total Lead-time. The 
Calculate Manufacturing Lead-time concurrent process uses item attribute Lead-time 
Lot Size to calculate item attribute Processing. The planning process uses actual order 
quantity to calculate the processing time for a specific planned order or scheduled 
receipt.

This diagram shows the relative use of Total Lead-time, Cumulative Manufacturing, 
and Cumulative Total.

Calculations of Cumulative Lead-time Attributes

Calculated Supply Dates
For all plan types, the planning process schedules planned orders and scheduled 
receipts based on Demand Due Date of the demand that the supply is pegged to. It 
calculates these dates:

• Need By Date: The earliest demand due date of all demands pegged to a supply. 
This does not apply to purchase orders, as the need by date for purchase orders is 
the collected date from purchasing.
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• Suggested Due Date: The date by which the supply is available for use by its 
demand. In an Unconstrained or Constrained - Enforce demand due dates plan this 
is the same as Need By Date. In a Constrained - Enforce capacity constraints plan 
this is the scheduled availability date of the supply.

• Suggested Dock Date: For buy or transfer orders, the date the order arrives on your 
receiving dock.

• Suggested Ship Date: For transfer orders, the date of departure from the source 
organization of the last transport used for the transfer.

• Suggested Start Date: The date that you, your supplier, or your ship from facility 
should begin work on the order 

• Suggested Order Date: The date by which you need to place the order. For a 
scheduled receipt, this field displays the date the date that it was created.

Old Due Date, Old Dock Date, and Original Need By Date are the original dates from 
the source system for scheduled receipts.

You can view these dates among the supply and demand information.

Calculating Planned Order Demand Due Date
The planning process takes into account the actual requirement date and the lead-times 
for calculating the planned order demand due dates. This provides more accurate lead-
time offsets in aggregate planning time buckets.

It allows you to plan at aggregate time bucket levels like periods and weeks. It provides 
you easy identification of aggregate supply/demand mismatches and helps you make 
strategic decisions related to equipment and labor acquisition, sourcing etc. without 
generating needless details.

The planning process calculates the planned order demand due dates for dependent 
demands based on the actual requirement date with respect to lead-time. It saves the 
calculated requirement date based on the lead-time value for subsequent calculation.

Then, it aligns all dates to the ends of time buckets. You can get more accurate dates by 
first performing dependent demand explosion followed by alignment.

Example
Consider an organization with an assembly A, which has components B and C.
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Assembly

The quantity per assembly for components B and C is 1.

The lead-time for assembly A = 4

The lead-time for sub-assembly B = 3

The lead-time for component C = 4

The organization follows a weekly planning bucket and working days are Monday 
through Friday.

An order quantity of 1 is placed for item A on Friday February 28.

The planning process generates the following planned order demands:
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Planned Order Demand Due Date Calculation

Explanation:

• Calculated requirement date for B

= Demand Due Date for A - LT 

= February 28 - 4 days 

= February 24 (Monday)

• Demand Due Date for B

= Calculated requirement date for B after bucketing into planning bucket

= February 28 (weekly demands are bucketed into Friday)

• Calculated requirement date for C

= Calculated requirement for B - LT

= February 24 - 4 days

= February 18 (Monday)

• Demand Due Date for C

= Calculated requirement date for C after bucketing into planning bucket

= February 21 (weekly demands are bucketed into Friday)

Date Calculations for Manufactured Supplies
The planning process uses work days from the manufacturing calendar to calculate 
dates for manufactured supplies, unless otherwise indicated.

Need By Date: The date that the material should ship or be in inventory for a next-
higher level assembly. The earliest demand due date that the supply is pegged to.

Suggested Due Date: In an Unconstrained or Constrained - Enforce demand due dates 
plan this is the same as Need By Date. In a Constrained - Enforce capacity constraints 
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plan this is the scheduled availability date of the supply. If the supply is constrained, 
the planning process forward schedules from the constraint.

Suggested Dock Date: Demand Due Date. Dock Date is the day by which all shop floor 
operations are complete. 

Suggested Ship Date: Blank

Suggested Start Date: Suggested Due Date - Production duration. The day that you 
should begin shop floor operations.

Lead-time offsetting begins only on a workday of the workday calendar. For example:

• The workday calendar shows the week of 15 January as 5 workdays (Monday 15 
January to Friday 19 January) followed by 2 non-workdays (Saturday 20 January to 
Sunday 21 January).

• The planning process creates a planned order against item A for quantity 45 with 
suggested ship date 20 January. Processing lead-time for item A is 5 days.

• Since 20 January is a non-workday, the planning process moves to 19 January to 
begin lead-time offsetting and calculates Suggested Start Date 12 January.

Sunday 21 January (non-workday)

Monday 20 January (non-workday) > Suggested Ship Date 

Friday 19 January > Beginning of lead-time offsetting

Thursday 18 January > -1 

Wednesday 17 January > -2 

Tuesday 16 January > -3 

Monday 15-January > -4

Sunday 14 January (non-workday)

Saturday 13 January (non-workday)

Friday 12 January > -5 and Suggested Start Date

Thursday 11 January

Production Duration:

• Unconstrained plans: Fixed + (Variable * Order quantity)

• Constrained plans: Calculated resource and material duration. If the item does not 
have a routing, the planning process uses the unconstrained calculation.

Suggested Order Date: Planned order Start Date - Preprocessing. The date on which you
should place the order. For a scheduled receipt, this field displays the date the date that 
it was created.

This diagram shows dates calculated for manufacturing supplies.
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Dates Calculated for Manufacturing Supplies

Date Calculations for Manufactured Supply Components
The planning process calculates the component due dates of a manufacturing supply 
order according to your setting of the plan option Material Scheduling Method. 

For value Order Start Date, the component due date is the supply Start Date.

For value Operation Start Date:

• Unconstrained plans: The planning process determines the operation that uses the 
component. It begins with the supply Start Date and increases it by lead-time % of 
that operation.

• Constrained plans: Operation Start Date for the operation which uses it

Purchased Supply Lead-times and Approved Supplier Lists
If the item of the purchased supply has an Approved Supplier List, the planning 
process uses:

• Uses its Processing Lead-time value instead of the item attribute Processing lead-
time

• Adjusts Dock Date to conform to its Delivery Calendar value

You can view Approved Supplier List planning attributes among the items information.

Date Calculations for Purchased Supplies
The planning process uses work days from the receiving organization calendar to 
calculate dates for purchased supplies, unless otherwise indicated.

Need by Date: Date that the material is required to satisfy demand.

Suggested Due Date:

• Unconstrained plans: Need by Date

• Constrained plans: The available date of the supply by forward scheduling

Suggested Dock Date:

• Unconstrained plans: Due Date - Postprocessing
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• Constrained plans: The latest delivery day for which the capacity is available and 
the material is needed

• If the purchased supply item has an Approved Supplier List delivery calendar: The 
planning process verifies that the Suggested Dock Date is a work day on the 
delivery calendar. If it is not, the planning solver changes Suggested Due Date to 
the next earliest working day of the delivery calendar.

Suggested Ship Date: Dock Date - Production duration

Production Duration:

• If the purchased supply item has an Approved Supplier List Supplier Processing 
lead-time: Approved Supplier List Supplier Processing lead-time

• If the purchased supply item does not have an Approved Supplier List Supplier 
Processing lead-time: Item attribute Processing

Suggested Start Date: Ship Date

Suggested Order Date: Start Date - Preprocessing. For a scheduled receipt, this field 
displays the date the date that it was created. For collected information, purchase order 
create date. The planning process calculates this date using the organization 
manufacturing calendar.

This diagram shows the calculations for purchased supplies.

Calculated Dates for Purchased Supplies

Date Calculations for Transfer Supplies
The planning process uses work days from the receiving organization calendar and 
shipping organization calendar to calculate dates for transfer supplies.

Need By Date (receiving organization calendar): Date material is required to satisfy 
demand. 

Demand Due Date (receiving organization calendar):

• Unconstrained plans: Need By Date

• Constrained plans: Forward scheduling from the constraint.

Suggested Dock Date (receiving organization calendar): Due Date - Postprocessing

Suggested Ship Date (shipping organization calendar): 



8-18    Oracle Rapid Planning Implementation and User's Guide

• Unconstrained plans: Dock Date - Intransit Time 

• Constrained plans: Dock Date - Intransit Time, considering constrained 
transportation duration. The planning process considers transportation constraint 
maximum transfer quantity per day

Intransit Time is calendar days.

Suggested Start Date (shipping organization calendar): 

• Unconstrained plans: Ship Date - Processing

• Constrained plans: Ship Date. The planning process does not consider a build time 
because the supply may be on-hand.

Suggested Order Date (receiving organization calendar):

• Unconstrained plans: Planned order Start Date - Preprocessing

• Constrained plans: Ship date in the receiving organization, if the shipping 
organization is a planned organization. The constrained plan uses material and 
resource constraints in the shipping organization.

For a scheduled receipt, this field displays the date the date that it was created.

This diagram shows calculated dates for transfer supplies in an unconstrained plan. The
planning process calculates production duration differently for the source organization 
and the destination organizations; therefore, the dates in your plan may not line up as 
accurately as they appear in this diagram. If material is scheduled inside of these lead-
times, planners can determine what action to take on the compression messages.

Calculated Dates for Transfer Supplies, Unconstrained Plan

This diagram shows that, in constrained plans, Need By Date and Demand Due Date in 
the shipping organization should be the same as planned order Ship Date in the 
shipping organization.
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Calculated Dates for Transfer Supplies, Constrained Plan

Supply Scheduling
This topic applies to unconstrained plans only. For constrained plans, see Default Order
Sizing and Planning Unit of Work.

Resources and Suppliers
The planning solver overloads resource and supplier capacity.

It does not schedule resources earlier to minimize resource overload.

It backward schedules resources based on duration when required to meet the make 
order due date.

During backwards scheduling, when it reaches the plan run date, it schedules all earlier
resources on the plan run date.

It issues exception messages for resource capacity overloads, supplier capacity 
overloads, and lead time violations.

If it calculates resource requirements, it issues exception messages Sales order / forecast 
at risk due to a material shortage and Sales order / forecast at risk due to a resource 
shortage.

Compression Days
Compression occurs when the planning engine detects that a supply order needs to be 
completed in less time that its minimum processing time in order for it to meet a 
demand. If the planning engine plans the order according to its lead-time, it would start
in the past (before the planning horizon start date). Compression days is the number of 
days the planning process suggests you reduce the time between the start date and the 
due date).

Make Orders
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For schedule and reschedule of WIP jobs and planned orders for make items, the 
planning solver compresses the first several operations of the make order. The 
operation start dates and end dates are the plan run date.

Compression begins at pre-processing lead time. The planning solver compresses each 
successive operation to no duration until there is sufficient lead time for the remaining 
operations to complete using their resource durations.

Buy and Transfer Orders

For schedule and reschedule purchase orders and purchase requisitions and planned 
orders for purchased items, the planning solver compresses pre-processing lead time, 
then processing lead time, then post processing lead time until there is sufficient lead 
time for the order to complete using the lead times.

Default Order Sizing and Planning Unit of Work
This topic applies to constrained plans only. For unconstrained plans, see Supply 
Scheduling.

Default order sizing creates manageable manufacturing order sizes that are both 
efficient for scheduling resource usage and are efficient to produce.

Order sizes that are too small create shop floor inefficiencies while order sizes that are 
too large are difficult to schedule, can cause supplies to be late for demands and usually
leave significant amounts of unconsumed resource capacity.

To invoke default order sizing, you specify a planning unit of work--a few hours, a 
shift, a day, or a larger time bucket.

Planning Unit of Work

Planning Unit of Work is an item-organization attribute that you specify in hours.

Oracle Rapid Planning uses planning unit of work to determine the order size. Order 
size is how many units you can produce within the planning unit of work time.

For example:

• Since the planning solver considers daily capacities, you can decide that it should 
create planned orders with quantity equal to one production day. In other words, 
because Oracle Rapid Planning only considers daily capacities, then Oracle Rapid 
Planning should create units of work that take a full production day. 

• If you want long production runs, set the planning unit of work, for example, to 
two to three days or two to three weeks duration.

The planning solver uses planning unit of work for constrained planning; for 
unconstrained planning, it uses lead time. It uses planning unit of work to fix the lead 
time for planned orders so it can quickly arrive at a feasible daily schedule. 

Planning Unit of Work Size
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The planning unit of work order size is the number of units of an item that you can 
produce during the planning unit of work time. The planning solver calculates it for 
each primary and alternate routing by dividing the planning unit of work by the 
routing lead time. If you use rounding control, the calculation rounds the planning unit 
of work order size up.

If you have not defined a Planning Unit of Work, then Oracle Rapid Planning uses 
order size quantities that can be produced in a day, depending on resource and material
availability.

Resources and Planning Unit of Work

The planning solver:

• Applies planning unit of work

• Splits resource requirements

• Consumes resource requirements

Resources and Planning Unit of Work: Applying Planning Unit of Work

The planning solver backward schedules the resource requirements from the job end 
time.

The planning solver uses the operation lead time for each operation if resources are 
available within the time that the lead time covers. For example, if the lead time is 10 
hours with 8 hour per day shifts, the lead time spans two days. If the resource 
requirement is 10 hours using a single assigned unit, then resource capacity usage each 
day can be anything from 2 to 8 hours. Fixed lead time is the time required to make one 
unit.

If the planning solver has to move the operation to an earlier day, it schedules to reflect 
the resource usage on that day. For example:

• There is four hours of available capacity in the second day of the operation

• The planning solver schedules four hours on the second day

• The planning solver schedules six hours on the previous day

Resources and Planning Unit of Work: Splitting Resource Requirements

This is how the planning solver splits resource requirements across daily buckets:

• For resource requirements of two hours or less, it can split them over two 
contiguous daily buckets. It searches for a bucket with at least two hours available 
capacity and schedules the remainder of the resource requirement in a contiguous 
bucket.

• For resource requirements more than two hours, it schedules them in a daily bucket

For example:
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• The resource requirement is 4 hours

• The planning solver looks for a bucket that has at least 2 hours (half the 
requirement).

• It finds 3.5 hours in a daily bucket

• It looks in the daily bucket before and after to find the remaining 0.5 hour.

Resources and Planning Unit of Work: Consuming Resource Availability

This example shows how the planning solver consumes resources with daily buckets.

Resource availability:

• Resource A: 8 hours per day

• Resource B: 8 hours per day

Routing:

• Operation 1: Uses resource A; resource requirement = 0.25 hour

• Operation 2: Uses resource B; resource requirement = 0.25 hour

Lead time = 0.5 hour [0.25 + 0.25]

Planning unit of work = 16 hours

Planning unit of work order size = 32 [16 / 0.5], you can produce 32 units in 16 hours

For any planned order quantity from 1 to 32 units, total lead time = 16 hours

• Operation 1 lead time = 8 hours

• Operation 2 lead time = 8 hours

Demand

• Quantity: 60 units

• Due date: Day 8

This diagram shows that the planning solver schedules these planned orders:
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• Quantity = 20 units, days 1 and 2, lead time = 16 hours

• Quantity = 8 units, days 5 and 6, lead time = 16 hours 

• Quantity = 32 units, days 7 and 8, lead time = 16 hours

For the planned order for quantity 32, the planning solver could schedule the 
operations on the same day:

• Day 8: Operation 1, 8 hours consumed [32 * 0.25]

• Day 8: Operation 2, 8 hours consumed

For the planned order for quantity 32, the planning solver could schedule the 
operations on different contiguous days:

• Day 7: Operation 1, 8 hours consumed

• Day 8: Operation 2, 8 hours consumed

For the planned order for quantity 32, the planning solver could schedule the 
operations on different non-contiguous days:

• Day 6: Operation 1. 8 hours consumed

• Day 8: Operation 2, 8 hours consumed

For the planned order for quantity 4, the planning solver could schedule the operations 
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on the same day:

• Day 8: Operation 1, 1 hour consumed [4 * 0.25]

• Day 8: Operation 2, 1 hour consumed

Order Modifiers

The planning solver uses these rules to decide planned order sizes when there are 
conflicts between planning unit of work size and order modifiers:

• If fixed days supply is higher than the planning unit of work size, use fixed days 
supply.

• If fixed lot multiplier is higher than the planning unit of work size, use fixed lot 
multiplier.

• If minimum order quantity is higher than the planning unit of work size, use 
minimum order quantity.

• If maximum order quantity is lower than the planning unit of work size, use 
maximum order quantity.

• If there is a fixed order quantity, use it. All planned orders have the same lead time 
and same quantity.

Key Plan Options
See Plan Options.

Plan Life Cycle Actions
When you select a plan in the Plans region, you can see its information.

This table shows the life cycle of each plan.

Action Plan State

Create Plan Created

Launch Plan Successfully launched

Load Plan Loaded in memory, available for update

Close Plan Closed, not in memory
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Action Plan State

Save Plan Saved to database from memory

Delete Plan Delete plan from memory and database
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9
Implementation: General Features

Step 7: General Features
You evaluate Rapid Planning features and decide whether to use them. For example:

Safety Stock
Safety stock planning helps you in such situations to handle uncertainties in demand 
and maintain higher customer satisfaction levels.

Use this feature if you:

• Are unable to meet demands because of stockouts

• Have uncertainty in your demand and supply lead times

If the demand quantities vary greatly, consider safety stock planning by lead time. 
Otherwise consider safety stock planning by quantity.

Safety Stock Lead Time
The planning solver calculates safety stock lead time if the value of profile option MSC 
Use Safety Lead Time is Yes.

The calculation is:

• Item attribute Safety Stock Percent / 100

• Rounded up to the next integer

The planning solver uses the safety stock lead time to create supplies that are a number 
of days earlier than the actual demand. The process is to try to schedule the supply:

• Early by the safety stock lead time
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• If this is not possible, halfway between the safety stock lead time and the demand 
due date 

• If this is not possible, on the demand due date

The planning solver:

• Only uses workdays

• Never reschedules earlier that the planning time fence

• Applies safety stock lead time when scheduling components that are MRP Planned 
and have a safety stock percent

• Schedules using safety stock lead time of the end item substituted and the 
substitute components

• Does not schedule safety stock lead time for co-products and by-products

Modeling Safety Stock
Oracle Rapid Planning provides two methods of modeling safety stock:

• Lead time

• Quantity

Modeling Safety Stock Based on Lead Time

Oracle Rapid Planning models safety stock to buffer against unexpected demands using
safety lead time. It uses the following item attributes to model

• Safety Stock method: This must be set to MRP PLANNED PERCENT for Oracle 
Rapid Planning to consider safety stock requirements

• Safety Stock Percent: This is a value field that must be populated

Safety Stock Lead Time (SSLT) is an internal field. It is an integer value, which is 
calculated as Safety Stock Percent / 100. During planning, Oracle Rapid Planning creates
supplies that are SSLT days earlier than the actual demand due date. For example, if a 
demand is on Day 12 and SSLT = 5, then the supply is created with a suggested due 
date = day 7, assuming there are no non-working days.

The plan option MSC: Rapid Planning Use Safety Lead Time enables this logic. The 
possible valid values for the plan option are:

• YES: Compute SSLT for items with Safety Stock Method = MRP Planned Percent 
and Safety Stock Percent not null

• NO: Do not compute SSLT
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Modeling Safety Stock Based on Quantity

In order to calculate safety stock by quantity, Oracle Rapid Planning performs two 
tasks. It:

• Converts Safety Stock Percent to Safety Stock Quantity

• Converts Safety Stock Quantity to Safety Stock Percent

To complete these conversions, the assumptions associated with the current safety stock
logic hold.

Converting Safety Stock Percent to Safety Stock Quantity

The Oracle Rapid Planning engine uses Safety Stock Percent as an input in handling 
safety stock requirements. This value can be converted to quantity so that it can then be 
displayed in the user interface. The following steps describe the conversion logic that is 
used by the application:

• Compute Safety Stock Lead Time (SSLT)

SSLT = SafetyStockPercent/100

• Derived safety Stock Quantity (DSSQ)

DSSQ = SSLTxAverage DailyDemandd 

where the Average Daily Demand is computed as an Average divided by the 
Planning Horizon

Note: SSLT can be a fractional value.

An example of the conversion logic follows:

Example
Safety Stock Percent = 100

Demands over a 7 day horizon are: 20, 28, 50, 33, 38, 19, and 28

Safety Stock Lead Time (SSLT) = 100/100 = 1 day

Average Daily Demand over the planning horizon = (20+28+50+33+38+19+28)/7 = 30.85

Derived Safety Stock Quantity (DSSQ) = 1 * 30.85 = 30.85 units

Converting Safety Stock Quantity to Safety Stock Percent

Oracle Rapid Planning has the ability to read in time phased safety stock quantity as an 
input. However, this quantity must be converted to SSLT since the engine supports only
SSLT.

The steps below show the logic that is used to convert a time phased quantity based 
safety stock to a single SSLT value that the engine uses in its safety stock computation:

Time Phased Safety Stock Quantity (SSQi) is an input; where i refers to the occurrence 
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in the time period.

Compute Safety Stock Lead Time (SSLTi):

Average Daily Demand is computed as an Average over the Planning Horizon.

Compute Safety Stock Percent:

The safety stock lead time (SSLT) that the engine will be using in its computations is the
weighted average shown above:

The derived safety stock quantity (DSSQ) will be computed using SSLT.

Note: SSLT can be a fractional value.

To calculate safety stock, there is a new plan option, Safety Stock Lead Time Method. 
This plan option has three possible settings:

• Do not compute safety stock

• User Safety Stock Percent

• Use Safety Stock Quantity

To calculate safety stock using quantity, this plan options must be set to Use Safety 
Stock Quantity.
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Two examples of calculating safety stock quantity are given below.

Example 1

The demands over a 7 day horizon are: 20, 28, 50, 33, 38, 19, and 28. Assume a constant 
safety stock quantity over the horizon of 5 units.

Average Daily Demand over the planning horizon = 30.85

Safety Stock Lead Time (SSLT) = 5/30.85 = 0.16 days

Safety Stock Percent = 16

Derived Safety Stock Quantity (DSSQ) = 0.16 * 30.85 = 4.94 units

Example 2

Average Daily Demand over the planning horizon = 27.86

Safety Stock Lead Time is computed as 4/27.86 = 0.14 days and 6/27.86 = 0.22 days for 4 
and 6 units safety stock quantities respectively

Safety Stock Lead Time (SSLT) computed as weighted average = (0.14 * 3 + 0.22 * 4)/7 = 
0.186

Derived Safety Stock Quantity (DSSQ) = 0.186 * 27.86 = 5.18 units

Note: When determining safety stock by SSLT, SSLT is a rounded down
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integer value. When determining safety stock by quantity, SSLT is used 
as a positive number. Fractional values of up to two decimal values are 
permissible. When the engine plans, it considers SSLT as a positive 
number.

Component Safety Stock

Safety stocks are also computed for components. The calculation of Safety Stock Lead 
Time for components requires component item demands which are not available as 
input (from snapshot) like an end item demand. Demands for components are 
calculated during planning and therefore safety stocks for end items are only 
considered during the first planning run.

At the end of the first planning run components items demands are available. They are 
updated for subsequent planning runs. SSLT for component demands is available after 
the first planning run and is considered in subsequent planning runs. There will always 
be a lag on component safety stock consideration because in each planning run, the 
component items demands generated from previous planning runs, are considered. In 
addition, component items demands are generated using the satisfied quantity of the 
parent end item

Safety Stock Input

The Safety Stock input is fed into and defined by Oracle Rapid Planning in one of two 
ways:

1. Item Attribute Safety Stock Percent

2. Time Phase Safety Stock Quantity

For the input to be fed into Oracle Rapid Planning successfully, Safety Stock Method 
must be set to MRP PLANNED PERCENT.

1. Safety Stock Input Defined by Item Attribute Safety Stock Percent

When Oracle Rapid Planning defines safety stock by Item Attribute Safety Stock 
Percent, the engine performs the following functions:

• Takes Safety Stock Percent as input

• Computes Safety Stock Lead Time (SSLT)

• Schedules orders by buffering for Safety Stock using SSLT

Note: In this case, the SSLT used is a positive number. A fractional 
value is permissible.

• Computes Derived Safety Stock (DSSQ)
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Note: In this case, the SSLT used is a positive number. A fractional 
value is permissible.

The user interface displays the Derived Safety Stock in Material Plan, as computed by 
the engine in the steps in the example above.

Note: If Target Safety Stock Quantity is specified, it will not be 
displayed in this scenario.

2. Safety stock Input Defined as a Time Phased Safety Stock Quantity

When Oracle Rapid Planning defines safety stock as a time phased safety stock 
quantity, the engine performs the following functions:

• Takes Safety Stock Quantity as input. This is the Target Safety StocK.

• Computes Safety Stock Lead Time as a weighted average (SSLT)

• Computes Safety Stock Percent. Populates this as the Item attribute value

• Schedules orders by buffering for Safety Stock using SSLT

Note: In this case, the SSLT used is a positive number. A fractional 
value is permissible.

• Computed Derived Safety Stock (DSSQ).

Note: In this case, the SSLT used is a positive number. A fractional 
value is permissible.

The user interface displays both Target Safety Stock and Derived Safety Stock quantities
in Material Plan, as computed by the engine in the steps above.

Some points to note are:

• There are no drilldowns from Target Safety Stock and Derived Safety Stock rows. 

• Target Safety Stock Quantity is displayed only if plan option Safety Stock Lead 
Time Method is set to "Use Safety Stock Quantity". 

• Target Safety Stock Quantity displayed at the Week or Period level is the value of 
the last day within that Week or Period. 

• Target Safety Stock Quantity and Derived Safety Stock Quantity are not editable in 
the material pan view.
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If the item attribute Target Safety Stock Override is populated in the Item Details 
screens, it updates the Target Safety Stock row in the Material Plan view.

Quantity Based Safety Stock Planning
In order to understand your inventory position more comprehensively, Oracle Rapid 
Planning supports the following methods of planning safety stock in addition to using 
Safety Lead Time: 

1.  User-defined Safety Stock Quantities and safety stock from Oracle Inventory. Item 
safety stock method is Non-MRP Planned.

2. Safety Stock Quantities calculated by Oracle Rapid Planning as a percent of future 
demand. Item safety stock method is MRP Planned Percent.

3. Safety Stock Quantities fed into Oracle Rapid Planning from Inventory 
Optimization. Item safety stock method is MRP Planned Percent.

Introduction to Safety Stock Based on Quantity
Planning safety stock, based on quantity, starts by planning all safety stock demands 
across the supply chain prior to planning all other real demands. This allows the Rapid 
Planning engine to consume any transient safety stock by demands that occur after the 
fall in the safety stock level. This logic ensures that there will be no excess inventory 
due to transient safety stocks. The diagram below and the example that follows 
illustrate this behavior:

Example
Example:

Lead time = 5 days

D1 D2 D3 D4 D5
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Sales Orders 10

Safety Stock 20 20 20 20 20

Onhand 20

Planned Order 10

Available (excluding Safety Stock 
Quantity)

0 0 0 -10 0

Available (including Safety Stock 
Quantity)

20 20 20 20 20

Using the numbers in the table above, planning follows the sequence:

1. Plan Safety Stock on D1. Available Qty on D1 = 0

2. Plan Demand on D4 based on Available (excluding SS). Since LT = 4 days, the 
earliest satisfaction date = D5

3. Plan Demand on D4 based on Available (including Safety Stock). Satisfaction Date =
D4

Safety Stock Set-ups
Oracle Rapid Planning uses the plan option Safety Stock Planning Method and the item 
attributes Safety Stock Method using the following decision chart:
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User-defined Safety Stock Quantities at the Item Level

• Safety Stock Method = Non-MRP Planned

• User entered Safety Stock Quantities (Oracle Inventory > Planning > Safety Stocks)

The safety stock quantities are then collected and used in Oracle Rapid Planning.

Safety Stock Quantity Generated in Oracle Inventory at the Item Level

• Safety Stock Method = MRP Planned %

• Safety Stock Bucket Days = user defined value 

• Safety Stock Percent = user defined value

These item attributes are collected and the safety stock quantities are calculated in 
Oracle Rapid Planning using the following logic:

a. Calculate the daily gross requirements for every item in the supply chain. Daily gross 
requirements is the independent demand + dependent demand.

b. For every day, Day-n, calculate the sum of gross requirements for the safety stock 
demand window. Note that all days are working days based on the organization's 
manufacturing calendar. The demand window is derived as follows:

• Start Date of the window = Day-n + m days 

where m = Safety Stock Bucket Start Offset Days. This is based on a new profile 
option, MSC: Safety Stock Bucket Start Offset Days. This profile option is also 
available as a plan option.

Both Day n and m days are working days based on the organization's 
manufacturing calendar. 

The start date of the safety stock bucket is offset from the current day. This allows 
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Rapid Planning to ignore the impacts of high near term demand which may occur 
due to high backlog demand. 

• End Date of the window = Start Date of the window + n days

where n = Safety Stock Bucket Days (Item Attribute)

c. The bucket days serve as a rolling window, based on working days in the 
organization manufacturing calendar. 

• Safety stock is (Sum of gross requirements for Bucket Days working days * Percent) 
/ (100 * Bucket Days).

• Calculate safety stock as follows where:

Working week = 5 days

Bucket Days = 5

Safety Stock Percent = 100

Note: Safety stock is not calculated on non-working days.

• Safety stock on D1 = (Average daily Gross Requirements in bucket days from D1) *
(SS % / 100)

= [ (10 + 10 + 20 + 20 + 20) / 5 ] * 1.0

= 16

• Safety stock on D21 = (Average daily Gross Requirements in bucket days from D1) *
(SS % / 100)

= [ (10 + 20 + 20 + 20 + 20) / 5] * 1.0

= 18

and so on.

Because Rapid Planning is a day-level planning tool, the safety stock level is a target, 
which is satisfied by the end of the day.

Since component dependent demand is not readily available in the initial bootstrap run 
of a plan, due to the choices of the alternate BOMs or substitute components that the 
plan has not yet made, this example uses the following logic to calculate the dependent 
demand:
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1. In the initial bootstrap run of the plan, the dependent demand for the purpose of 
calculating the gross requirements is based on the primary BOM. The primary 
components use an unconstrained MRP explosion using Fixed and Variable lead 
times.

2. For all subsequent runs, the dependent demand is based on the previous run and 
the choices of alternate BOMs and substitute components made in that run.

In both scenarios, the Total Demand used for Safety Stock Calculation is available along 
with Safety Stock Quantity in the material plan. 

Safety Stock Quantity Input to Oracle Rapid Planning from Inventory Optimization

For Rapid Planning plans, if you want to account for the variability in demand and lead
times in their supply chain, you can specify any Inventory Optimization Plan in the 
demand schedules area of Plan Options. For such items, the Safety Stock Method = MRP
Planned % and will be part of the Inventory Optimization plan.

A Rapid Planning plan can be made up of a combination of items from any of the 
following groups:

• MRP Planned%

• Some of the items have their safety stocks calculated in an Inventory Plan 
(demand schedule) 

• Some of the items have their safety stocks calculated in Oracle Rapid Planning

If an item of this category (SS Method = MRP Planned %) is coming from an 
Inventory Optimization plan as a demand schedule , then the IO generated safety 
stock takes precedence and the other safety stock attributes, that is safety stock 
percent, are not considered. Rapid Planning does not calculate the safety stock for 
that item.

• Non-MRP Planned

• Some of the items have user-defined safety stock quantities.

• Some of the items have safety stock quantities generated in Oracle Inventory.

Plan Option for Safety Stock Planning

The current plan option in the advanced options section, Safety Stock Lead Time 
Method, which configures safety stock planning method, is changed to Safety Stock 
Planning Method. It has the following values:

• Do not plan Safety Stock

• Use Safety Stock Quantities

• Use Safety Stock Lead Time from Safety Stock Percent
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There will no longer be Safety Stock Lead Time using Safety Stock.

Safety Stock Smoothing

In some cases, you may want to reduce the fluctuations in safety stock in the plan but 
do not want to directly use the raw safety stock numbers that come out of either of the 
above mechanisms such as an IO plan, generated in Oracle Inventory or user-defined. 
The following profile options are available so you can control if and how the smoothing
occurs. For example: 

• MSC: Safety stock change interval (Days): The number of working days in the interval 
for smoothing.

• MSC: Smoothing method to calculate Safety stock within Change interval: Starting from 
plan horizon, in every interval, the raw safety stock quantities are smoothed. The 
result is always rounded up to nearest integer. Valid values are Min, Max, and 
Average.

• MSC: Apply Safety Stock Change interval to non MRP Planned Safety Stock: Valid values
are Yes and No. If it is set to No, smoothing occurs only when the item has the 
safety stock method set to 'MRP Planned %', that is, when Rapid Planning 
calculates the safety stock quantities or when they are fed in from IO.

• MSC: Maximum Percentage variation in safety stock values: This decides how the 
smoothing occurs from one interval to the next. For example, using the table above, 

In the 2nd interval, Interval = 5 days

Safety stock after smoothing within the interval using Min option = 10

Safety stock after smoothing across intervals using Max % of 25% = 12

• MSC: Minimum Percentage variation in safety stock values: This option indicates 
the minimum required percentage that triggers an interval to have a different 
safety stock qty. For example:

Safety stock (after smoothing) in Interval (1) = 20

Safety stock (after smoothing) in Interval (2) = 25

Min % variation in SS stock values profile = 50%
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In this example, since the Interval (2) is below the Min % (Interval (1) + 50% = 30), 
the plan further smooths the safety stock by not triggering any change between 
these two intervals and moves to next interval. The result is:

Safety stock (after smoothing) in Interval (1) = 20

Safety stock (after smoothing) in Interval (2) = 20

Safety Stock Pegging

Rapid Planning does not generate actual demand entries for Safety Stock requirements. 
Therefore, there is no pegging created for the supplies that are used to satisfy the safety 
stock requirements. However, the safety stock will consume the inventory buffer like 
any other demand and the plan will ensure that there is enough supply for it, subject to 
other demands being met.

Simulation of Item Attributes

You can edit the following item attributes in both simulation sets and in Plan for 
simulation, what-if analysis. When you change these attributes in Plan, it takes effect 
without running the plan with a snapshot

• Safety Stock Method

• Safety Stock Bucket Days

• Safety Stock Percent

The standard mass edit operations are available for these attributes.

Material Plan

The following measures are currently available in Material Plan. The changes to 
measures are as follows:

• Target Safety Stock: This will represent the time-phased Safety Stock Quantities that
are considered as "input" to Rapid Planning after smoothing. You can edit the 
Target Safety Stock only if the item's safety stock method attribute is Non-MRP 
Planned. 

• Raw Target Safety Stock: This is the Target Safety Stock prior to smoothing.

• You can edit the following in material plan

• Item-Org-Day: Simple update. No allocations

• Item-Org-Week: Applies to all Days in that week

• Item-Org-Period: Applies to all Days in that period

You will be able to edit the Raw Target Safety Stock only if the item's safety stock 
method attribute is Non-MRP Planned.



Implementation: General Features    9-15

Fixed Days Supply
This feature does not appear in all releases. Contact Oracle Support for information 
about your release.

Use this feature if you:

• Place purchase orders in bulk quantities, for example, once a week

• Schedule production in bulk quantities, for example, once a week

The planning solver estimates fixed points (FDS dates) on the planning timeline. It 
creates and resizes supply orders on these days as it processes demands in priority 
order.

For unconstrained plans, it calculates fixed days supply for all items where you set a 
fixed days supply

For constrained plans, it calculates fixed days supply for buy items where you set a 
fixed days supply that have either:

• Sourcing rules assigned to the item with only buy from sourcing. If the sourcing 
rules assigned to an item have buy from and also make at or transfer from, the 
planning solver does not calculate fixed days supply.

• No sourcing rules assigned to the item, but make/buy code of buy.

Processing

It sets the first FDS date on the latest of the:

• Plan start date

• Planning time fence + 1 day. It cannot create FDS dates earlier than a planning time 
fence.

• Latest scheduled receipt + Fixed Days Supply: For work orders, it uses Old Due 
Date.

To set the other FDS dates, it:

• Starts with the first FDS date

• Spaces FDS dates according to Fixed Days Supply

The time between two FDS days is the FDS window. 

The planning solver may have to adjust the length of the first FDS window when it 
needs to respond to a zero or negative projected available balance by:

• Rescheduling the latest scheduled receipt
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• Creating supply before the first FDS date

It may either:

• Move the first FDS date 

• Create earlier FDS dates, if moving the first FDS date results in more than two FDS 
days of supply on the moved FDS date

It does not change the length of the other FDS windows.

The planning solver creates supply only on FDS dates.

The planning solver may have to:

• Finally reschedule a scheduled receipt after it creates planned orders

• Work with a firm scheduled receipt

In these cases, you may see:

• A scheduled receipt and a planned order in an FDS window

• The planned order due before the scheduled receipt

The planning solver does not violate capacity constraints in a Constrained-Enforce 
capacity constraints plan. To deal with a need to create supply where you have 
unavailable capacity, it uses this process:

• Looks to the previous FDS dates to create a build ahead quantity

• Looks to the next FDS dates that have available capacity in their FDS windows

After the planning solver creates planned orders on the FDS dates, it resizes them to 
accommodate fixed lot multiple, then minimum order quantity, then maximum order 
quantity.

When you have sourcing splits, the planning solver:

• Does not split a planned order on an FDS date

• Alternates sources on the FDS dates and attempts to keep the split percentages close
to your percentages

• Issues exception messages for sourcing split violations

When you set both safety stock lead time and fixed days supply for an item, the 
planning solver:

• Calculates fixed days supply

• Does not calculate safety stock
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Views

You can set Fixed Days Supply in a simulation set and see it in the Items view.

You can view Days of Supply and Average Days of Supply in the Material Plan view.

Days of Supply is:

• Calculate available supply for today: Projected available balance of the previous 
day + The supply available today

• Begin with the available supply of today, subtract from it the daily demands on 
each of the following days, until you've used up all of the supply

• Use that number of days as the days of supply for today

For the first day of the FDS window, the planning solver uses 0 for projected available 
balance.

On a non-workday, its fixed days supply is the same as the fixed days supply of the day
before.

For example:

• Demand quantity days 5 to 15: 150 each day

• Projected available balance on day 4: 0

• Supply quantity on day 5: 500

• Supply quantity available on day 5: 500 [0 + 500]

• Remaining supply day 5: 350 [500 - 150]

• Remaining supply day 6: 200 [350 - 150]

• Remaining supply day 7: 50 [200 - 150]

• Remaining supply day 8: -100 [50 - 150], used up all the supply from day 5

• Days of supply: 4 [day 5, day 6, day 7, and day 8]

For example:

• The FDS window is five days

• The demand is quantity 100 on each of the five days

• On day 1, there is a planned order for quantity 500 

• At the end of day 1, there is demand quantity remaining of 400 and there are four 
days left in the period
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• At the end of day 1, the projected available balance is 400

• Days of Supply = 4 [400 / (400 / 4) = 400 / 100] 

Average Days of Supply is 

Projected Available Balance / (The sum of demand in Average Days of Supply 
Calculation Window (Days) / The number of days in Average Days of Supply 
Calculation Window (Days))

Average Days of Supply Calculation Window (Days) is an item attribute and you can 
include it in a simulation set.

For example:

• Average Days of Supply Calculation Window (Days) is 5

• The Average Days of Supply on day 4 is (Projected available balance on day 4 / 
Average daily demand from day 4 to day 8)

• The Average Days of Supply on day 20 is (Projected available balance on day 20 / 
Average daily demand from day 20 to day 24)

The planning solver issues exception message Days of Supply Exceeds Fixed Days 
Supply.

Enforcing Sourcing Splits
Use this feature if you:

• Have contractual obligations to source from suppliers in proportions

• Have business rules to make items in multiple manufacturing facilities in 
proportions

The planning solver splits sourcing of:

• All sourcing types: Make, buy, and transfer

• Rank 1 sources

• Within a time window

Setting Up

Create or verify sourcing percentages and ranks in the Advanced Supply Chain 
Planning sourcing rules and assign them to entities assignment sets.

Divide the planning horizon into windows. Within each window, the planning solver 
splits the supply according to the sourcing percentages. If the cumulative quantities in a
window do not match the sourcing percentages, it may issue an exception message. Set 



Implementation: General Features    9-19

profile option MSO: Sourcing Allocation Window. Use Plan Options view, Advanced 
tab.

Set a tolerance percentage between the sourcing percentages and the actual percentages 
in a window. If the difference between them is more than the tolerance, the planning 
solver issues a Sourcing split percentage violated exception message. Set profile option 
MSC: Sourcing Variance Tolerance. Use Plan Options view, Advanced tab.

Set the start date where the collections starts to accumulate sourcing history. The 
planning engine uses this information to make sourcing decisions. Use profile option 
MSC: Start Date Offset for Sourcing History (in months) in Advanced Supply Chain 
Planning profile options.

Instruct the planning solver to process the sourcing splits. Use Plan Options view, Main 
tab, Enforce Sourcing Splits field.

Processing

In constrained plans, the planning solver favors capacity or due date constraints over 
the soft constraint of sourcing splits.

The planning solver uses only sources with rank 1.

 When you copy these sorts of plans from Advanced Supply Chain Planning, select plan
option Enforce Sourcing Constraints.

Analyzing

 You can see Source, Rank, and Sourcing % in the Supply Chain Bill view. Click 
Exceptions to see the Sourcing split percentage violated exception message.

Clear To Build
Use this feature if you:

• Keep on-hand for most of your component and sub-assembly items

• Like to know which items which orders you can start early or right away

• Reprioritize your orders to peg current on-hand to them

Clear to build tells you whether you can start orders for make items. It depends on 
whether the materials required for these orders are available. An order is clear to build 
if all its components are on-hand.

If you understand which make orders have delay risks due to the lack of component 
availability, you can:

• Expedite component supplies

• Readjust and resequence planned production to expedite clear to build metrics of 
important orders
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An order is clear to build if all its components peg to on-hand. If some of its 
components peg to scheduled receipts, for example purchase order, planned order, 
transfer order, it is not clear to build.

The planning solver can determine clear to build for:

• Planned orders

• Discrete jobs – unreleased

• Discrete jobs – released: Set profile option Released WIP Jobs: Consider in Clear to 
Build to Yes.

Simulation Set Attributes

You set these clear to build item attributes in the simulation set:

• Consider in Clear to Build: Determines whether the planning solver calculates clear 
to build for this item-organization. The default is No.

• Calculate Clear to Build: Determines whether the planning solver calculates clear to 
build in this plan. The default is No.

• Clear to Build Horizon: The horizon where the planning solver calculates clear to 
build KPI metrics. This attribute does not affect when it calculates clear to build for 
orders, but only the time period that it assembles KPIs. The default is the plan 
horizon.

Clear to Build Attributes

The planning solver uses the pegging information to calculate these attributes for each 
make order:

You can see these attributes in the:

• Supply/Demand view

• Clear to Build Simulations view

• Simulation View Contentions view 

Clear to Build Status:

• Yes: All its components are completely available in on hand

• No - On Time: All its components are available when required for the order. Some 
components are not completely available in on hand right now.

• No - At Risk: The Clear to Build Date is later than the Need By Date. The order is at 
risk due to lack of components.

Clear to Build Component Availability %: The percentage of components of the make 



Implementation: General Features    9-21

order, that are completely available on hand.

Ready to Build %: The percentage of the order that you could start now, based on the 
most constrained component. For this to have a value, all components must at least 
partially peg to on hand. 

Clear to Build Date: The date that the order should be clear to build. It is the date that 
the latest component material should arrive in on hand. The planning solver uses, for 
make planned orders, The due date; for buy orders, the dock date plus postprocessing 
time; and for transfer orders, the receipt date plus postprocessing time.

Clear to Build Date (Purchased Components only): Clear to Build Date if you only look 
at buy components.

Delay Due to Clear to Build: Clear to Build Date - Need By Date, in working days from 
the manufacturing calendar). Zero means that the two dates are the same (no delay) or 
that the Clear to Build Date is earlier than Need By Date.

Ready to Build Quantity: The quantity of the order that you could start now, based on 
the most constrained component. For this to have a value, all components must at least 
partially peg to on hand. Ready to Build % * Order quantity.

Make Order Value: Manufactured item standard cost * Order quantity.

Substitute Components Used Indicator:

• Yes: The order uses substitute components

• No: The order does not use substitute components

Clear to Build Example

A make order against Item 1 for quantity 100 due on June 20 uses three components

Component A buy usage = 1, need for this order 100

Component B make usage = 2, need for this order 200

Component C buy usage = 3, need for this order 300

Component A pegged to on hand = 20, quantity 80 scheduled to arrive in on hand on 
June 14 

Component B pegged to on hand = 20, quantity 180 scheduled to arrive in on hand on 
June 30

Component C pegged to on hand = 40, quantity 260 scheduled to arrive in on hand on 
June 14 

The standard cost of item 1 is $45

Clear to Build = No [all components are not completely available in on hand]

Clear to Build Component Availability % = 0 [no components are completely available 
in on hand]

Ready to Build % = 10 [you can start 10 units of the make order, this consumes 10 units 
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of A, 20 units of B, and 30 units of C; (10 units ready to build / 100 order quantity) * 100]

Clear to Build date = June 30 [component B is the latest to arrive in on hand]

Clear to Build Date (Purchased Components only): June 14

Delay Due to Clear to Build: 8 [June 30 – June 20 in workdays]

Ready to Build Quantity: 10 [0.1 * 100] Make Order Value: $4500 [$45 * 1000]

Substitute Components Used Indicator: No

Clear to Build Across Multiple Levels

When a higher-level make order pegs to a lower-level make order that is clear to build, 
the planning server operates as if the lower-level assembly is already available in on 
hand.

In this example, the planned order for:

• SA123 is clear to build: Its components CM1 and CM2 both peg to on hand

• AS66311 is clear to build: Its component CM3 pegs to on hand. Its component 
SA123 pegs to on hand because it is a clear to build order.

Item Descrip
tion

Order 
Type

Reques
ted 
Date

Due 
Date

Order 
Quantit
y

Pegged
Quantit
y

Clear to
Build

Clear to
Build 
Compo
nent 
Availab
ility 

AS66311 End 
Item

Sales 
order

Day 20 - 100 - - -

. 
AS66311

End 
Item

Planned
order

- Day 20 100 100 Yes 100

. . SA123 Sub 
assembl
y

Planned
order

- Day 18 100 100 Yes 100

. . . CM1 Subasse
mbly 
compon
ent

On 
hand

- - - 100 - -
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Item Descrip
tion

Order 
Type

Reques
ted 
Date

Due 
Date

Order 
Quantit
y

Pegged
Quantit
y

Clear to
Build

Clear to
Build 
Compo
nent 
Availab
ility 

. . . CM2 Sub 
assembl
y 
compon
ent

On 
hand

- - - 100 - -

. . CM3 End 
item 
compon
ent

On 
hand

- - - 100 - -

In this example, the planned order for:

• SA123 is clear to build: Its components CM1 and CM2 both peg to on hand

• AS66311 is not clear to build: Its component CM3 pegs to purchase order. Its 
component SA123 pegs to on hand because it is a clear to build order

Item Descrip
tion

Order 
Type

Reques
ted 
Date

Due 
Date

Order 
Quantit
y

Pegged
Quantit
y

Clear to
Build

Clear to
Build 
Compo
nent 
Availab
ility 

AS66311 End 
Item

Sales 
order

Day 20 - 100 - - -

. 
AS66311

End 
Item

Planned
order

- Day 20 100 100 No - on 
time

80

. . SA123 Sub 
assembl
y

Planned
order

- Day 18 80 80 Yes 100
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Item Descrip
tion

Order 
Type

Reques
ted 
Date

Due 
Date

Order 
Quantit
y

Pegged
Quantit
y

Clear to
Build

Clear to
Build 
Compo
nent 
Availab
ility 

. . . CM1 Subasse
mbly 
compon
ent

On 
hand

- - - 80 - -

. . . CM2 Sub 
assembl
y 
compon
ent

On 
hand

- - - 80 - -

. . CM3 End 
item 
compon
ent

Purchas
e order

- - - 20 - -

Using Clear to Build Information in the Supply/Demand View

You can use the Supply/Demand view to

• View the clear to build attributes

• Search on the clear to build attributes

• View the order status: For example, Unreleased or Released

You cannot update the clear to build attributes.

Using Clear to Build KPIs

These are the clear to build KPI metrics. Some are available to Oracle Advanced 
Planning Command Center:

• Clear to Build Orders (%)

• Clear to Build Component Availability %

• Ready to Build %

• Top Shortage Components

• Top Shortage Suppliers
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See Base Metrics, page 15-21.

Clear to Build Simulations

Use the Clear to Build Simulations view to try a more desirable allocation of on-hand to 
competing make orders. You do this by:

• Identifying critical make orders that need to be expedited for clear to build

• Prioritizing them

• Deprioritizing other make orders

• Prioritizing and deprioritizing planned orders

• Deprioritizing sales orders

Clear to Build Simulations: Identifying Critical Make Orders

In the Supply/Demand view, filter for your key sales orders to identify whether there is 
any risk associated with replenishing them. Use filters such as:

• Revenue

• Scheduled Ship Date/Due Date

• Customer

• Ship-From Organization

• Item

Use action View Pegged Make Order Supplies. This shows the make orders that peg to 
the key sales orders and their clear to build attributes.

Select the orders of concern, and use action Clear to Build Workbench. 

Clear to Build Simulations: Prioritizing Make Orders

To prioritize make orders that you want to be clear to build, select Clear to Build 
priority. 

This instructs the planning solver to allocate on-hand supply to these orders with 
priority during the next plan run.

If there is not enough on-hand to satisfy all of the priority clear to build orders, the 
planning solver allocates it in order of order due date.

Clear to Build Simulations: Deprioritizing Make Orders

To deprioritize make orders, select your key make orders, and click View Order 
contentions.

View the display of contenders—other make orders that are contending for the on hand
of the components of your key make orders. The process displays the contenders in the 
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order of the most improvement offered to the key make orders.

Use component allocation to decide which orders to deprioritize.

Select Deprioritize from Clear to Build.

Clear to Build Simulations: Prioritizing and Deprioritizing Planned Orders

If you prioritize a firm planned order, the planning solver uses its date, even if there 
will not be on hand to satisfy its components. It may issue lead time compression and 
overload exception messages as a result.

If you deprioritize a firm planned order, it retains its firmness and date, and the 
planning solver may issue exception messages as a result.

If you prioritize a planned order, it becomes a firm planned order.

If you deprioritize a planned order, the planning solver loses that information when it 
recreates planned orders in the next run.

Clear to Build Simulations: Priority Flag Retention

During each run of a plan, the planning solver keeps the clear to build priority and de-
priority flags for discrete jobs and firm planned orders.

Demand Pull-ins, Upside Processing, and Order Priorities
This section outlines the process and logic though which Oracle Rapid Planning 
respects Pull-ins, Upsides, and Order Priorities. It specifies the mechanism by which 
users can simulate Pull-ins and Upsides and analyze their impact on Planning, while 
respecting the Order Priorities that are set either by the user or computed by an offline 
demand prioritization scheme.

This feature ensures that Rapid Planning meets multiple needs of an enterprise, while 
not compromising its fast simulations, performance and efficiency

This section is divided into the following topics:

• Planning Logic Recap for Oracle Rapid Planning

• Planning Logic for Pull-ins and Upsides 

• New Item Attributes 

• New Exception Messages 

• Identifying Pull-ins and Upsides 

• Examples of Pull-ins and Upsides

Planning Logic Recap for Oracle Rapid Planning

Oracle Rapid Planning solution adheres to the following logic:
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1. Your list of orders is prioritized from the highest to the lowest.

2. The orders are planned, one at a time, starting with the highest priority order.

3. The sequence for each order is to:

• Ensure supply is available upstream to meet the Order Due Date.

• If this is not possible, try to find supply by building ahead ensuring lead times 
are respected.

• If this is also not possible, then try to find supply while minimizing Order 
lateness.

4. After planning an order, that plan is locked before selecting the next order in 
priority list.

5. When planning all the Orders in the priority list, use FIFO logic to peg demands to 
supplies by sorting demands in increasing order of demand satisfaction date.

The objective of the Pull-in logic may be described as follows: If a demand is Pulled-in 
and it succeeds per its priority then no issues but If the Pull-ins fail, that is, the Planning
logic did not find any supply on the revised Order Due Dates, then the logic should 
revert to the pre Pull-in due dates. In case of Upsides, if it fails, it will be recorded as a 
shorted order.

Planning Logic for Pull-ins and Upsides

The planning logic for pull-ins and upsides is as follows:

1. The application considers both orders that are split and those that are not split 
when prioritizing the list of orders. Each order must have:

• Firm date

• Firm Quantity

• Priority (Priority may also be referred to as Primary Order Priority)

• Revised Demand Date

• Revised Demand Priority

2. The application then determines the highest priority of a pull-in and marks all pull-
in orders.

3. All orders with a priority greater than the priority determined in Step 2 are then 
planned using Firm Date and Firm Quantity. The on-hand profile resulting from 
this run dictates how much pull-ins and upsides can be planned:
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• An excess-on-hand at the end indicates the amount of upside that can be 
planned.

• A temporary excess at a specific period indicates the amount of pull-in that can 
be planned during that period.

4. The orders that can be planned are planned, starting with the highest priority as 
determined in Step 2 to the lowest priority or until the supply is exhausted.

If an order to be planned is pulled-in, then:

• Unplan the primary order, keeping track of the Date of Fulfillment for that 
order

Note: The entire order is pulled-in. Partial pull-ins are not 
supported.

• Plan the pull-in order on the Revised Demand Date with the Firm Quantity.

• If Step b fails, then try to build ahead by searching for Firm Quantity between 
Revised Demand Date and Plan Current but ensuring lead times are respected.

• If Step c also fails, then try to find supply to minimize lateness. You can do this 
by searching for supply between Revised Demand Date and Date of Fulfillment
for Firm Quantity.

Note: On-hand profile from Step 3 is used when searching for 
supply.

5. Once planning is complete, using FIFO logic, demands are pegged to supplies by 
sorting the demands in increasing order of demand satisfaction date. However, in 
case of partial pull-ins, the partially pulled-in quantity and the date on which it was
satisfied are also used in the sorting logic.

Note: Make sure a temporary negative On-hand is not created.

Note the following points:

1. Release Orders: Users should have the ability to release the Planning results to the 
source Order Management system.

2. Launch Re-plan with Re-fresh Snapshot: As discussed above, Pull-in and Upsides 
logic is primarily for simulation purposes. The data is saved to the memory only. If 
users launch re-plan with re-fresh snapshot, the changes made to the Plan will be 
lost. 
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3. Late Demand Analysis: Late Demand Analysis is performed as part of the planning 
logic to determine reasons on why an Order was not satisfied on the due date. Some
reasons may include upstream constraints (resource, capacity, etc.). During 
planning of Pull-ins and Upsides, if any of these orders fail, that is if the order is 
unable to be satisfied on the desired due date, the late demand analysis logic should
be invoked so that users can better understand which constraint (material, supplier 
or resource) is the root cause. Understanding the root cause will help users take 
necessary actions to alleviate the constraint.

4. Pegging: As described in the Planning logic, pegging is a post-process done after 
planning wherein demand is pegged to supplies using FIFO logic within a planning
bucket. However, in case of demands being partially satisfied in each bucket, the 
partial quantities and their satisfaction dates are also used in the pegging logic 
thereby ensuring plan quality is not compromised. The supply demand view where
the pegging logic is displayed will display the partial consumptions from different 
buckets.

5. Save Plan: On Planning with Pull-ins and Upsides, if the user likes the results he 
can save the plan using the "Save Plan" feature. Saving a Plan will save the current 
version of the Rapid Planning Plan to the database. This is similar to the current 
feature and has no impact on this enhancement.

Exception Messages for Pull-ins and Upsides

Four new exceptions messages, two for sales orders and two for forecasts, are introduce 
to address lateness of a pull-in order and quantity of pull-in satisfied on the revised 
demand date. They are:

• Late Replenishment for a Pull-in Sales Order: This exception message is flagged 
when the planning logic detects that supplies for a sales order line are due later 
than the sales order line's Revised Demand Date. 

• Late Replenishment for a Pull-in Forecast: This exception message is flagged when 
the planning logic detects that supplies for a forecast are due later than the 
forecast's Revised Demand Date. 

• Sales Orders Pulled-in: This message is flagged for all Sales Orders that have the 
Revised Demand Date populated. It indicates:

• Quantity that has been satisfied by the Revised Demand Date

• Quantity that has been satisfied by the Demand Date

• Forecasts Pulled-in: This message is flagged for all Forecasts that have the Revised 
Demand Date populated. It indicates:

• Quantity that has been satisfied by the Revised Demand Date
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• Quantity that has been satisfied by the Demand Date

Item Attributes for Pull-ins and Upsides

Two item attributes in Oracle Rapid Planning to support pull-ins and upsides:

• Revised Demand Date: This is a date field that indicates the due date of the Pull-in 
Order. A pull-in is created on a demand line if this field is populated

• Revised Demand Priority: This field determines the priority of the pull-in that is 
populated in the Revised Demand Date field. The value in this field is typically less 
than the Firm Date.

The two new attributes are enabled in both Search and Advanced Search functions in all
Rapid Planning Views to aid you in performing searches by Revised Demand Date and 
Revised Demand Priority in addition to the already supported entities. This helps in the
analysis of Pull-in and Upside orders.

Both attributes have the following characteristics:

• They are nullable fields with no default values.

• They are editable.

• You can Mass Update these attributes using the mass update framework. This 
needs to be enabled in the supply demand view.

• They are populated using the existing custom self-service load feature:

• Role: Advanced Planning Administrator

• Drill path: Navigator>Collections: Oracle System> Load Transaction Data Using
Self Service Loads

When you click Load Transaction Data Using Self Service Loads, the Load Data Files 
window appears.
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On this screen you can point to the file that contains the attributes that need to be 
uploaded. Each upload of this file replaces all the data that currently exists in the 
system.

You can use the Download Template link to obtain the format that is required to 
uploading attributes. The names of the attribute template files are:

• demandforecast.dat for forecasts

• salesorder.dat for sales

An example of an Upside and a Pull-in created using the Revised Demand Date and 
Revised Demand Priority fields is shown below:

In the above example, order numbers WMT-1011, XYZ-1011 and XYZ-1212 have either 
been pulled-in or have an upside. Order numbers WMT-1011 and XYZ-1011 are pulled-
in. Notice the Revised Demand Date and Revised Demand Priority for these orders. 
Upside is planned for Order number XYZ-1212 by creating a new manual demand.

Identifying Pull-ins and Upsides
To make sure that Oracle Rapid Planning respects the Order Priorities that were set by 
the user or by an offline process, it is important to identify the Pull-ins and Upsides.
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In Oracle Rapid Planning, upsides are defined as a new demand line with type Manual 
Demand. The priority assigned to this order, its due date, and quantity defines where it 
is planned in the order sequence

A Pull-in is created on a demand line if the Revised Demand Date is populated. The 
priority of the Pull-in is populated in the field Revised Demand Priority. The Revised 
Demand Date should typically by less than the Firm Date. If the Revised Demand Date 
is greater than the Firm date then it is a Pull-out which is possible but this is not normal.

In the example shown in the previous section on the new item attributes, note the 
partial pull-in, fully pull-in and upside in the results. The explanations use the 
information from that example.

Explanation 1

Order Number WMT-1011 is partially pulled-in as shown below:

Firm Date = 18-Feb-09 and Firm Quantity = 1200; Priority = 2

Revised Demand Date = 04-Feb-09 and Revised Demand Priority = 6

Revised Demand Date is less then Firm Date hence the order is pulled-in. The amount 
pulled-in is 1200 and will be planned with Revised Demand Priority 6.

Explanation 2

Order Number XYZ-1011 is pulled in fully as shown below:

Firm Date = 11-Feb-09 and Firm Quantity = 700, Priority = 4

Revised Demand Date is less then Firm Date hence the order is pulled-in. The amount 
pulled-in is 700 (entire quantity) and planned with Revised Demand Priority 7.

Explanation 3

Order Number XYZ-1212 has an upside as shown below:

Firm Date = 25-Feb-09 and Firm Quantity = 2000 with Priority = 5

Manual Demand created with Firm Date = 25-Feb-09 and Firm Quantity = 1500 with 
Revised Demand Priority = 8

The manual demand is an upside planned with the lowest priority, in this case 8. 

In this case, 2000 units of the Order will be planned with the priority of a regular sales 
order while 1500 units will be planned with priority of a Manual Demand as an Upside.
The due date for both demand lines is the same.

Examples of Pull-ins and Upsides
The examples in this section are based on the following assumptions:

1. This logic applies to both Forecasts and Sales Order demand streams

2. Pull-in and Upsides information is fed to Rapid Planning in one of the two ways:
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• From the back end: Pull-in date and Upside quantity along with the associated 
priority against a demand line are populated and fed into Rapid Planning 
through a supported integration scheme. 

• Manually created in the Supply-Demand view: User manually populates the 
relevant fields creating the Pull-in and/or Upside.

3. Priority against a Pull-in is specified in two ways

• Computed by an external Process: An offline demand prioritization scheme 
supports logic that can be based on custom rules to compute the Pull-in or 
Upside priority.

• Manual: You can create or update Pull-ins or Upsides in the Supply-Demand 
view. In this case, you input the priority for Pull-ins and Upsides.

4. Upsides defined for demand lines that are received in Rapid Planning from the 
back end come in as a new demand line with order type set to manual demand.

5. The pegging information displayed when planning with Due Date and with 
Revised Demand Date can be different.

6. In this document, Firm Date refers to Demand Date (due date of the demand line) 
and Firm Quantity refers to the Quantity of the demand line.

7. If the Revised Demand Date is populated, the behavior is as follows:

• Demand Date is copied into the Firm Date 

• Quantity is copied into the Firm Quantity fields 

• Firm date and Firm quantity fields will not be editable.

• Users will be able to edit the Revised Demand Date and Revised Demand 
Priority fields.

• This behavior applies to both Firm and un-Firm demand lines.

Solution Components

 The solution consists of the following components:

• Assumptions in the model (see below)

•  New attributes added to the Order Attribute table and the mechanism to load them

• Ability to identify the pull-in and/or upside date and quantity.
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• Ability to Plan respecting the Pull-in and/or Upside date and quantity and its 
priority.

•  Impacts on Existing Rapid Planning Feature.

A typical workflow describing the user actions in creating a pull-in or an upside is 
shown below:

In this example, four customers are competing for supply from a common hard disk 
vendor. For simplicity, assume the production lead times are zero. Demands are due at 
the start of the week. Step one to five determine the weekly customer demands.

1. The demand priority (customer, pull-in, and upsides) is as shown below:

Customer Priority

CUST-A 1

CUST-M 2
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CUST-C 3

CUST-M Pull-in 4

CUST-C Pull-in 5

CUST-A Upside 6

2. Last week's customer requested demands are as shown below:

Week 1 Week 2 Week 3 Week 4 Week 5 Total

CUST-A 500 500 500 500 2000 4000

CUST-M 200 200 200 1200 1200 2000

CUST-C 500 300 700 100 200 1800

3. The incoming supply picture for the hard drive HDD1 is as shown below:

Week 1 Week 2 Week 3 Week 4 Week 5 Total

HDD-1 1200 1700 1800 1500 1600 7800

4. Given the prioritization, the demand prioritization is as shown below:
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Oracle Rapid Planning uses the above prioritization scheme in planning the 
customer demand.

5. Based on Oracle Rapid Planning's Planning logic, the weekly customer demands are
planned. A temporary excess in bold in the tablet below: 

Week 1 Week 2 Week 3 Week 4 Week 5

Supply 1200 1700 1800 1500 1600

Buffer 
Balance

1200 2900 4700 6200 7800

CUST-A 500

700 2400 4200 5700 7300

500

700 1900 3700 5200 6800

500
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700 1900 3200 4700 6300

500

700 1900 3200 4200 5800

2000

700 1900 3200 4200 3800

CUST-M 200

500 1700 3000 4000 3600

200

500 1500 2800 3800 3400

200

500 1500 2600 3600 3200

1200

500 1500 2600 2400 2000

200

500 1500 2600 2400 1800

CUST-C 500

0 1000 2100 1900 1300

300

0 700 1800 1600 1000

700

0 700 1100 900 300
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100

0 700 1100 800 200

200

Temporary 
excess is in 
bold.

0 700 1100 800 0

6. The current week's demands are revised with upsides and pull-ins.

Week 1 Week 2 Week 3 Week 4 Week 5 Total

CUST-A 500 500 500 500 3500 5500

CUST-M 200 1400 200 0 200 2000

CUST-C 500 1000 0 100 200 1800

7. Based on the chart above, there is an upside of 1500 units in Week 5 for Customer-
A. Customers M and C have a Pull-in of 1200 units in Week 2 and 700 units in Week
3 respectively.

8. Normally, Rapid Planning is able to plan for the revised demands for this week, as 
shown in Step 6, because it has the temporary excess, (see Steps 5 and 6). If it can't 
plan the upsides and pull-ins from this week's revised demand, it goes back to the 
plan and reverts to the solution shown in in Step 5, which does not consider the 
revised commits.

Phantoms
Oracle Rapid Planning plans phantom assemblies and their bills of material like 
standard items.

You cannot release planned orders for phantom assemblies.

Oracle Rapid Planning does not use profile option MSC: New Planner Backward 
Compatibility
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Flow Manufacturing
You can:

• Plan supplies for flow items using line rates in flow routings 

• View planned orders, flow schedules, and time phased material plans for flow 
items

• Release flow schedules

Setup

Define flow items using template Flow Assembly.

Define a production line with minimum and maximum hourly rates. Flow 
Manufacturing does not use fixed and routing-based lead times.

Associate the production line with the item routing.

Create bills of material.

Create demand schedules.

Process

The planning solver:

• Does not plan operations of the flow item

• Plans for components on hand at the beginning of the process

• Plans the line rate from the maximum hourly rate of the production line. It does not 
use minimum hourly rate

• Creates flow schedules as daily planned orders

• Calculates resource usage form the maximum hourly rate: For example, if the 
maximum hourly rate if 10 units per hour, the resource usage is 0.1 [1 / 10].

• Calculates daily capacity: For example, if the maximum hourly rate is 5 units and 
the line runs 20 hours per day, the daily capacity of the line is 100 units [5 * 20]

• Sets by-product and scrap due dates to the suggested due date of the flow schedule

Flow schedules are firm. The latest flow schedule creates a natural time fence and the 
planning solver does not create flow schedules earlier than it. If new demands appear 
before the natural time fence, the planning solver plans to satisfy them late. 

Exception Messages

In unconstrained plans, the planning solver always schedules daily supply to meet 
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daily demand. If the daily demand is higher than the daily capacity, the planning solver
issues resource overloaded exception messages.

In constrained plans, the planning solver never plans to exceed daily capacity. If the 
daily demand is higher than the daily capacity, the planning solver meets the demand 
late and issues late demand and resource overloaded exception messages. The line 
appears in the Constraint Details page as a root cause of late demand satisfaction.

To research late demand, use page Constraint Details, find the production line in 
column Department/Line and look for a Resource Constraint.

For resource overloaded, find the production line in column Department/Line.

Viewing

To view flow information in Rapid Planning, use pages:

• Resources: Department/Line and Resource (the production line), Max Rate. 
Operation Sequence Number and Resource Sequence Number are zero. 

• Processes: Department/Line and Resource (the production line) and Rate or Usage 
[1 / Max Rate]. Operation Sequence Number and Resource Sequence Number are 
zero.

• - Resource Requirements: Department/Line and Resource (the production line), 
Adjusted resource Hours, and Schedule Quantity. Operation Sequence Number and
Resource Sequence Number are zero.

• Resource Availability: Department/Line and Resource (the production line), 24 
Hour Resource, From Time and To Time (for non-24 hour resources)

• Resource Plan: Available Capacity [Maximum hourly rate * Hours per day, daily 
with UOM = EA], and Required Capacity [flow schedule quantity, daily with UOM 
= EA], Net Capacity Available [Available Capacity - Required Capacity], and Cum 
Capacity Available [Required Capacity / Available Capacity]

• Supplies and Demands: Order Type is Flow schedule

• Metrics: Department/Line and Organization and Department/Line, Organization 
and Week

Simulating

To change line capacity for the entire planning horizon, navigate to the Resource page 
and change the maximum hourly rate.

To change line capacity for an interval of time, navigate to the Resource Availability 
page change resource duration and capacity units. You cannot change the maximum 
hourly rate for specific time buckets.

Run the plan without refresh snapshot.

Releasing
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You cannot release planned orders for flow lines.

Run concurrent process Push Plan Information:

• In Plan Type, select Supply Chain Simulation Plan.

• In Plan Name, select the plan with the flow schedules.

Implement the flow schedules in the Line Scheduling Workbench.

Daily Bucketing
Oracle Rapid Planning buckets these entities by day.

Resource and supplier capacity. It:

• Is a strategic planning tool that wants to minimize planning solver processing time

• Does not do detailed shop floor scheduling and does not schedule resources down 
to the minute.

Demands and supplies. It does not assign a timestamp

Available resource capacity:

• If a make order is scheduled that uses 8 hours of capacity on Day 1 and 1 hour of 
capacity on Day 2, the planning solver does not assign a particular hour for the 
resource requirement on either Day 1 or Day 2

• The planning solver assumes that resource capacity availability in a daily bucket is 
continuous.

Work in process job completion dates. The job completion date is typically in the last 
daily bucket where the final activity consumes resource capacity but can be later in 
some cases. These are the scheduling rules:

• A single resource activity is typically scheduled within a single daily bucket. The 
resource activity can be scheduled in two contiguous daily buckets with some 
resource usage on each day. However, a single resource activity is never scheduled 
in non-contiguous daily buckets.

• A single resource requirement for two hours or less is scheduled in a single daily 
bucket.

• In a single operation, two or more resources are always scheduled contiguously. 
That is, there are never daily gaps in the scheduled resources for a single operation.

• Two operations can be scheduled with gaps more than one day between the 
operations.
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• If the planning solver cannot bucket all of the resource usage into a daily buckets, it 
creates multiple planned orders for scheduling flexibility.

Large resource requirements:

• If resource requirements are more than one day for a single resource, the planning 
solver expands the resource capacity bucket and spreads the resource requirement 
over several days.

• The plan information shows the start date and the end date of the resource 
requirement and also shows the resource usage on each day. The start date and end 
date of the resource requirement may not match the resource usage precisely due to
the estimation of lead time.

• It schedules resources within an operation contiguously

• It does not necessarily schedule operations contiguously

• It can schedule resource requirements more than two hours over contiguous daily 
buckets

• If it must bucket some resource requirements into larger than daily buckets, it can 
still use daily buckets for the other resource requirements on the routing.

Firm Supplies
Use this feature if you:

• Firm supplies to avoid re-planning changes to them

• Use firm supplies as plan input data to Rapid Planning

Order and Resource Firming
You can firm supplies in these ways.

Planned orders; you can:

• Firm the supply and enter a new date and a new quantity

• For a make at order, select and firm an alternate bill of material and routing 
combination. If you do not re-run the plan after this change, a release of the planned
order only creates the order header

• For a buy from order, select and firm an alternate source.

• Select and firm a substitute component.
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Non-firm work in process job:

• You can firm the supply and enter a new end date. Re-run the plan to have the 
planning solver recalculate the resource and component requirements in the next 
plan run.

• If you firm a work in process job in the source, the planning solver does not change 
its resource and component requirements

Non-firm purchase order:

• Firm the supply and enter a new date and a new quantity

• The planning uses Suggested Due Date unless you enter New Date. The planning 
solver then sets the Suggested Due Date to the New Date and reschedules all 
related activities.

Scheduling Firm Supplies
The planning solver does not change the suggested due date or quantity of a firm 
supply. 

When the supply is firm the planning solver:

• Cannot change resource schedules

• Can overload resource or supplier capacity

The planning solver first processes firm work orders and firm planned make orders 
against the highest priority demands. It does this without regard to the demand 
priorities. However, it never makes a demand late by using a firm order.

After it processes firm work orders, then it schedules supplies for demands by priority 
using non-firm work orders and planned orders.

If a supply is firm, the planning solver treats all upstream supplies as pegged to a firm 
and they are not allowed to be late. This means that these orders can be compressed in 
the same manner as unconstrained planning. This does not apply to supplies that are 
firmed because of the planning time fence.

Scheduling Non-firm Supplies
To schedule non-firm supplies, the planning solver uses the same idea as scheduling 
firm supplies but also considers supplies that are after the demand due date.

This is the process: 

• The planning solver uses non-firm supplies and does not change the suggested due 
date order of work in process supplies needlessly
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• It continues to use non-firm supplies until it has selected all of them.

• For non-firm supplies that are later than the demand date, the planning solver tries 
to reschedule them in to meet the demand on time. It does not select alternate 
resources, substitute components, or alternate bill of material and routing 
combinations for work in process supplies.

• If this is not possible for a supply, the planning solver creates planned orders to 
meet the demand on time.

• If this is not possible for a supply, the planning solver creates planned orders as 
close to the demand date as possible. If a planned order date is the same as a 
scheduled receipt and there is available capacity for the existing supply, it uses the 
scheduled receipt for the lower priority demand as well, even though the supply 
may be late.

To specify your preferences for work order vs. planned order pegging, you can use 
Oracle Rapid Planning item attribute No planned orders before WIP window in 
simulation sets.

• The default value is 10.

• Work orders outside of this window do not affect planned order creation.

• In this number of days from plan start date, the planning solver does not create 
planned orders that are due earlier than work orders are due.

• It tries to reschedule in the work orders first, then uses planned orders outside this 
window if work order reschedules will meet the demand late.

The planning solver right-justifies non-firm orders to the right to minimize excess. It 
does this only if they are outside of the range you specify in item-organization attribute 
Acceptable Early Days.

Creating Supplies
The planning solver does not create planned orders if:

• There is no available resource capacity or material capacity during the planning 
horizon

• The plan horizon is shorter then the lead times, planned orders are not created

Oracle Advanced Supply Chain Planning creates planned orders at the end of the plan 
horizon due to constraints during the plan horizon. The Oracle Rapid Planning solver 
generates exception message Demand Quantity not Satisfied and does not create 
planned orders at the end of the plan.
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If the planning solver cannot create a complete supply for a demand, it sets its material 
satisfied date to the day after the end of the planning horizon.

Alternate Supplies
Use this feature if you:

• Use alternate bills of material, routings, and resources

• Want to use alternate supplies wherever possible to meet demands

The planning solver considers all alternates as supplies to meet demands.

The search path is depth first and then breadth. During the search, the planning solver 
may find partial quantities and then continue the search for the remaining quantity 
required to meet the demand. It uses partial quantities only if they satisfy the order 
modifiers.

This is the search order.

The primary source is searched first based on the sourcing rules:

• First use on hand, then in receiving, then scheduled receipts

• Check each source all the way down the supply chain for supply availability before 
considering the next lower ranked source

• Search each alternate source at all levels before moving on to the next alternate 
source

The sourcing rule primary source is the rank 1 source with the highest % allocation. The
planning solver searches all rank 1 sources with allocation percents before rank 2 
sources.

If multiple rank 1 sources have the same allocation percents, then the engine selects one 
to search first.

If there is make source on the search path:

• First, search the primary bill of material and routing combination using any 
substitute components and alternate resources

• Then, search each alternative successive bill of material and routing combination 
using any substitute components and alternate resources. Search alternates in bill of
material rank order.

The planning solver continues searching alternate sources until it considers all of them.

Search for the first substitute item using its complete search path.

Continue searching for each successive substitute item using its complete search path.

If the demand cannot be met on time, re-search and attempt to minimize the supply 
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lateness. Use an alternate source may be used to create a late supply if the primary 
source supply date is after the alternate source supply date.

Bottleneck Resource Planning
All resources default as bottleneck resources. You must clear the flags manually.

In simulation sets, you can select a bottleneck flag for resources in constrained planning.

• Selected: The planning solver schedules resources to avoid overloads. It may 
schedule resource requirements early due to resource capacity loads or the planned 
order late because of resource capacity loads.

• Cleared: The planning solver calculates resources requirements and notes resource 
duration. It can overload resources and issues exception messages. It schedules the 
resource requirement as needed and never early because of resource capacity loads.
The planned order is never late because of resource capacity loads but can be late 
because of uncompressed resource duration.

There are no bottleneck resource groups.

Substitution
Use this feature if you have similar products where you can:

• Satisfy the demand for one item with supply of another item

• Use one component in place of another component

Rapid Planning plans both:

• End-item substitution

• Component substitution

The planning solver works with only these features of end item substitution. See Oracle 
Advanced Supply Chain Planning Implementation and User's Guide.

• One-directional

• Two-directional

•  Inference

Planning attributes: If a plan specifies a substitution set, the planning solver uses it You 
must use a substitution set for end item substitution.

The planning solver does not use these profile options but behaves as if they are set to 
these values:
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• MSO: Choice of supply for substitution: All supplies

• MSO: Disable Inference of Item Substitution Relationship: Yes.

• MSC: Choice of Items for which to Create Supplies in a Substitute Relationship: 
Follow Item Attributes

• MSO: Use Effectivity Dates to Infer End Item Substitute Priority: No

You can always use partial substitution supplies to satisfy end demands. The planning 
solver does not use customer-specific end item substitution rules.

Component Substitution
Oracle Rapid Planning supports component substitution and allows you to control how
the substitution occurs and in which order it occurs. As long as demand can be met on 
schedule, Rapid Planning follows one of the following behavior:

• When substitute parts are very similar in their specification and cost to the primary 
component or the substitute component is in its end-of life phase, you can use up 
the supply before buying or making the primary component. In such cases, you 
may want to use the Unhand and Scheduled Receipts of the substitute component 
before you create a new order for the primary component.

• Sometimes it is advantageous and cost effective to create new supplies on the 
primary component, for example, when the substitute component is either more 
expensive than the primary component, or it is over-specified, such as a 4 GB card 
being substituted for a 2 GB card.

Perhaps it is just a poor replacement for the current item, such as replacing the 
required 2% resistor with 1% resistor. In a case like this, it only makes sense to 
substitute the primary component if you cannot meet the demand on time using 
either existing or new supply for the primary component.

You can switch between the two behaviors as the need arises.

Oracle Rapid Planning engine searches for component supplies, full or partial, which 
are capable of meeting the demand on time. If it cannot find any, it discards that search 
and moves to the next step. It looks for component supplies at every level in the 
following order:

1. Existing supplies of primary component (including on hand and schedule receipts, 
that is Purchase Orders, Requisitions, Firm Work Order, and non-standard jobs) 

2. Existing supplies of substitute

3. Create new supplies of primary 
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4. Create new supplies of substitute 

In case the requirement is met by partial quantities of substitute and primary, the make 
order of the assembly should not be split. It should still be one single order or as 
needed, based on the order modifiers, but with component requirements spread 
between primary and substitute.

Note:  Normally, non-firm WIP is not considered as part of existing 
supplies in the search for primary and substitute components.

Example
For example:

Finished good A has a sourcing rule setup of Rank 1 as Transfer and Rank 2 as make, 
with B and C components. C1 is a substitute for C. The search order is to transfer A to 
meet demand on time. If this is not feasible, then Rapid Planning uses existing supplies 
of C first and then existing supplies of C1.

You can control the order of how the search for supplies upstream is done. That is, 
using these controls, you can configure the search order to be as follows:

1. Existing supplies of primary

2. Existing supplies of substitute

3. Create new supplies of primary

4. Create new supplies of substitute

For more information on how to set the controls, see User Controls for Component 
Substitution in this document.

When creating new supplies, the Rapid Planning engine uses the order you prescribe 
for the primary and every alternate BOM in the priority order. This search order is 
honored as long as the demand can be met on time. But if there are existing supplies of 
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the substitute (step 2 above), the Rapid Planning engine may choose to create new 
supplies on primary (step 3 above). This may happen if using the existing supplies on 
substitute could potentially delay the demand due to constraints or lead-time, and the 
creation of new supplies on the primary could cause the demand not to be met on time

The Rapid Planning engine evaluates the options of creating supplies on primary versus
substitute to minimize lateness. For example, if the demand is due on D20, and if 
neither the primary nor the substitute's existing supplies are available to meet the 
demand on time, the engine does not create the new supply on primary if it pushes the 
demand to D25, if it can create the new supply on substitute that will satisfy the 
demand earlier, say on D22.

Level by Level Searching

When Rapid Planning searches for existing supplies of a substitute component, it 
searches the current level as well as all upstream levels, one level at a time. In doing so, 
it allows you to specify which items qualify for this multiple-level search and which 
items in the chain qualify for the upstream search.

Using these controls, you are able to refine the search order to be as follows:

1. Existing supplies of primary

2. Existing supplies of substitute 

3. Create new supplies of primary with existing supplies of upstream components, 
level by level 

4. Create new supplies of substitute with existing supplies of upstream components, 
level by level

5. Create new supplies on primary 

6. Create new supplies on substitute

Lateness Threshold

Component substitution not only ensures that demand is met on the due date, it also 
allows certain configurable offset so that the demands satisfied within the window from
the due date are also considered as on-time. 

This is achieved by using a new plan option, Lateness Threshold for Consuming 
Existing Supplies. You can set this plan option to any positive integer. The default is 
zero.

Example
For example:

In the following example, the Finished Good (F) is made of 2 primary components (P1, 
P2) which have substitute components (S1 and S2 respectively). Each of these 
components is made using the BOM shown below.
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Assuming there is on hand upstream of the substitute component, S1, the configured 
search path is:

1. Existing supplies of primary 

2. Existing supplies of substitute 

3. Create new supplies of primary with existing supplies of upstream components, 
level by level 

4. Create new supplies of substitute with existing supplies of upstream components, 
level by level 

5. Create new supplies on primary 

6. Create new supplies on substitute 

If the Demand is due on D10 and creating a planned order for S1 with existing 
upstream supplies (step 3 above) satisfies the Demand on D11 and creating new 
supplies on primary (step 5 above) on D10, the logic creates new supplies on Primary as
it is the alternative that satisfies the demand on time.

Demand 
Quantity

Due Date Path Satisfied 
Quantity

Date Selected

100 D10 P1, P11, P12 100 D10 Yes

100 D10 S1, S11, S12 100 D11

However, you can configure a threshold for the lateness calculation. If you specify a 
lateness threshold of 2 days, the decision changes; Rapid Planning chooses to create 
supplies on Substitute with existing upstream supplies. This is because the demand 
satisfaction date is Due Date + Lateness threshold.

Lateness Threshold, by customer, is 2 days
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Demand 
Quantity

Due Date Path Satisfied 
Quantity

Date Selected

100 D10 P1, P11, P12 100 D10

100 D10 S1, S11, S12 100 D11 Yes

Excluding Components from a Multi-Level, Level-by-Level Search

In some cases, an in-depth multi-level search is not required. Rapid Planning provides 
you with the ability to exclude some part of the supply chain from this deep search for 
three reasons:

1. It is sometimes preferable to leave the existing supplies upstream unused , for 
example, in the case of a low-cost nature of the upstream components.

2. There is a performance hit for doing this extensive. Therefore, Oracle does not 
recommend performing such a search for all components.

3. Sometimes, the upstream on hand of a primary component is being preserved for 
other purposes. You may prefer to use other options to satisfy the demand, such as 
creating new supplies on substitute (as long as the demand can be met on time).

Example
For example:

Consider the case where there is upstream on hand for a component of both the 
primary components P1 and P2 as well as the substitute S2.

If the demand is due on D10 and if item attribute on P is set to not participate in this 
multi-level search, then the solver picks the option to use P1 and S2. It ignores the fact 
that there is existing supply upstream of P2.

Lateness Threshold = 0 days
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Demand 
Quantity

Due Date Path Satisfied 
Quantity

Date Selected

100 D10 P1 and P2 100 D10 No used 
because the 
item 
attribute, 
Consume 
Before 
Making 
Primary, on 
$21 is set to 
No.

100 D10 P1 and S2 100 D10 Yes

Switching Primary and Substitute Components for Existing Supplies

You can specify the order of precedence among the existing supplies of primary and 
substitute supplies. By setting the order of precedence, products that have short life 
cycles and substitute that represent older revisions are used before Rapid Planning 
creates a new order for the primary, which is the newer revision.

A new profile option, MSO: RP - Component Substitution Logic controls this switch. 
When it is enabled, the search order changes as follows:

1. Existing supplies of substitute

2. Existing supplies of primary

3. Create new supplies of substitute with existing supplies of upstream components, level 
by level 

4. Create new supplies of primary with existing supplies of upstream components, 
level by level 

5. Create new supplies on primary

6. Create new supplies on substitute

Note: The profile option MSO: RP-Component Substitution Logic is 
also available as an advanced plan option.

Note: The substitute comes first only in the case of existing supplies at 
that level, that is 1 and 2 are switched around, or existing supplies 
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upstream, that is, 3 and 4 are switched around). New supplies are still 
using the Primary first approach. 

User Controls for Component Substitution
Component substitution can be set at the primary component level or set to consume 
before making primary.

Plan Option : MSO:RP - Component Substitution Logic

Plan Option MSO: RP - Component Substitution Logic is a global setting that applies to 
your entire plan. It is also available as an advanced plan option. You can override these 
settings at the individual item level, as demonstrated in the following sections. MSO: 
RP - Component Substitution Logic is set to one of the following options:

1. Use Primary, existing and new supplies, before using Substitute

2. Exhaust all existing supplies (Primary first) c. Exhaust all existing supplies 
(Substitute first)

3. Exhaust all existing supplies (Substitute first)

The default setting is Use Primary.

If it is Exhaust all existing supplies (primary first), the process consumes the supplies in 
this order:

• Existing supplies of primary 

• Existing supplies of substitute

• Create new supplies of primary

• Create new supplies of substitute

If it is Exhaust all existing supplies (substitute first), the process consumes the supplies 
in this order:

• Existing supplies of Substitutes

• Existing supplies of Primary

• Create new supplies of primary

• Create new supplies of substitute

The existing supplies include On-hand, Firm and non-firm purchase orders, purchase 
Requisitions, and WIP orders.

Setting Component Substitution at the Primary Component Level
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A new item attribute, Component Substitution Logic, is available. Valid values are a, b, 
or c:

• a - Use primary, existing and new supplies, before using substitute.

• b - Exhaust all existing supplies, primary first.

• c - Exhaust all existing supplies, substitute first.

Note: This item attribute is available only on Value Chain Planning 
(VCP) instances through simulation sets. It is not available on the 
source system.

The interplay between the new plan option and item attribute control is as follows:

Setting Component Substitution to Consume Before Making Primary

 This attribute controls whether this item will need to be consumed as part of the 
process where the engine is trying the exhaust all existing supplies as discussed in the 
section Switching Primary and Substitute Components for Existing Supplies of this 
document.
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Note: Set for all components at all levels.

There is a new item attribute, Consume before making Primary. Valid values are Yes 
and No. The default value is No.

Note: This is a planning attribute that is available only on VCP 
instances through simulation sets, not on the source system.

Example
Example:

In the example in the section Switching Primary and Substitute Components for Existing 
Supplies in this document, this attribute is set to No for item P11 so that it is not 
included in the search for existing supplies. The behavior excludes this item and all its 
upstream components from this search for existing supplies.

Supplier Capacity
If the purchase order promise date is not available, the planning solver uses purchase 
order need by date to consume supplier capacity.

It accumulates supplier capacity at the beginning of each day. Plans launched during 
the day will not accumulate supplier capacity until the next day.

The planning solver behaves like this if supplier capacity is missing from the advanced 
supplier list:

• No supplier capacity entries: Supplier capacity is infinite

• Supplier capacities have gaps: During gaps, supplier capacity is zero

• Future supplier capacity is missing: After the last defined supplier capacity, it is 
infinite
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• Beginning supplier capacity is missing: Before the first defined supplier capacity, it 
is zero

Planning Time Fence
Use this feature if you want to keep:

• Schedules for the near term intact but replan

• The due date of planned orders outside of the near term

To use it:

• Set values for item-org attribute Planning Time Fence Days to the number of days 
from the plan start date

• Select plan option Planning Time Fence

In unconstrained plans, it does not set any planned order suggested due dates earlier 
than the planning time fence date. It can schedule all other dates before the planning 
time fence date.

In constrained plans, it schedules planned orders depending on supply type:

• Make supplies: It does not set any planned order suggested due dates earlier than 
the planning time fence date.

• Buy supplies: It does not set any planned order dock dates earlier than the planning
time fence date

• Transfer supplies: It does not set any planned order start dates at the receiving 
organization earlier than the planning time fence date

Past Due Orders

If a scheduled receipt has a suggested due date in the past (earlier than the plan date), 
the Planning Solver

• For purchase requisition and purchase order, always reschedules it out regardless 
of whether its item has a planning time fence.

• For job, always firms it.

Natural Time Fence

A natural time fence is a planning time fence date that the Planning Solver calculates 
based on an item's scheduled receipts, as opposed to calculating it from a fixed number 
of weeks that you enter for the item. The Planning Solver uses the later of the calculated
dates as the value for Planning Time Fence Date. 

To instruct the Planning Solver to use natural time fences as the planning time fence for 
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an item, you must:

• Select item attribute Planning Time Fence Control

• Set plan options on the Advanced tab 

If you select Create Time Fence, you instruct the Planning Solver to create a natural time
fence for items at the due date of the latest firm discrete job, purchase order, flow 
schedule, or shipment. If you run the plan without the snapshot process, it still 
calculates a natural time fence. For example: 

• The calculation of Planning Time Fence Date based on item attribute PTF Days is 
day 10. The latest scheduled receipt for the item is a job with due date of day 15. 
The plan uses planning Time Fence Date of day 15.

• The calculation of Planning Time Fence Date based on item attribute PTF Days is 
day 10. The latest scheduled receipt for the item is a job with due date of day 5. The 
plan uses planning Time Fence Date of day 10.

If you select Firm Planned Order Time Fence, you instruct the Planning Solver to create 
a natural time fence for items at the due date of the latest firm planned order.

If you select Firm Internal Requisition Time Fence, you instruct the Planning Solver to 
create a natural time fence for items at the due date of the latest firm internal 
requisition.

If you select more than one of these plan options, you instruct the Planning Solver to 
create a natural time fence for items at the due date of the latest due date of all the 
supplies that are covered by your plan option selections.

You cannot see the natural time fence date but you see that an item has used the natural
time fence if its Planning Time Fence Date is different from a date calculated using item 
attribute PTF Days.

Configure to Order
Oracle Rapid Planning plans these configurations:

• Assemble to order

• Pick to order 

It can source the model components:

• All from the same organization

• From multiple organizations within a single instance

Scenarios

Oracle Rapid Planning works with:
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• Exploded configure to order forecasts as demand

• Model forecasts that it explodes as demand

• Global forecasting

You can use forecasts from:

• Oracle Demantra

• Oracle Demand Planning

• Oracle E-Business Suite

Oracle Rapid Planning always includes sales orders and always uses them to consume 
forecasts.

Scenarios: Pre-Exploded Model Forecasts as Demand

Oracle Rapid Planning creates supply for pre-exploded, organization-specific forecasts 
for assemble to order models that include option class and option forecasts:

• Sales orders consume the forecasts

• Models can be either single or multi-level

• It sources their subassemblies and components using sourcing rules 

Oracle Rapid Planning creates supply for pre-exploded, organization-specific forecasts 
for pick to order model forecasts that include options, items, and ATO model forecasts.

• Sales orders consume the forecasts

• It does not source their subassemblies and components because pick to order model
forecasts do not pass to Oracle Rapid Planning.

Oracle Rapid Planning creates supply for pre-exploded, single-instance, global forecasts
for assemble to order models that include option classes and options across multiple 
organizations. 

• Sales orders consume the forecasts

• It sources them using sourcing rules and supply availability, either percentage-
based or region-based

• It sources their subassemblies and components using sourcing rules at the local 
organization and planning percentages of each component. For forecasts form 
Oracle Demantra, it passes the final planning percentage.

Oracle Rapid Planning creates supply for pre-exploded, single-instance, global forecasts
for pick to order models that include options, items, and ATO model forecasts. 
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• Sales orders consume the forecasts

• It does not source their subassemblies and components because pick to order model
forecasts do not pass to Oracle Rapid Planning.

Scenarios: Model Forecasts as Demand for Explosion

Oracle Rapid Planning explodes and creates supply for organization-specific, assemble 
to order model forecasts to the options, option classes and mandatory components.

• Sales orders consume the forecasts

• It uses the planning bill of material percentages to explode the model forecasts to 
each level.

• It sources their subassemblies and components using sourcing rules

Oracle Rapid Planning explodes and creates supply for organization-specific pick to 
order model forecasts that include options, items, and assemble to order model 
forecasts.

• Sales orders consume the forecasts

• Pick to order model forecasts do not pass to Oracle Rapid Planning

• You can pass organization-specific pick to order forecasts that are exploded one 
level down

Oracle Rapid Planning explodes and creates supply for single-instance, global forecasts 
for assemble to order models that include option classes and options across multiple 
organizations. 

• Sales orders consume the forecasts

• It sources them using sourcing rules and supply availability, either percentage-
based or region-based

• It sources their subassemblies and components using sourcing rules at the local 
organization and planning percentages of each component.

Oracle Rapid Planning explodes and creates supply for single-instance, global forecasts 
for pick to order models that include options, items, and ATO model forecasts across 
multiple organizations. 

• Sales orders consume the forecasts

• It sources them using sourcing rules and supply availability, either percentage-
based or region-based

• It sources their subassemblies and components using sourcing rules at the local 



9-60    Oracle Rapid Planning Implementation and User's Guide

organization and planning percentages of each component

Scenarios: Global Forecasting

Oracle Rapid Planning creates supply for single-instance, global forecasts for standard 
items:

• Sales orders consume the forecasts

• It sources them using sourcing rules and supply availability, either percentage-
based or region-based

 The planning solver distributes forecasts with no constraints. It uses planning 
percentages and rank 1 sourcing rules.

For assemble to order model forecasts the planning engine in all cases distributes the 
global forecast based on sourcing rules and planning percentages to meet the model 
forecast on time.

For global forecast offsetting during forecast explosion, the planning solver only uses 
only the processing lead times defined in the item validation organization. Oracle Rapid
Planning only accounts for fixed and variable lead times when it processes sales orders.

Item Attribute Forecast Consumption for Pre-exploded Forecasts

For the model, set to Consume or Consume & Derive. Oracle recommends that you set 
to Consume and Derive.

For child items of the model other than mandatory components, Oracle Rapid Planning:

• Recommends that you set to Consume and Derive for Oracle Demantra and Oracle 
Demand Planning pre-exploded forecasts

• Includes forecasts for ATO Models, PTO Models, Option Classes, Options and 
Mandatory Components (optional).

• Performs forecast consumption

• Does not peg forecast demand to the model planned order

If you set child items of the model to Consume:

• Oracle Demantra and Oracle Demand Planning do not calculate exploded demand

• Oracle Rapid Planning does not create exploded demand from parents

For child items of the model other than mandatory components, Oracle Rapid Planning:

• Requires that you set to Consume and Derive for Oracle Demantra and Oracle 
Demand Planning pre-exploded forecasts

• Includes forecasts for ATO Models, PTO Models, Option Classes, Options and 
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Mandatory Components.

• Performs forecast consumption

• Does not peg forecast demand to the model planned order

For mandatory component children of the model, Oracle Rapid Planning:

• Recommends that you set to None

• Calculates exploded demand 

• Pegs planned order demand to the model planned order

Item Attribute Forecast Consumption for Forecast Explosion

For the model, set to Consume or Consume & Derive. Oracle recommends that you set 
to Consume and Derive.

For child items of the model other than mandatory components, Oracle Rapid Planning:

• Recommends that you set to Consume and Derive for Oracle Demantra and Oracle 
Demand Planning forecasts

• Explodes forecasts to assemble to order models, option classes, options and 
mandatory components

• Performs forecast consumption

• Does not peg forecast demand to the model planned order

If you set child items of the model to Consume, Oracle Rapid Planning does not create 
exploded demand from parents.

For mandatory component children of the model, Oracle Rapid Planning:

• Recommends that you set to None

• Calculates exploded demand 

• Pegs planned order demand to the model planned order

Select plan option Explode Forecast.

If you are using Oracle Demantra, set profile option MSD_DEM: Calculate Planning 
Percentages and do not change it after the initial download. 

If you are using Oracle Demand Planning, set profile option MSD: Calculate Planning 
Percentage

Bills of Material

For models, you can:
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• Add models, option classes, and items to model and option class bills of material 
that you have already defined ion the source instance

• Edit Planning Percent for model and option class bills of material 

• Edit flag Optional for model and option class bills of material

Use the Plan Input views to make these changes.

Demand Schedules

You can select these forecasts as demand schedules:

• Organization-specific configure to order

• Global configure to order: If you have multi-level, multi-organization assemble to 
order models, Oracle recommends that you use these for proper forecast 
consumption

For organization-specific configure to order forecasts, use either:

• Pick to order forecasts that contain assemble to order model, option class, and 
option level forecasts and mandatory components Oracle Demantra does not pass 
pick to order model forecasts, only its options, items, and assemble to order models

• Assemble to order forecasts that contain model, option class and option level 
forecasts

For global configure to order forecasts, you import them at these levels:

• Global (Item)

• Organization

• Customer

• Customer site

• Zone

• Customer zone

Set both of these profile options in the master organization:

• Define the item validation organization using the profile option OE: Item Validation
Organization.

• Maintain a common bill of material in the Oracle Order Management validation 
organization and identify that organization in profile option MSC: Organization 
containing generic BOM for forecast explosion.
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After forecast explosion, Oracle Rapid Planning sources global forecasts to 
organizations in an unconstrained manner based on sourcing rules and planning 
percentages. It plans based on ship date at the shipping organization and does not 
attend to constraints in receiving calendars.

Mandatory Components

If you pre-explode assemble to order forecasts, you do not need to pass forecasts for 
mandatory components because Oracle Rapid Planning calculates them from their 
parents, after it consumes the parents.

For pre-exploded pick to order models, include pre-exploded forecasts for mandatory 
components.

Forecast Explosion

To instruct Oracle Rapid Planning to explode configure to order forecasts, select plan 
option Explode. It explodes forecasts, then it consumes the forecasts.

Forecast Consumption

Set plan option Ship to consumption level. The process consumes forecast entries that 
have the same Ship To value as it.

For consumption by demand class:

• If a sales order has a demand class, the process consumes a forecast that has the 
same demand class.

• If a forecast does not have a demand class, the process uses its organization 
demand class.

• If a sales order does not have a demand class, the process uses its organization's 
warehouse demand class.

• If you consume by demand class and have forecasts without demand classes, set 
profile option MSC: Rapid Planning Consume Forecast with No Demand Class.

For global forecasts, the planning solver:

• Aggregates all sales orders to the level that you want to consume.

• Ignores the organizations on the sales order lines

• Consumes global forecasts by sales orders in inventory organizations with reference
to a ship to entity, for example, zone, customer site, and demand class

• Distributes forecasts and sales orders to organizations that may have a different 
demand classes than the ones on the sales orders and may have a different demand 
classes than the ones that it used for consumption.

Sourcing Rules
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Oracle Rapid Planning uses sourcing rules for a configuration first, then for the model, 
then for the sourcing hierarchy.

For global forecasts, use the profile option MRP: ATP Assignment Set to indicate the 
assignment set name for use with Oracle Global Order Promising. The planning solver 
also uses this profile option to determine sources when configuring a model sales order.

Configuration Forecasts

If you build standard configurations to forecasts, and make forecasts both for the model
and the configuration, make them customer-specific forecasts. Reduce the model 
forecasts and their component forecasts by the amount of the configuration forecasts.

The planning solver first consumes forecasts with sales orders for the configured item, 
then with forecasts for the base model. 

Purchased Models

If you purchase assemble to order configurations, you can use the Suppliers page > 
Supplier site to see their constraints.

You can constrain the purchased configuration by providing the aggregate capacity for 
the supplier – supplier site to build the base model. 

Also, view metrics:

• Supplier capacity utilization %

• Supplier Capacity

• Supplier requirements

The planning solver uses the:

• Approved supplier list capacity for the assemble to order models, not the supplier 
capacity for any of its configuration items.

• Approved supplier list order modifiers and lead times for the configuration items

Option Dependent Resources

The planning solver treats option dependent resources in model routings as 100% 
loaded.

This may result in the resource appearing overloaded. Consider making these resources
non-bottleneck resources.

Simulation

You can firm and update forecasts for models and configurations and their option 
classes, options, mandatory components.

However, if you drive a plan with pre-exploded forecasts from Oracle Demantra, there 
are no pick to order models and option classes for update..
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Ship Sets
You set ship sets in Oracle Order Management against sales order lines. Sales order 
lines of one sales order with the same ship set must ship:

• Together: The planning solver calculates a planned ship date.

• From the same warehouse (organization)

You can also set a ship set on a manual demand

Process

The planning solver plans ship sets in Unconstrained and Constrained plans.

It looks at the sales order lines and manual demands in ship sets and plans to create 
supplies that satisfy all the demands of the ship set on the same date (common date)—
the most constrained of the satisfied dates. Constraints on one line of a ship set can 
make all the lines of the ship set late.

The planning solver does not:

• Recommend to change the warehouse

• Consider end item substitutes

In this example:

• The planned order for Item C is constrained until Day 10

• Therefore, the planning solver changes the dates of all supplies and their sales order
lines from Day 5 to Day 10

Item Order 
Type

Quantit
y

Ship 
Set

Due 
Date of 
Deman
d

Sugges
ted Due
Date of 
Supply 
(in the 
absenc
e of a 
ship 
set)

Sugges
ted Due
Date of 
Supply 
(with 
ship set
respect
ed)

Planne
d Ship 
Date of 
Deman
d (in 
absenc
e of 
ship 
set)

Planne
d Ship 
Date of 
Deman
d (with 
ship 
set)

Item A Sales 
Order

100 1 Day 5 - - Day 5 Day 10

.Item B Sales 
Order

100 1 Day 5 - - Day 5 Day 10
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Item Order 
Type

Quantit
y

Ship 
Set

Due 
Date of 
Deman
d

Sugges
ted Due
Date of 
Supply 
(in the 
absenc
e of a 
ship 
set)

Sugges
ted Due
Date of 
Supply 
(with 
ship set
respect
ed)

Planne
d Ship 
Date of 
Deman
d (in 
absenc
e of 
ship 
set)

Planne
d Ship 
Date of 
Deman
d (with 
ship 
set)

Item C Sales 
Order

100 1 Day 5 - - Day 10 Day 10

Item A Planned
Order

100 1 - Day 5 Day 10 - -

Item B Planned
Order

100 1 - Day 5 Day 10 - -

Item C Planned
Order

100 1 - Day 10 Day 10 - -

These are situations when the planning solver plans a supply due date that is different 
from the ship set common date. It:

• Must finish the supply earlier because of constraints. For example, it plans three 
make orders of quantity 10 to satisfy a demand of quantity 30 on Day 5 because the 
production capacity is 10 units per day. The first two planned orders have due 
dates of Day 3 and Day 4 instead of Day 5. 

• Must finish the supply later because of constraints. It issues exception message Late 
replenishment for sales order. 

• Decides to satisfy the demand from on-hand. It sets the supply due date to the plan 
start date or to the day that it plans the material to go into inventory.

Analyzing and Viewing

To view and change ship sets, use view Supply/Demand, field Ship Set. The field does 
not have a list of values. You can use both letters and numbers for the ship set name.

To query ship sets, use search fields Sales Order Number (not Order Number) and Ship 
Set. Different sales orders can have the same ship set name, but a ship set only applies 
to one sales order. Ship set A of sales order 2222 is a different ship set than ship set A of 
sales order 1111. Search field Ship Set does not have a list of values.

The planning solver gives constraint details only for the order line that causes the delay 
in the ship set. Oracle recommends that you click on all of the order lines in the ship set,
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then click Constraint Details.

You can simulate adding, changing, or deleting ship sets and the planning solver plans 
for them:

• You cannot simulate changing a sales order line to another sales order.

• As you add ship sets to sales order lines, the view immediately updates the firm 
date of the lines to the ship set's common date.

• As you change firm dates and revised demand dates of sales order lines in a ship 
set, the view asks if you want to change the firm dates of all lines in the ship set to 
this new date. If you answer No, you must remove the firm date that you changed.

• You cannot mass update lines with no ship set names so that they have ship set 
names. Your mass update could include multiple sales orders, and the planning 
solver cannot calculate a common date.

• You cannot mass update sales order line firm dates and revised demand dates if 
any of the lines has a ship set. Your mass update could not have all of the lines in 
the ship set, and the planning solver cannot calculate a common date. 

• If you give multiple manual demands the same ship set name, the planning solver 
plans them to ship together. However, it does not associate them with any sales 
orders, even if some sales orders use that same ship set name. 

You can pass simulated new schedule dates to the sales order in Oracle Order 
Management:

• It is for dates that the planning solver reschedules and issues exception message 
Changes recommended to sales orders. Use action Publish Sales Order Changes.

• The action does not pass dates to the sales order that you have manually changed 
after a simulation run. These sales order lines Release Status is None.

Engineering Change Orders
You can plan use-up engineering change orders (ECOs). Use-up engineering change 
orders are engineering change orders where the cutover date for the new component is 
the date that you run out of the old component.

For other ECOs that are:

• Based on the usage of the assembly item, Rapid Planning does not plan them

• Non-use-up ECOs (adding new components only or changing component 
sequences or quantities, Rapid Planning uses the ECO effective date

Process
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For a use-up ECO, you:

• Create it in the source; use form Engineering Change Order

• Leave it unimplemented

• Enter the assembly (revised item) and mark it as MRP Active; use form Revised 
Items

• Collect the data to Rapid Planning

• Run a Rapid Planning plan

• Send the plan information to the source; use concurrent request Push Plan 
Information 

• In the source ECO, enter the old (use-up item) and new component; use form 
Revised Components

• Collect the data to Rapid Planning

• Run a Rapid Planning plan

The planning solver:

• Marks the old component item attribute Use Up as Yes

• Ignores effectivity dates of the old and new components

• No longer creates planned orders for the old component

• Calculates use-up date as the date that old component projected on hand becomes 
zero. However, when there are firm supplies, the projected on hand of the old 
component may go below zero prior to the due date of the earliest firm supply. In 
this case, the use up date is the date when the planning engine uses up the latest 
firm supply.

• Creates planned orders for the new components after the use-up date

If the old component of a use-up ECO is in multiple bills of material, the planning 
solver

• Calculates a use up date for the old component in each of the bills

• Leaves demand unmet if a bill of material does not specify a new component. In 
this case, you must create an ECO for that bill.

Each time that you run a Rapid Planning plan and send the plan information to the 
source, the planning solver refines the use-up date.
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Models

You can also plan use-up ECOs for models in which:

• The revised item is an option class

• The old and new components are options and mandatory components 

The planning solver does not:

• Plan ECOs for configured items that came from the model

• Calculate use-up dates for options that have pre-exploded forecasts, for example, 
from Oracle Demand Planning or Oracle Demantra Demand Management

Simulating

You can run simulation plans against plans with ECOs where you either:

• Change the use-up item on an ECO

• Add a new component to a bill of material

To change the use-up item on an ECO:

• Navigate to page Bill of Material and query the bill with the ECO

• In the row with the use-up component, change the use-up component

• The new use-up item's item attribute Use Up is Yes and the old use-up item's item 
attribute Use Up changes to No

• Run a Rapid Planning simulation plan without refresh snapshot

• Review the simulation plan output

• When you accept the simulation plan output, send the plan information to the 
source 

• In the source, manually change the use up item on the ECO

To add a new component to a bill of material:

• Navigate to page Bill of Material and query a bill

• Add a new component on the bill and specify a use up item

• Run a Rapid Planning simulation plan without refresh snapshot

• Review the simulation plan output

• When you accept the simulation plan output, send the plan information to the 
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source 

• In the source, manually create a new ECO

Viewing

To view ECO information in Rapid Planning, use pages:

• Items: Use Up and Inventory Use Up Date 

• Bill of Material old component: Use Up, Disable Date 

• Bill of Material new component: Use Up Item (changeable for simulations but not 
deletable), Change Notice
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10
Implementation: User Interface Modeling

Step 8: User Interface Modeling
The views, actions, exceptions, and metrics in Rapid Planning are the tools for your 
planners. Become familiar with them and decide on your processes.

Overview

Related Topics
See:

Plan Analysis: Workbench

Plan Analysis: Inputs

Plan Analysis: Output Exceptions and Metrics

Plan Analysis: Outputs
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11
Implementation & Plan Analysis: 

Simulations

Step 9: Simulations
You can simulate unanticipated events in the business environment and respond to 
them. By comparing multiple simulation plans with the baseline plan, you can make the
best decision for execution.

Overview
You can do simulations by modeling changes in business conditions, for example, new 
demands, changes to supplies, and engineering change orders. The planning solver 
analyzes the impacts of these changes.

Use simulations if you:

• Have frequent, unanticipated supply chain changes that occur in the near term

• Want to do what-if scenario analysis, simulate responses, and compare scenarios 
before deciding on responses to these changes

Implementation
You can make changes to:

• Plan inputs: For example, items, bills of material and resources, to simulate, for 
example, engineering change orders, machine downtime

• Plan data: Forecasts and supplies to simulate situations, for example, hot demand 
and late supplies.

You make these changes either:
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• Individually

• Mass update: Multiple changes with one transaction

Change:

• Plan inputs using simulation sets

• Plan data using the views

This table compares the editing methods.

Simulation Sets Views

Changes apply to collected data Changes apply to plan data

You can use the changes in multiple plans You can use the changes in the changed plan 
only

You cannot edit supply and demand entities You can edit supply and demand entities

Used to update key properties without 
updating ERP

Used for interactive simulation using a plan

See changes in the Plan Inputs tab See changes in the views

This table shows the entities that you can update.

Entity Type Create Rows Duplicate Rows Update Rows Delete Rows

Items No No Yes No

Resources No Yes Yes No

Bill of Materials No Yes Yes No

Resource 
Availability

No Yes Yes Yes

Resource 
Requirements

No No No No

Calendar No Yes Yes No
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Entity Type Create Rows Duplicate Rows Update Rows Delete Rows

Calendar 
Associations

Yes Yes Yes No

Supplier No Yes Yes No

Processes No Yes Yes No

Supply and 
Demand

No No No No

This table shows the attributes that you can update.

Entity Attributes

Item Maximum Order Quantity, Minimum Order 
Quantity, Fixed Lot Multiple, Fixed Order 
Quantity, Variable Lead Time, Fixed Lead 
Time, Preprocessing Lead Time, Processing 
Lead Time, Post-processing Lead Time

Resources Units, Bottleneck Flag, Effective Date, Disable 
Date

Bill of Material Assembly Quantity, Effective Date, Disable 
Date, Component, Substitute Component 
Item, Component Usage Quantity, 
Component Yield, Substitute Priority, 
Substitute Quantity, Substitute Item UOM

Resource Availability Shift, Shift Date, Assigned Units, Start Time, 
End Time

Calendar Status

Calendar Associations Association Type

Supplier Processing Lead Time, Last Change Date / 
Time, Changed by, Minimum Order Quantity,
From Date, To Date, Capacity, FLM
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Entity Attributes

Processes Effective Date, Disable Date, Operation 
Effective Date, Operation Disable Date, 
Resource, Alternate Routing, Replacement 
Group, Alternate Resource, Assigned Units, 
Rate or Amount, Operation Yield

Editing Plan Input (Collected) Data
After the collected data arrives, you can use it unchanged to run through a plan

You can change it using either:

• Direct changes

• Simulation sets

Editing Plan Input (Collected) Data – Direct Change
You can change data as changes in your manufacturing environment occur by 
individually updating or mass updating a plan or a copy of a plan. You do not have to 
make the changes in the source system and re-collect them.

You can use these changes to visualize your supply and demand picture:

• Before: A current plan

• After: A simulation plan that includes the simulated data. This can be a copy of the 
current plan

• Edit plan data in order to evaluate their impact on the plan.

To make direct edit changes:

• Navigate to a data area tab

• Do not enter a simulation set name in the view's Search Area

• Type over the data that you want to change or use a mass update. See Mass Update.

You do not need to make direct updates for a plan run to use your changes. You can 
update data in the Rapid Planning views and store your changes in a simulation set. If 
you make individual updates and mass updates to a simulation set and run a plan with 
the simulation set, the planning solver uses the changes from your simulation set. The 
changes are not permanently in the plan, they are in the simulation set. See Editing Plan
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Input (Collected) Data – Simulation Sets.

If you make individual updates and mass updates to a plan and run it, the planning 
solver uses your changes. The edits only apply to that plan and are permanently in the 
plan, unless you manually undo each one. They are neither in a simulation set nor 
saved to the database.

This table shows the edits that you can make in the Supply & Demand view.

Order Type Editable Field Default Value

Planned Order Firm Status Firm

 Firm Date Value from field Sugg Due 
Date

 Firm Quantity Value from field Quantity

 Alternate BOM  

 Alternate Routing  

 Source Organization  

 Source Supplier  

 Source Supplier Site  

Purchase Order / Purchase 
Requisition

Firm Status Firm

 Firm Date Value from field Sugg Due 
Date

 Firm Quantity Value from field Quantity

 Source Organization  

 Source Supplier  

 Source Supplier Site  

Work Order Firm Status Firm
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Order Type Editable Field Default Value

 Firm Date Value from field Sugg Due 
Date

 Firm Quantity Value from field Quantity

 Alternate BOM  

 Alternate Routing  

Forecast Firm Status Firm

 Firm Date Value from field Sugg Due 
Date

 Firm Quantity Value from field Quantity

 Order Priority  

Sales Order Firm Status Firm

 Firm Date Value from field Sugg Due 
Date

 Firm Quantity Value from field Quantity

 Order Priority  

After you edit plan data, you can re-run a plan without refreshing snapshot data. When 
you start plan action Launch Plan, select Launch Plan, do not refresh snapshot.

Editing Plan Input Data – Simulation Sets
Use simulation sets to modify plan inputs and evaluate their impact on the plan. You 
can use one simulation set can be given as input to a particular plan. One simulation set 
can include changes to multiple entities.

You do not need to store your changes in a simulation set for a plan run to use them. 
You can update data in the Rapid Planning views and not name a simulation set (direct 
updates). If you make direct individual updates and mass updates to a plan and run it, 
the planning solver uses your changes. The changes are permanently in the plan. See 
Editing Plan Input (Collected) Data – Direct Change.
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If you save plan changes in a simulation set, they are separate from the collected data 
and do not change the collected data. You can apply them again later to that plan or to 
another plan. Plan runs start with the collected data and write over it with the data in 
their simulation set.

Managing Simulation Sets
You can begin to work with simulation sets by navigating to a data area tab.

Simulation Set Exists for the View

If the view already has changes into a simulation set, you see:

• There is an entry in tab Plan Inputs, Manage Simulation Sets

• The column Simulation Set has value Collected Data. If the tab has changed rows 
that you saved in a simulation set, that column shows the simulation set name.

• Simulation Set is a criterion in the search area. All of the rows of the tab display and
the simulation set rows are in blue highlight.

You can continue to make changes into the simulation set.

Starting with a New Simulation Set

If you are making changes into a simulation set for the first time, you:

• Make a simulation set

• Make changes into it

Simulation Set Operations

To make a simulation set:

• Click Manage Simulation Sets

• In window Manage Simulation Sets, click icon Add New

• In the new blank row, enter the new simulation set name

To make changes into a simulation set:

• Verify that there is a simulation set name in the view's Search Area

• Type over the data that you want to change or use a mass update. See Mass Update.

To rename a simulation set:

• Click Manage Simulation Sets

• In window Manage Simulation Sets, select the row with the name of the simulation 
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set to rename

• Type the new name in the same row

To make a copy of a simulation set:

• Click Manage Simulation Sets

• In window Manage Simulation Sets, select the row with the name of the simulation 
set to make a copy of

• Click icon Duplicate

• The copied simulation set appears with name Duplicate of <original simulation set 
name>. You can rename it.

You can set a simulation set as a default. Every time you make a mass change, the 
Update Data window:

• Applies the default simulation set to the data

• Fills field Simulation Set with the default simulation set name. The mass update 
changes will go to the default simulation set unless you select another simulation 
set name before you OK the mass change

When you add or duplicate a row in a tab and want to store it in a simulation set, select 
the simulation set that you want as the value for column Simulation Set.

You can perform a mass update that includes rows from the simulation set:

• If you want to save these latest changes in a simulation set, when you are in 
window Update Data for the mass change, click button Manage Simulation Sets

• Changed data appears in new rows

• You can change changed data in an individual update but not in another mass 
update

You can delete rows from a simulation set just as you can from the collected data.

You may save changes in a simulation set, recollect the data, and then apply the 
simulation set to the recollected data. There can be changes in the simulation set that 
changed a row from the previous collection, but that row is not in the current collection.
The tab displays these simulation set changes as deleted rows (red text with 
strikethrough and a red flag.

To delete a new simulation set:

• Click Manage Simulation Sets

• In window Manage Simulation Sets, select the row with the name of the simulation 
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set to delete

• Click icon Delete

Applying Simulation Sets

You can apply one simulation set to a plan for each run. 

When you want to apply a simulation set to a plan, enter its name in plan option 
Simulation Set. 

The planning solver applies all the simulation set changes to the plan data before it 
begins solving supply and demand.

When the plan finishes, you can see the simulation set entities in the data area tabs as 
new rows. 

Plan Simulation Types
Incremental Planning

Use incremental planning for hot demands. Incremental planning does not re-snapshot 
planning data.

The incremental plan freezes all:

• Supplies

• Planned orders

• Resource capacity consumption

• Supplier capacity consumption

• Pegging relationships

The planning solver only changes plan output to:

• Create and reshuffle supplies to meet the hot demand and determine when you can 
meet it

• Recalculate all exception messages

If there are multiple hot demands, the planning solver plans by:

• Highest demand priority

• Then by earliest due date

• Then by lowest quantity

See Define Incremental Replan Scope.
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Simulation Replans and Snapshot Refresh
If the incremental plan output is not satisfactory, run a replan; do not run multiple 
incremental planning runs.

Run plan launch either with or without snapshot.

When you re-run with snapshot, the planning solver starts over with the collected data. 
However, the planning solver does not write snapshot data over your manual changes 
in the simulation set.

Multi-planner Collaboration
Use multi-planner collaboration if:

• Your business has multiple planners

• They work independently on different parts of the plan

• They each want to easily save their changes either together or separately

This is how Oracle Rapid Planning processes data when more than one planner is 
working on the same plan:

• Their saved changes are visible to one another

• A save or undo of changes by one planner saves or undoes the changes of all the 
planners

• A re-plan run by one planner locks out all planners from making changes to that 
plan

• If two planners are changing the same entity, the last one's change holds

• When one planner releases planned orders, the planned order information may not 
include unsaved changes by another planner. For example, a planner has mass-
edited supplier capacity but not saved the changes. When another planner then 
releases planned orders, they are based on the previous supplier capacity.

Saving to Simulation Sets

Each planner can save their changes to a simulation set.

If you don't select any changed records, all your changes go into the simulation set. If 
you select changed records, only those changes go into the simulation set.

Use view action Save to Set or menu Plan Actions > Save to Simulation Set:

You can perform all the simulation set actions.

If you can update an entity in the views, you can save the entity to a simulation set.
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If you change a field in a record, the save process saves the entire records, not just the 
field that changed. When the plan runs and applies the simulation set, it applies to all 
fields from the last chronological update of the record.

When two planners update the same record at different times, the second updater's 
view may not display the field updates of the first updater. If so, the planning solver 
loses the first updater's field changes when it applies the second updater's record.

Simulation Set Configuration

All planners can save their changes to one simulation set. If multiple planners change 
the same information, the planning solver uses the last chronological change. Use this 
method if you want to consolidate all changes to apply to the next run of the plan.

Each planner can save their changes to different simulation sets. Use this method if each
planner wants to run independent simulation on their part of the plan.

Planners can save changes from multiple plans to the same simulation set. Use this 
method if planners are working with copies of the base plan but want to save changes 
to apply in the next run of the base plans.

Multi-planner Example

This table shows a collected engineering change order cut-over in tab Plan Inputs

Simulation Set End Item Component Effective Start Effective End

Collected Data AS66311 CM66331 - Jan 7

Collected Data AS66311 CM66331New Jan 8 -

The planner does some simulations, decides that a later cut-over is better, and enters 
that decision in the Bill of Materials view. The planner saves the changes to simulation 
set MySimSet. The data in tab Plan Inputs changes.

Simulation
Set

End Item Compone
nt

Effective 
Start

Effective 
End

Last 
Updated 
By

Last 
Updated 
Date and 
Time

Collected 
Data

AS66311 CM66331 - Jan 7 Planner 1 09/12/08 00:
00

Collected 
Data

AS66311 CM66331N
ew

Jan 8 - Planner 1 09/12/08 00:
00
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Simulation
Set

End Item Compone
nt

Effective 
Start

Effective 
End

Last 
Updated 
By

Last 
Updated 
Date and 
Time

Collected 
Data

AS66311
CM11222

- Jan 15 Planner 1 09/12/08 00:
00

Collected 
Data

AS66311 CM11222 Jan 16 - Planner 1 09/12/08 00:
00

MySimSet AS66311 CM66331 - Jan 31 Planner 1 09/12/08 00:
10

MySimSet AS66311 CM66331N
ew

Feb 1 - Planner 1 09/12/08 00:
10

Another planner can save changes to the same simulation set.

Simulation
Set

End Item Compone
nt

Effective 
Start

Effective 
End

Last 
Updated 
By

Last 
Updated 
Date and 
Time

Collected 
Data

AS66311 CM66331 - Jan 7 Planner 1 09/12/08 00:
00

Collected 
Data

AS66311 CM66331N
ew

Jan 8 - Planner 1 09/12/08 00:
00

Collected 
Data

AS66311
CM11222

- Jan 15 Planner 1 09/12/08 00:
00

Collected 
Data

AS66311 CM11222 Jan 16 - Planner 1 09/12/08 00:
00

MySimSet AS66311 CM66331 - Jan 31 Planner 1 09/12/08 00:
10

MySimSet AS66311 CM66331N
ew

Feb 1 - Planner 1 09/12/08 00:
10

MySimSet AS66311 CM11222 - Feb 14 Planner 2 09/12/08 00:
20
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Simulation
Set

End Item Compone
nt

Effective 
Start

Effective 
End

Last 
Updated 
By

Last 
Updated 
Date and 
Time

MySimSet AS66311 CM11222N
ew

Feb 15 - Planner 2 09/12/08 00:
10

However, if the other planner saves changes to the same data that the original planner 
saved changes to, the simulation set only keeps the changes from the other planner

Simulation
Set

End Item Compone
nt

Effective 
Start

Effective 
End

Last 
Updated 
By

Last 
Updated 
Date and 
Time

Collected 
Data

AS66311 CM66331 - Jan 7 Planner 1 09/12/08 00:
00

Collected 
Data

AS66311 CM66331N
ew

Jan 8 - Planner 1 09/12/08 00:
00

Collected 
Data

AS66311
CM11222

- Jan 15 Planner 1 09/12/08 00:
00

Collected 
Data

AS66311 CM11222 Jan 16 - Planner 1 09/12/08 00:
00

MySimSet AS66311 CM66331 - Jan 25 Planner 2 09/12/08 00:
10

MySimSet AS66311 CM66331N
ew

Jan 26 - Planner 2 09/12/08 00:
10

Simulating with Updated Demand Priorities 
Use this if you have changing demand priorities that do not conform to consistent rules 
and you receive hot demands. You can mass update demand priorities without 
rerunning the planning solver snapshot.

You can use this functionality in unconstrained and constrained plans.

If you do have consistent demand priorities and do not receive hot demands, either:
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• Set them on sales orders in the execution (source) system and collect them

• Use demand priority rules

Process

Use an original plan--a new plan or one launched with refresh Snapshot.

Make a copy (destination plan). Use concurrent request Copy Simulation Plan.

Extract demands from the copy plan. Your business must write a query to extract the 
demand IDs and attributes that you want into a spreadsheet.

Update demand priorities. You must upload them to the Planning Data Store:

• This table has columns – Plan ID, Demand ID, Firm Date, and Order Priority.

• Both Plan ID and Demand ID: need foreign key references to their corresponding 
columns in table msc_demands.

• You can only load priorities for demands that are in the plan. Plan ID-Demand ID 
of the updated demand must match Plan ID-Demand ID of a demand in the plan.

• The table does not keep history. 

Launch the copy plan:

• Select option Use Mass Updated Demand Priorities.

• Do not refresh snapshot. Select either Incremental Replan or Launch Plan, do not 
refresh snapshot. If you select Incremental Plan, use incremental replan scopes: 
Freeze selected Supplies / Replan all demand or Freeze all except selected supplies, 
Replan all demands. 

• If you need to refresh snapshot, use concurrent process Launch Simulation Planner. 
See Launch Plan, Schedule a Plan Run. For both parameters Launch Snapshot and 
Use Mass updated Demand Priorities, use their default values Yes. For Launch 
Snapshot, if you select No, you must have run the plan with snapshot at least once 
before.

Analyzing and Viewing

After the copy plan launch finishes, compare the original and the copy plan.

In view Supply/Demand, you can see, the new priority information in columns Order 
Priority and Firm Date. 

The process updates Suggested Due Date based on the new demand priorities. It keeps 
the original Suggested Due Date (from the first refresh snapshot run) in column 
Original Due Date. If you've run a plan without snapshot, Original Due Date does not 
change, even if you change Firm Date.

If you want to adjust some of the demand priorities in the completed copy plan, you 
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can in view Supply/Demand both by direct update and mass update. 

Simulating Advanced Supply Chain Planning Plans
You use Oracle Advanced Supply Chain Planning and Oracle Rapid Planning together 
to respond to unanticipated events between Advanced Supply Chain Planning runs. 
Use Rapid Planning to simulate prospective changes that address these unanticipated 
issues. Choose a solution, then release it to the execution system and feed it back to 
Advanced Supply Chain Planning. 

Simulate Advanced Supply Chain Planning plans in Rapid Planning if you:

• Use Advanced Supply Chain Planning

• Have frequent, unanticipated supply chain changes that occur between Advanced 
Supply Chain Planning plan runs

• Want to do what-if scenario analysis, simulate responses, and compare scenarios 
before deciding on responses to these changes

Typically, businesses run Advanced Supply Chain Planning plan as a nightly job. The 
next morning, the planner validates the plan output, takes corrective action, and 
releases orders to the execution system.

During the day, if any dynamic changes occur, for example, to demands, supplies, 
resources, bills of material, and routings, the planner can see the effects of these 
changes. Simulate these changes using Rapid Planning plans.

See also Rapid Planning and Advanced Supply Chain Planning.

Process
This table describes the simulation process.

Oracle Advanced Supply Chain Planning Oracle Rapid Planning

Enable simulations  

Run plan -

Edit and firm order dates --

Release orders to execution --

There are unanticipated events that cause 
production issues before the next plan run. . .

--
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Oracle Advanced Supply Chain Planning Oracle Rapid Planning

Copy Advanced Supply Chain Planning plan 
as Rapid Planning baseline plan (once, either 
from Advanced Supply Chain Planning or 
Rapid Planning) 

Copy Advanced Supply Chain Planning plan 
as Rapid Planning baseline plan (once, either 
from Advanced Supply Chain Planning or 
Rapid Planning) 

-- Do this as many times as you need to simulate
potential solutions and select a solution: 

-- - Copy the baseline plan to a simulation plan

-- - Make changes to the simulation plan 

-- - Firm a portion of the simulation plan

-- - Run the simulation plan

-- - Compare the baseline and the simulation 
results

-- Release orders

-- Firm orders

Run the plan and specify the Rapid Planning 
simulation plan that you used to solve the 
issue and released orders from.

--

Enable Simulations
See Oracle Advanced Supply Chain Planning Implementation and User's Guide. 

Open Simulation
See Oracle Advanced Supply Chain Planning Implementation and User's Guide. 

Launch Supply Chain Planning Process Request Set
See Oracle Advanced Supply Chain Planning Implementation and User's Guide. 
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Copy Plan
Navigate to Copy Plan.

In Copy From, select Plan Type ASCP

In Copy To, select Plan Type Rapid Planning. If it is a new plan, enter Description, 
Simulation Horizon (Days), and Category Set.

If the plan exists, you receive a warning.

Create Baseline Plan
You can create the baseline Rapid Planning plan from an Advanced Supply Chain 
Planning plan using these methods:

• In Advanced Supply Chain Planning: Menu, Open Simulation

• In Rapid Planning: Process, Copy Plan

Supplies inside the simulation horizon that peg to demands outside the simulation 
horizon disappear from the baseline plan. 

Baseline Entities

The baseline creation process replicates the Advanced Supply Chain Planning plan with
these entities.

End demands

Supplies: Dates and quantities. However, it does not copy orders made by Global Order
Promising.

Details for planned orders and their dependent demands

• Make: Bill of material, routing, resources, operation start and end dates, resource 
requirement start and end dates, components, and component requirement dates

• Buy: Supplier, supplier site, and ship method

• Transfer: Source organization and ship method

Details for scheduled receipts and their dependent demands:

• Work orders: Bill of material, routing, resources, operation start and end dates, 
resource requirement start and end dates, components, and component 
requirement dates

• External purchase orders and purchase requisitions: Supplier, supplier site, and 
ship method

• Internal purchase orders and purchase requisitions: Source organization and ship 
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method

Safety stock

• It depends on how you select the Advanced Supply Chain Planning organization-
level plan options Plan Safety Stock

• You check it for at least one organization: The process sets Rapid Planning plan 
option Safety stock lead time method to Safety Stock Quantity and uses the safety 
stock quantities from the Advanced Supply Chain Planning plan.

• You clear it for all organizations: The process sets Rapid Planning plan option 
Safety stock lead time method to Do not compute safety stock.

• For setting Advanced Supply Chain Planning plan option Plan Safety Stock, Oracle 
recommends that you either select it for all organizations or clear it for all 
organizations.

Baseline Plan Process
Copy plan options and set defaults for some non-Advanced Supply Chain Planning 
plan Options that are not present in ASCP

Run the Rapid Planning snapshot process to load the static data.

Load all end demands and supplies—scheduled receipts and planned orders--within 
the simulation horizon. If you have supplies within the Rapid Planning planning 
horizon that peg to demands outside the Rapid Planning planning horizon, the supplies
disappear. Oracle recommends that you set your Rapid Planning planning horizon to:

• At least 30 days after your last supply order due date

• A length where you can see the information that you need, but where you can 
ignore the plan results of the final 30 to 45 days, in case orders disappear.

Set the firm flag on all the supplies to Yes. The planning solver does not change order 
dates.

Set all planning time fences to the end of the Rapid Planning planning horizon. The 
planning solver does not create supply.

Run the planning solver to:

• Make resource and material requirements the orders

• Peg demands to supplies

• Issue exceptions

• Calculate Exceptions/KPIs
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Unfirm the artificially firmed supplies and reset all artificially set planning time fences.

Baseline Plan Options
The Rapid Planning plan shows the name of the Advanced Supply Chain Planning 
plan. 

In tab Main, you can change these plan options: 

• ATP Enabled

• Category Set

• Use for S&OP

• Plan Security Attributes

In tab Organizations, the sections show the organizations and global demand, demand, 
and supply schedules from the Advanced Supply Chain Planning plan. 

Tab Advanced shows the profile option values from the Advanced Supply Chain 
Planning plan. 

Baseline Order Attributes and Options
This is how process Create Baseline Plans sets supply order attributes and what you can
do with the supply orders in Rapid Planning.

For firm supplies, the process makes dependent component requirements and resource 
requirements firm as well.

Oracle Advanced Supply Chain Planning 
Supply

Oracle Rapid Planning Supply

Scheduled receipt – No change recommended It inherits firm status from Advanced Supply 
Chain Planning and has Action = None.

You can plan it in a Rapid Planning 
simulation and release its recommendation. 

Scheduled receipt – Change recommended 
and not released

It inherits Firm = No and Action = Release. 

You can either: 

- Release the Advanced Supply Chain 
Planning recommendation straightaway 

- Plan it in a Rapid Planning simulation and 
release its recommendation 
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Oracle Advanced Supply Chain Planning 
Supply

Oracle Rapid Planning Supply

Scheduled receipt – Change recommended 
and released

It inherits Implement Firm, Action = None, 
and Suggested Due Date = Implement Date 

You can either:

- Leave it alone 

- Unfirm it, plan it in a Rapid Planning 
simulation, and release its recommendation 

Planned order – Unreleased and unfirm It inherits Firm = No and Action = Release. 

You can either: 

- Release the Advanced Supply Chain 
Planning recommendation straightaway

- Replace it by planning it in a Rapid Planning 
simulation 

Planned order – Unreleased and firm It inherits Firm = Yes and Action = Release.

You can either: 

- Leave it alone

- Release it straightaway

- Unfirm it, plan it in a Rapid Planning 
simulation, and release its recommendation 

Planned order – Released Inherits Firm = Yes, Suggested Due Date = 
Implement Date, and Action = None. 

You can modify the firm flag. When you plan 
a simulation, Rapid Planning removes it, 
unless it is part of the simulation scope. Oracle
recommends that you do not do this--if you 
rerun the plan, it plans another, you might 
accidentally release it, and you order double 
production.

Running Baseline Simulation Plans
You can't run the snapshot for these plans

You must replan in either of these modes:
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• Incremental Replan

• Launch Plan, do not refresh snapshot

Specifying Simulation Scope
See Define Incremental Replan Scope.

Comparing Plans
Use the Analytics view to compare supply orders between the baseline plan and the 
simulation plans.

Navigate to tab Metrics. Attend to these metrics:

• Total Supply Quantity

• Planned Order Quantity

• Make Planned Order Quantity

• Transfer Planned Order Quantity

• Buy Planned Order Quantity

• Work Order Quantity

• Purchase Orders / Requisition Quant

• Internal Purchase Orders / Requisition Quantity

• Total Demand Quantity

• Forecast Quantity

• Sales Order Quantity

See Base Metrics.

Navigate to tab Order Comparison, subtab Supply Order Comparison. You can see 
comparison between purchase orders, purchase requisitions, and work orders. It 
reports are: 

• Action changes: For example, cancelled orders vs non-cancelled orders, rescheduled
orders vs non-rescheduled orders, and have an action vs do not have an action.

• Due date changes (Available Date + [Equal To, Less Than, or Greater Than]): Supply
Due Dates between scheduled receipts are outside the range. For example, 
Available Date + greater than 10 = all supply order pairs with Supply Due Dates 
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more than ten days apart.

It does not report planned orders.

Release Orders
In the simulation plan that you use to solve the issue, release orders to the execution 
system.

Firm Orders
In the simulation plan that you use to solve the issue, firm the planned orders that you 
released.

They become firm planned orders when you pass them to the next Advanced Supply 
Chain Planning run.

Feeding Back to Advanced Supply Chain Planning 
Feed back the results of your Rapid Planning simulation decision to the next Advanced 
Supply Chain Planning plan run. 

See Oracle Advanced Supply Chain Planning Implementation and User's Guide. 

Purge Plans
You can purge Advanced Supply Planning plans that have baseline and simulation 
Rapid Planning plans. 

The Rapid Planning plans remain but don't have reference to a baseline plan and don't 
have any of the restrictions of a baseline plan. 

Implementation Guidelines
Advanced Supply Chan Planning can plan to the minute level. It can model detailed 
shop floor constraints such as sequence dependent setups, hard links.

Rapid Planning plans at the day level. You use it to get a rapid response to changes in 
plan inputs and data without needing to respect all of the detailed constraints.

In constrained plans, Rapid Planning always plans in Enforce capacity constraints 
mode. If you will compare Rapid Planning and Advanced Supply Chain Planning 
output, run the Advanced Supply Chan Planning plan as Constrained – Enforce 
capacity constraints.

Rapid Planning has a global parameter to control safety stock. Advanced Supply Chain 
Planning has organization-level control. If you will compare Rapid Planning and 
Advanced Supply Chan Planning output, set the Advanced Supply Chain Planning 
plan safety stock parameter in each plan organization to be the same as the Rapid 
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Planning parameter.

If you use any of these modeling constructs and constraints in the Advanced Supply 
Chain Planning plan, the Rapid Planning and Advanced Supply Chan Planning output 
will be very different:

• Process manufacturing organizations

• Project manufacturing organizations

• Flow routings

• Batchable resources

• Transportation capacity

• Fixed days supply order modifier

• Percentage based sourcing splits

• Product family level planning

• Bill of resources planning

• Phantom items

Copying a plan from ASCP to RP loads only the demand and supply within the 
simulation horizon. Keep the simulation horizon large enough to minimize end-of-
horizon effects. For example, if you want to simulate for 30 days and cumulative lead-
time is 15 days, Oracle recommends that you set the horizon to 45 days. The demands 
within the simulation horizon will use supplies up to 30 days; otherwise the planning 
solver may drop them.

Simulation Scenarios

Hot Demand
This is a possible scenario for processing a hot demand.

You have a production plan.

You receive information on a hot demand.

Copy your production plan to a new plan named Hot Demand.

View the Supply Chain Bill for the demanded item.

Navigate to the Material Plan view. Note the supply, demand, and projected available 
balance.

Navigate to the Supply/Demand view, enter the hot demand, and assign it a high 
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priority.

Re-navigate to the Material Plan view and notice the impact of the hot demand, 
including the negative projected available balance.

Save the Hot Demand plan.

Run plan Hot Demand without changing current orders.

Note that the planned date for the hot demand is unacceptably late.

Re-run plan Hot Demand with the ability to change current orders.

Review key performance indicators, favorites, and order comparison information 
between the production plan and the Hot Demand plan.

If the Hot Demand plan is the more acceptable plan, release planned orders from it. 

Engineering Change Cut-in
This is a possible scenario for processing an engineering change order cut-in.

You have a production plan.

You receive information on a phase out-phase in bill of material change

Copy your production plan to a new plan named ECO Change 1.

Navigate to the Bill of Material view and modify the bill of material by changing the 
effectivity dates.

Run plan ECO Change 1.

Navigate to the Horizontal Plan screen and review the projected available balance for 
the two components. Check for a large final projected available balance on the phase-
out component.

Compare key metrics, for example, excess inventory monetary value and late days, 
between the production plan and plan ECO Change 1.

If there is, for example, unacceptable excess inventory monetary value, copy your plan 
ECO Change 1 to a new plan named ECO Change 2.

Re-navigate to the Bill of Material Edit/Update screen and modify the bill of material 
with a new cut-in date.

Run plan ECO Change 2.

Navigate to the Material Plan view and review the projected available balance for the 
two components.

Compare key metrics, for example, excess inventory monetary value and late days, 
between the plan ECP Change 1 and plan ECO Change 2

Release planned orders from the more acceptable ECO Change plan.



Implementation & Plan Analysis: Simulations    11-25

Yield Bust
This is a possible scenario for processing a yield bust.

You have a production plan.

You receive information on a reduction in inventory by 100 pieces due to a yield bust.

Copy your production plan to a new plan named Supply Change

Navigate to the Supply/Demand view and lower the inventory by 100 pieces.

Navigate to the Material Plan view and note the projected available balance change.

Run plan Supply Change.

Compare key metrics between the production plan and plan Supply Change.

If you find that the results from the Supply Change plan are unacceptable, check 
alternate components and find one with supplier capacity of 100 per day.

Negotiate with your supplier for supply of an alternate component.

Re-run plan Supply Change.

Re-compare key metrics between the production plan and plan Supply Change.

If the Supply Change plan is the more acceptable plan, release planned orders from it.

Resource Downtime
This is a possible scenario for processing a resource downtime.

You have a production plan.

You receive information on a down bottleneck resource for all of next week.

Copy your production plan to a new plan named Resource Downtime.

Navigate to the Resource Availability view and decrease the resource availability for 
next week to zero.

Run plan Resource Downtime

Compare key metrics between the production plan and plan Resource Downtime.

If you find that the results from the Resource Downtime plan are unacceptable, check 
alternate resources.

Negotiate for overtime on an alternate resource for next week.

Re-navigate to the Resource Capacity view and increase the alternate resource 
availability for next week by 20%.

Re-run plan Resource Downtime.

Re-compare key metrics between the production plan and plan Resource Downtime

If the Resource Downtime plan is the more acceptable plan, release planned orders from
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it.
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12
Implementation: Best Practices

Step 10: Best Practices
To have best performance of your Rapid Planning functions, attend to Oracle 
recommendations.

Implementation
Follow these implementation best practices to improve your performance.

Display only the columns in Supply/Demand window that you need to see.

Create a default Material Plan and view with Item/Organization/Week as filter.

Query a plan for only the items that you need to see. If you don't need simultaneous 
view of multiple items, query them one at a time.

When querying entities, use as many filters as you can.

Select only those rows to expand that you need, for example, to view pegging.

Export entities only when needed and export only the rows that you need to see. Do 
multiple small exports instead of one large export.

Do only one query at a time.

Installation and Configuration
See Oracle Rapid Planning Installation Guide, Best Practices.
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13
Plan Analysis: Workbench

Responsibilities and Menus
The seeded responsibility for Rapid Planning planners is Supply Chain Simulation 
Planner.

This responsibility can access these menus:

• Plans, Inputs, and Simulations: The Oracle Rapid Planning workbench.

• Collections, Sourcing, Setup, and Other: Forms appropriate to Oracle Rapid 
Planning from Oracle Advanced Supply Chain Planning. For information about 
these forms, see Oracle Advanced Supply Chain Planning Implementation and User's 
Guide.

Rapid Planning Workbench 
The Rapid Planning Workbench is a workspace designed with these characteristics:

• Simple to understand and easy to learn

• Access to lots of data

• Customizable data displays

• Quick entry of data changes for simulation

When you access Rapid Planning Workbench, you see the global region and a 
workspace region.

The top region has:

• Your user name
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• Link Home: Returns to the E-Business Suite Rapid Planning responsibility menu

• Link Preferences: Set Oracle E-Business Suite preferences

• Link Help

• Link Logout

• Button Save: Saves your updates from all the tabs in the workbench. This is 
different from the Workbench Actions > Save Plan.

• Button Cancel: Discards your current updates and reverts to the last saved version 
of the plan.

The buttons to save and cancel changes apply to all tabs in the workspace. If you make 
changes in one tab and move to another tab, the Workbench prompts you to save your 
changes

The workspace region contains:

• Tabs: Use these to view and manipulate the data. You can open as many multiple 
tabs as you need to accomplish your task. The Workspace region has top and 
bottom frames; they are independent places to open more tabs and are not related 
as in, for example, master-detail information.

• Links: Use these to manipulate the plans. You can hide this area; click icon Collapse 
Pane. To show it, click icon Restore Pane.

When you access Rapid Planner Workbench, The open tabs are:

• Plans

• Plan Inputs

The Plans contain a navigator on the left that contains three regions that you can access. 
They are:

• Plans: Displays a complete list of all the plans that are in the states Launched, 
completed and Loaded into memory; Launched and currently in-process; and 
Launched and errored out

• Plan Links: Contains links to workbench views that display data about the currently
selected plan; you can take action against the data

• Plan Actions: Links to workbench views with actions that users need to manage the 
plans

The Plan Input tab displays a simpler navigator on the left that only has the Plan Input 
Links region. These links open views that you can use to see and update plan inputs 
and simulation set information
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Operating in Tabs
Rapid Planning Workbench is organized into multiple views in these main tabs:

• Plan Inputs

• Plans

As you open each view, there are these areas:

• Search area: The top of the view

• Search results: The bottom of the view

These areas have common features that you work with.

If you want to make a tab disappear, click on its title, then click its icon Close.

This is an example of a workbench view

Search Area (Top of the View)
The search area displays attributes that you can use to limit the display in the search 
results area. For example, in the Items tab, you can search for Item, Organization, 
Category, Product Family Item, Planner, Last Update Date, and Changed By.

Fill up the search fields that you want to, then click button Search.

Oracle recommends that you enter search criteria. If you do not, the data may take a 
long time to load. The view may remind you if you click Search without entering search
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criteria.

If you search on more than one criteria, the search process treats them as if they are 
joined by logical operator AND. For example, you search on

• Item Equals AS54888

• Organization Equals M1

The search process finds everywhere in the data that Item Equals AS54888 AND 
Organization Equals M1

The search area shows Basic search fields. If you want to do a more advanced search, 
click button Advanced. The search area shows more fields to search on and shows 
button Basic to return to the basic search criteria.

If the advanced search does not contain all the fields that you want to search on, click 
button Add Fields and select them from the list.

To clear all the search criteria, click button Reset.

Search Results Area (Bottom of the View)
The search results area shows the data that matches your search.

• Change how the data displays

• Act on the data

There are some common functions that appear in many views. See Search Results Area 
– Displaying Data and Search Results Area – Acting on Data.

Some functions in the search results area are unique for certain tabs. See Rapid Planning
Workbench Views, page 14-1

Search Results Area (Bottom of the View) – Displaying Data
You may see some or all of these menu items on the data area menu bar:

• Actions

• View

• Format

In addition, you may see icons and buttons on the search results menu bar.

Saving Data to Spreadsheet

If you want to see the data in a Microsoft Excel spreadsheet, click Actions > Export to 
Excel or click button Export to Excel. The export includes the column headings and 
Grand Totals..



Plan Analysis: Workbench    13-5

Printing Data

If you want to see the data printed out, click Actions > Print Page. A pop-up window 
opens with the data in a printable page format.

Sorting Data

To sort the data by a certain column, mouse over the column title and select either icon 
Sort Ascending or icon Sort Descending. Also, you can click View > Sort > Ascending or 
View > Sort > Descending.

To sort on multiple columns, click View > Sort > Advanced… In the advanced sort pop-
up window, select up to three column names and whether each should sort by.

Changing Column Order

To change the order of the columns, click View > Reorder Columns…. A pop-up 
window shows the available columns. To move column positions, click the columns' 
name in the pop-up window and then click one of these icons:

• Move selected items to top of list

• Move selected items up one in list

• Move selected items down one in list

• Move selected items to bottom of list

Changing Column Size

To change the size of columns, click Format > Resize Columns.

Wrapping Column Data

To wrap the data in the columns, click the Wrap icon or select Format > Wrap.

Removing a Column

To make a column disappear, click View > Columns and click the columns to disappear.

Adding a Column

If you want to add a new column, click View > Columns > Show More Columns. Then 
click the columns you want to see. 

Displaying All Columns

If you want to display all the columns available for the tab, click View > Columns > 
Show All

Moving Up a Data Hierarchy

To move up in a chain of data, for example, a supply chain bill or pegging tree:

• To the original top level where used, click icon Go top

• To the next level where used, click Go up
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Making a New Top Level

To make the currently selected row the new top level, click Show as top. To return the 
display to the original top level where used, click on the new top level, then click either 
icon Go up or icon Go top.

Freezing Data Columns

If you want to freeze columns, click in a column, then click icon Freeze or click View > 
Freeze. The column that you selected and all columns to its left freeze while you can 
scroll through the columns to its right.

Showing Data in a Separate Window

If you want to open the data area in a separate window of its own, click icon Detach. To 
resume working in the tab, click icon Attach. Use this function if you need to see a large 
number of data rows.

Searching Using Query-by-Example

To search using the query-by-example method:

• Click icon Find or click View > Query by Example. A blank row appears above the 
column titles. Enter your search criteria there. To execute the search, click Return or 
Search in the query panel. To exit, remove the search criteria and click icon Query 
by Example again.

• This function only works with fields that Oracle enables as query-by-example 
fields; for example, in view Clear to Build Simulation, you cannot query by example
on fields Prioritize for Clear to Build and Deprioritize for Clear to Build.

• In the Supply and Demand view, do not click the Query by Example icon. Click the 
binocular icon "Query By Example Mode to translate the view into a simple table.

• For alphabetic fields, you can use operators

Generally, you can use query-by-example in all views and all fields except:

• String fields: STARTS WITH, EQUAL TO, WILD CARD SEARCH

• Quantity fields: EQUAL TO, GREATER THAN, LESS THAN

Using Column Groups

In some tabs, Oracle assigns multiple, related columns into column groups. If you want 
to see the columns arranged by their groupings, select View > Column Groups. For 
example, in tab Supply & Demand, the column groups are Main, Release, and Other.

Viewing Related Data

If you want to open a tab with data that is related to the data you are viewing, select 
rows in the data area, then click a button with the name of another tab.

Viewing More Tabs
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Sometimes, there are more buttons with the names of other tabs that do not fit in the 
current tab. Click icon double-greater than and select them from the list of buttons.

Favorites
Use Favorites when you want frequent access to certain information on the workbench.

You can have your own:

• Multiple lists of items, resources, and suppliers

• Navigation to material and resource plans, exceptions, and supplies and demands 
for multiple items, resources and suppliers

A favorite list is either:

• Static: For example, items, resources, suppliers, supplies and demands

• Dynamic: Based on a filter condition and built when you use it in the current plan

To access a favorites list from a view, click on Favorites.

Static Favorites

To create a static favorites list:

• Query entities that you want to visit frequently, for example, specific items.

• Multi-select them

• Navigate Actions > Save to Favorites. Enter a name.

Dynamic Favorites

These are the dimensions and measures that you can use:

• Item and organization

• Fill rate %

• Inventory turns ratio

• On time orders %

• Late replenishment for sales order (value)

• Late replenishment for forecast (value)

• Demand quantity not satisfied (value)

• Resource and organization: Resource utilization %
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• Supplier:

• Supplier capacity utilization %

• Purchasing cost

To create a dynamic favorites list:

• Navigate to the view Analytics tab

• Select one of the measures.

• Click tab Filter and check Save results to a Favorite list. Enter a name.

Search Results Area (Bottom of the View) – Acting on Data
Copying Data to New Rows

If you want to copy a data to new rows:

• Highlight the rows that you want copied

• Click the Duplicate icon or click Actions > Duplicate Selected

Deleting Data Rows

If you want to delete a row of data:

• Highlight the rows that you want deleted

• Click the Delete icon or click Actions > Delete Selected

• Specify a simulation set, see Managing Simulation Sets, page 11-7.

The deleted data remains displayed. It is in red with a strikethrough and the change 
flag is red.

You cannot delete certain entities, for example, items.

Adding Data Rows

To add a row, click icon Add Row

Editing Data Rows

To edit a row, either:

• Double-click in it

• Click in it then click icon Edit

Then, enter or select the new value into the field

To change individual data, click in the field and type in the new data.
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Editing Multiple Data Rows

To edit multiple rows, click in them using the Shift and Ctrl keys. To select all rows, 
click Actions > Select All or click icon Select All. See Mass Update.

Unselecting Data Rows

To unselect a selected row, click in it.

To unselect all selected rows, click in an area of the tab that is not a selected row

Mass Update
Use mass update to edit multiple rows.

Editing One Column

To edit one column (mass update):

• Use search criteria or a favorite to limit the display to the rows that you want to 
change

• Click the column header

Editing Multiple Columns

To edit multiple columns (mass update):

• Use search criteria or a favorite to limit the display to the rows that you want to 
change

• Click the column headers using the Shift and Ctrl keys or rubber banding

Making the Edits

Click icon Mass change or navigate Actions > Update Selected

The tab opens window Update Data. In each row, select a field and an update action, 
then enter a new value. Each update applies to all the rows you selected.

Saving and Committing

If you want to save all your changes, click Actions > Update All.

If you want to save some of your changes:

• Highlight the rows that you want changes saved

• Click Actions > Update Selected

Viewing Changed Data

After you change data:

• It appears in blue highlight
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• There is a flag that appears in the left column to show the rows that are changed.

Applying Changes to the Database

If you want to apply your changes to the database, click button Commit or click Actions
> Commit. To reverse the commit, click button Rollback.

Reversing Mass Updates

If you want to reverse the changes you have made:

• Highlight them

• Navigate to Plan Actions > Undo All User Changes

Mass Update Time Capabilities

In the Supplies & Demands and the Resource Availability views, mass update hinges on
a separate value of the record. This ensures that each record is updated independently. 
That is, the records do not all assume the same value.

The number of rows that are updated are displayed at the bottom of the Resource 
Availability view and the Supplies & Demand View.

The additional option Increment by and Decrement by are also included in the Mass 
Update FROM TIME.

Resource From Time To Time

Resource 1 8:00 4:00

Resource 2 8:30 4:30

Resource 3 8:00 3:00

Resource 4 9:00 4:00

Using this new feature, if we reset the To Time of Resource 1 by one hour, the new To 
Time is 5:00. Resources 2, 3, and 4 are then also incremented independently by one 
hour, as shown below:

Mass Update in the Resource Availability View
Mass updating in the Resource Availability view can be based on a separate value in 
order to obtain results with separate values. This feature is available in the FROM TIME
and TO TIME fields. 

Example: The following defines the resources work time:
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Resource From Time To Time

Resource 1 8:00 4:00

Resource 2 8:30 4:30

Resource 3 8:00 3:00

Resource 4 9:00 4:00

Using this new feature, if we reset the To Time of Resource 1 by one hour, the new To 
Time is 5:00. Resources 2, 3, and 4 are then also incremented independently by one 
hour, as shown below:

Resource From Time To Time

Resource 1 8:00 5:00

Resource 2 8:30 5:30

Resource 3 8:00 4:00

Resource 4 9:00 5:00

To support this and similar features, the following options are included in the Mass 
Update TO TIME:

• From Time +

• Increment by

• Decrement by

The additional option Increment by and Decrement by are also included in the Mass 
Update FROM TIME.

Calculating the Value of TO TIME
Using the resources work time from the example above, the sections show how each 
option behaves.

Using the FROM Time + Option to Calculate To Time

When you select the FROM Time + option, then:
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To Time = From Time + Entered Value

If we select 9 as the Entered Value, then To Time = From Time + 9.

The new values of To Time are:

Resource From Time To Time

Resource 1 8:00 5:00

Resource 2 8:30 5:30

Resource 3 8:00 5:00

Resource 4 9:00 6:00

Using the Increment by Option to Calculate the Value of To Time

When you select the Increment by option, then:

To Time = To Time + Entered Value

If we select 2 as the Entered Value, then To Time = To Time + 2. The new values of To 
Time are:

Resource From Time To Time

Resource 1 8:00 6:00

Resource 2 8:30 6:30

Resource 3 8:00 5:00

Resource 4 9:00 6:00

Using the Decrement by Option to Calculate To Time

When you select the Decrement by option, then:

To Time = To Time – Entered Value. 

If we select 1 as the Entered Value, then To Time = To Time – 1. The new values of To 
Time are:

Resource From Time To Time
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Resource 1 8:00 3:00

Resource 2 8:30 3:30

Resource 3 8:00 2:00

Resource 4 9:00 3:00

Calculating the FROM TIME
The options Increment by and Decrement by are included in the Mass Update FROM 
TIME.

Using the resources work time as shown below, the following examples show how each
option behaves. 

Resource From Time To Time

Resource 1 8:00 4:00

Resource 2 8:30 4:30

Resource 3 8:00 3:00

Resource 4 9:00 4:00

Using the Increment by Option to Calculate From Time

When you select the Increment by option, then: 

From Time = From Time + Entered Value.

If we select 2 as the Entered Value, then From Time = From Time + 2. The new values of 
From Time are:

Resource From Time To Time

Resource 1 8:00 10:00

Resource 2 8:30 10:30
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Resource 3 8:00 10:00

Resource 4 9:00 11:00

Using the Decrement by Option to Calculate From Time

When you select the Decrement by option, then: 

From Time = From Time – Entered Value. 

If we select 1 as the Entered Value, then From Time = From Time – 1. The new values of 
From Time are:

Resource From Time To Time

Resource 1 8:00 7:00

Resource 2 8:30 7:30

Resource 3 8:00 7:00

Resource 4 9:00 7:00

Validations Rules for From Time and To Time
The following validations are required when editing From Time and To Time values:

Case 1: To Time Is Greater Than (>) From Time 

1. 0 {(ShiftDate + To Time + Increment By) – (ShiftDate + From Time)} < 24

For example, if :

ShiftDate = Sept 13th

To Time = 4:00

Increment By = 2

From Time = 3:00, then

0 {Sept 13th + 4:00 + 2:00) – (Sept 13th + 3:00)} < 24

0 Sept 13th 6:00 – Sept 13th 3:00 < 24

This condition is met because the difference is 3 hours.

2. 0 {(ShiftDate + To Time + Increment By) – (ShiftDate + From Time)} < 24
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3. 0 {(ShiftDate + To Time - Decrement By) – (ShiftDate + From Time)} < 24

4. 0 {(Shift Date + To Time) – (From Time + ShiftDate + Increment By)} < 24

5. 0 {(ShiftDate + To Time) – (ShiftDate + From Time – Decrement By)} < 24

Case 2: From Time Is Greater Than (>) To Time 

1. 1. 0 {(ShiftDate_plus1 + To Time + Increment By) – (ShiftDate + From Time)} < 24

For example, if :

ShiftDate = Sept 13th

To Time = 4:00

Increment By = 2

From Time = 8:00, then

0<= Sept 13th + 1 + 4:00 + 2:00 – (Sept 13th + 8:00) <=24

0<= Sept 14th 6:00am – Sept 13th 8:00am <=24

This condition is met because the difference is 22 hours.

2. 0 {(ShiftDate_plus1 + To Time + Increment By) – (ShiftDate + From Time)} < 24

3. 0 {(ShiftDate_plus1 + To Time - Decrement By) – (ShiftDate + From Time)} < 24

4. 0 {(ShiftDate_plus1 + To Time) – (From Time + ShiftDate + Increment By)} < 24

5. 0 {(ShiftDate_plus1 + To Time) – (ShiftDate + From Time – Decrement By)} < 24

Case 3: From Time is 00:00

If you need to change a From Time, which is currently 00:00, To Time can take a value 
of 24:00. Note that when From Time or To Time is modified, the conditions of Case 1 of 
the Validations Rules for From Time and To Time, apply.

Notes:

1. If any of the conditions listed in the above section, Validations Rules for From Time 
and To Time are violated, do not change either the From Time or the To Time.

2. If a specific record violates the validation rules, then the update is not applied to 
that specific record. In the case of records that are not violated, the updates is 
applied.

A message is displayed, which indicates the number of records that have succeeded and
the number of records that have failed. For example, you will see a message such as: 
Mass Update has failed on 6 out of 76 records. Mass Update has succeeded on 70 out of 
76 records.

To Change Both the From Time and To Time
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When you need to change both the From Time and the To Time in the Resource 
Availability view, follow the procedure below:

1. Make your initial change to the From Time.

2. Using the new From Time result from Step 1, calculate the new To Time.

3. If any of the above validation rules are violated when you calculate Step 1 or Step 2,
then do not change either the From Time or To Time.

Mass Update in the Supplies and Demand View
Similar to the Resource Availability view, mass update is available in the Mass Update 
FIRM DATE in the Supplies and Demand view. The options are:

• Reset to Original

• Set Value To

• Sugg Due Date+

The new options and their behavior are: 

• Increment by

If Firm Date is not null: 

Firm Date = Firm Date + Entered Value

If Firm Date is null:

Firm Date = Suggested Due Date + Entered Value

• Decrement by

If Firm Date is not null:

Firm Date = Firm Date – Entered Value

If Firm Date is null:

Firm Date = Suggested Due Date - Entered Value

• Request Date +

Firm Date = Request Date + Entered Value

If you choose Request Date, the system first looks for Requested Arrival Date. If the 
Requested Arrival Date is not populated, then it uses the Requested Ship Date.

Notes:

1. Request Date + and Sugg Due Date + can have a positive or negative value.
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2. For all views the mass update feature for the operators Increase by, Decrease By, 
Increase By %, Decrease By %, Sugg Due Date +, Request Date +, etc. are applied to 
the value displayed in the UI and not the value saved in the database. For this 
reason, the operators must be applied to un-saved date changes too.
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14
Plan Analysis: Inputs

Input Views
Use the views to view, analyze, and update the plan information

Access them from the Plan links section in the Plan tab and the Plan input links in the 
Plan inputs tab.

For each view, this tells you:

• The view name

• The regions that it commonly appears in

• What it is for and how to use it 

Bills of Materials
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view bills of material.

You can edit data in this view.

Plan Tab

Search, view, and analyze the bills of material, components, and substitute components 
used in the plan.

Plan Inputs Tab

Add a bill of material or some of its components or substitutes to a simulation set.

Plan Tab and Plan Inputs Tab

Duplicate a bill of material, a component, or a substitute and make edits for simulation 
purposes

Mass edit a set of rows, for example, all assemblies that use a particular component and 
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do a single-row edit to these attributes:

• Component effectivity date

• Component disable date

• Component

• Substitute component

• Component usage quantity

• Substitute priority

• Substitute quantity

• Substitute item UOM

Calendar Association
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view the associations of ship methods and calendars.

You cannot edit data in this view.

Plan Inputs Tab

Search, view, and analyze the associations of calendars to organizations, suppliers, 
customers, and carriers. 

Calendars
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view calendars.

You can edit data in this view.

Plan Inputs Tab

Search, view, and analyze the working days and non-working days of any calendar. 

You can edit attribute Status (working or non-working) for simulation purposes in 
simulation sets

Component Substitution
Most tabs share common functions, see Operating in Tabs.

Use this tab to view component substitutions.

You can edit data in this tab, including mass update.
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Item Substitution
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view item substitutions.

You can edit data in this tab, including mass update.

Items
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view item attributes.

You can edit data in this tab.

Enhance Item's List of Values

The List of Values (LOV) for an Item can be searched based on the following criteria:

• Starts With

• Contains

• Equal to

You can also perform a wildcard search, using the Contains option. For example, you 
can search for %ITM% or ITM.

All three search criteria apply to all the views where an Item's LOV is used in Rapid 
Planning as well as all Plan Inputs tab. The views are given below:

• Analytics: Create, Edit Metrics

•  Exceptions: Search

•  Supplies and Demand: Search

•  Material Plan: Set Up: Filter

•  Items: Search

• Supply Chain Bill: Search

•  Bill of Material: Search

• Clear to Build: Search

• Processes: Search

Plan Tab
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Search, view, and analyze the items used in the plan

Plan Inputs Tab

Make changes to items and add them to a simulation set

Plan Tab and Plan Inputs Tab

Mass edit a set of rows, for example, all items of a particular category, or do a single-
row edit to update any of these attributes

• Maximum Order Quantity

• Minimum Order Quantity

• Fixed Lot Multiple

• Fixed Order Quantity

• Variable Lead Time

• Fixed Lead Time

• Preprocessing Lead Time

• Processing Lead Time

• Postprocessing Lead Time

• Acceptable Early Days

• No New Planned Orders Before WIP

Manufacturing Order Operation Networks
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view manufacturing order operation networks.

You can edit data in this tab, including mass update.

Manufacturing Order Resource Requirements
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view manufacturing order resource requirements.

You can edit data in this tab, including mass update.

Resource Availability
Most tabs share common functions, see Operating in Tabs, page 13-3.
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Use this tab to view resource availability.

You can edit data in this view.

Plan Tab

Search, view, analyze, and edit the resource availability used in the plan

Plan Inputs Tab

Add simulation set changes or manual over-rides on resource availability

Plan Tab and Plan Inputs Tab

Mass edit a set of rows, for example, all dates of a particular resource, or do a single-
row edit to update any of the following attributes

• Shift Date

• Assigned Units

• Start Time

• End Time

Resources
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view resource attributes.

You can edit data in this view.

Enhance Resource's List of Values

The List of Values (LOV) for a Resource can be searched based on the following criteria:

• Starts With

• Contains

• Equal to

You can also perform a wildcard search, using the Contains option. For example, you 
can search for %RES% or RES.

All three search criteria apply to all the views where a Resources's LOV is used in Rapid
Planning as well as all Plan Inputs tab. The views are given below:

• Analytics: Create, Edit Metrics

• Exceptions: Search

• Resource Availability: Search
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• Resource Requirement: Search

• Resource Plan: Search

• Resources: Search

• Clear to Build: Search

• Processes: Search

Plan Tab

Search, view, analyze, and edit the resources in the plan

Plan Inputs Tab

Search, view, analyze, and edit the resources in the plan and add resource changes to a 
simulation set

Plan Tab and Plan Inputs Tab

Mass edit a set of rows or do a single-row edit to update attribute Bottleneck Resource 
flag.

Routing Operation Networks
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view routing operation networks.

You can edit data in this tab, including mass update.

Routings
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view routings.

You can edit data in this tab, including mass update.

Suppliers
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view supplier attributes--ASL's and supplier capacity.

You can:

• Add capacity to a supplier-item-org. You cannot create a supplier-item-org.

• Multi-select and duplicate ASL and supplier capacity rows

• Edit data 
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• Mass update data

• Save edits in simulation sets

You cannot have overlapping dates within the same supplier-supplier site-item-org.

There is no organization field in this view because Rapid Planning ASL information 
applies the same to all organizations for each item-supplier. For example, if you 
individual or mass edit information, duplicate a row, or add to a simulation set, the 
action applies to all organizations with that same item-supplier. 

Plan Tab and Plan Inputs Tab

Search, view, and analyze the approved supplier lists and the supplier capacities used 
in the plan

Supply Chain Bill
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view a graphical and tabular supply chain bill. 

You cannot edit data in this view.

The supply chain bill is a nested tree of the:

• Component structure: For all effectivity dates

• Sourcing hierarchy: This is from the assignment set of the plan options

There is not a separate row in the supply chain bill for Make at or Transfer from 
sourcing. There is a separate row for Buy from sourcing.

The tab shows all alternate bills of material unless you restrict it through search field 
Alternate BOM.

The tab does not show substitute components.

To add a component to an assembly:

• Click one assembly only

• Click icon Add Component

To add a component to an assembly by duplicating another component:

• Click one component only

• Click icon Duplicate Component

• Use line editing to change the duplicated component row

To remove a component from an assembly:
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• Click one assembly only

• Click icon Remove Component

Components Plan Tab

Search, view, and analyze the complete supply chain of specific end assemblies and 
their bills of material and sourcing.

You cannot make any edits in this view for simulation purposes. You can use the Bill of 
Materials view to edit bill of material attributes.

Processes Plan Tab and Processes Plan Inputs Tab

Search, view, and analyze the routings, operations, and resources assigned to each 
operation

You cannot make any edits in this view for simulation.

Plan Options
Use this view to maintain plan options.

You can access the plan options:

• As part of the action Create Plan.

• From the Plan Actions menu when you have a plan open.

Use this sequence to set up plan options. Set:

• Plan attributes

• Plan horizon

• Forecast allocation and consumption options

• Planned organizations and demand and supply schedule inputs

• Advanced plan options

The plan options view has these tabs:

• Main: Options that influence solver behavior.

• Organizations: Planned organizations and demand and supply schedule inputs

• Advanced: Advanced Options that influence solver behavior. They come from 
profile options.

Audit information about plans is now displays when a plan was last saved and by 
whom. To view this information, two fields, Last Saved Date and Last Save By, have 
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been added to the Plan Options screen. These fields are updated every time a Plan is 
saved.

In addition, when you save changes to rows, you receive a confirmation message, which
indicates the number of rows that have been updated, the number of successful 
updates, and the number of failed updates.

Main Plan Options Tab
The plan options Organizations tab has regions for. 

• General plan options: Define Plan Attributes

• Plan security: Define Plan Security Attributes

• Buckets and horizons: Define Plan Attributes

• Forecasting: Forecast Allocation and Consumption

• Auto release: Auto Release Parameters. See Planned Order Auto Release.

Explode Forecast: specifies that the planning solver should explode configure to order 
forecasts. Do not select this option if you are driving the plan with pre-exploded 
forecasts.

RP Planning Item Type. Values are:

• MPS: A master production schedule

• MPP: A master production plan

• MRP: A material requirements planning plan

• DRP: A distribution planning plan

This table shows the options in the Main tab.
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Plan Option Description

Plan Name Plan name

Plan Description Plan Description

Organization Plan owning organization

Planned Item Type The planning method of items included in the 
plan

Planned Items Items that are planned. Valid values are:

• All Planned Items

• Demand Schedule Items and all sales 
orders

• Demand Schedule and WIP components

• Demand Schedule items only

• Demand Schedule Items, WIP 
components and all sales orders

Unconstrained Plan Constrained or unconstrained mode.

Assignment Set Assignment set to use in the plan.

End Item Substitution Set End-item substitution set to use in the plan.

Simulation Set Simulation set to use in the plan.

Demand Priority Rule Demand priorities to use in the plan.

Overwrite To determine which firm orders the planning 
solver uses in this plan run.

Planning Time Fence Control Planning time fence to use in the plan.

Demand Time Fence Control Demand time fence to use in the plan.

Category Set Item category set to use in the plan.
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Plan Option Description

Number of Planning Buckets (Daily) Number of daily buckets to be included in the 
plan.

Plan Start Date The start date of the plan, set to the current 
date by default

Plan End Date The end date of the plan, calculated 
automatically based on the start date and 
number of planning buckets

Forecast Spreading Whether to spread the forecasts.

Consume by Forecast Bucket Whether forecast consumption is by forecast 
bucket or based on backward and forward 
consumption days.

Backward Days Forecasts falling within this many days before 
the sales order date are eligible for 
consumption by the sales order.

Forward Days Forecasts falling within this many days after 
the sales order date are eligible for 
consumption by the sales order.

Auto-Release Auto-release the recommendations.

Organization Plan Options Tab
The plan options Organizations tab has regions for. 

• Organizations

• Global forecasts and sales orders: Global Demand Schedules

• Local forecasts and sales orders: Demand Schedules

The fields for subinventory netting appear on a separate window.

Ship to consumption level

Specifies the forecasts that the planning solver should consume. Valid values are:

• Customer: Consumption occurs when item numbers and customer numbers match 
between the forecast entry and the sales order line.
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• Customer Site: Consumption occurs when item numbers, customer numbers, and 
customer ship-to addresses match between the forecast entry and the sales order 
line.

• Zone: Consumption occurs when the item numbers and the zone to which the 
customer ship-to address belongs match between the forecast entry and the sales 
order line.

• Zone Customer: Consumption occurs when the item numbers, the zone containing 
the customer ship-to address, and the customer numbers match between the 
forecast entry and the sales order line.

• Demand Class: Consumption occurs when item numbers and demand class match 
between the forecast entry and the sales order line.

• Item-organization (default value): Consumption occurs when item numbers match 
between the forecast entry and the sales order line.

All values apply to global forecasts. For local forecasts, you can use Customer, 
Customer Site, Demand Class, and Item-org.

This table shows the options in the Organizations tab.

Plan Option Description

Organizations Organizations to plan. in the Rapid Plan. Note
– 

• You cannot edit some checkboxes.

• List all organizations that are in your 
sourcing rules. The planning solver uses 
missing organizations as sources of 
infinite supply.

Sub-Inventories Subinventories to net.

Demand Schedules Demand schedules to use in the plan.

Ship To Consumption Level Forecasts to consume.

Global Demand Schedules Global forecasts.
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Advanced Plan Options Tab
The plan options Advanced tab has the plan options that:

• Default from profile options

• Control natural time fence; see Planning Time Fence

This table shows the options in the Advanced tab.

Plan Option Description

Auto-Release Compression Days Tolerance Number of compression days allowed for 
auto-release of planned orders.

Consume Forecast Inside Demand Time Fence Determines whether to apply forecast 
consumption or demand time fence first.

Consume Forecast with No Demand Class Order of forecast consumption when some 
have demand classes.

Consume Forecasts Using Internal Sales 
Orders

Should internal sales orders consume 
forecasts.

Default Forecast Priority Default priority value for forecasts.

Default Sales Order Priority Default priority value for sales orders.

Safety Stock Bucket Start Offset Days Number of days after the plan run date that 
the safety stock window starts.

Firm Internal Reqs Transferred to OE Consider internal requisitions transferred to 
Oracle Order Management as firm.

Inflate WIP Resource Requirements Whether to inflate resource requirements by 
efficiency and utilization during collections 
from Oracle Work in Process.

Released Only By User Whether to restrict implementation of planned
orders to the current user.

Requisition Load Group Option Group by option to use when loading 
requisitions from the workbench
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RP Group Planned Orders Whether to restrict implementation of planned
orders and recommendations to the current 
group.

RP - Component Substitution Logic Whether to use on-hand of the primary item 
or its substitutes first to satisfy the demand.

Lateness Threshold for Consuming Existing 
Supplies

The number of days late that an order can be 
to use on hand of substitute components.

Safety Stock Planning Method Whether to calculate safety stock and whether 
to use time phase or quantity based safety 
stock.

Create Time Fence Whether to recalculate the time fence date to 
the latest due date of scheduled receipts.

Firm Planned Order Time Fence Whether to recalculate the time fence date to 
the latest due date of firm planned orders.

Firm Internal Requisition Time Fence Whether to recalculate the time fence date to 
the latest due date of firm internal 
requisitions.

Basic Plan Actions
Use the actions to act against plans. You find links to the actions in the Plan Actions 
section of the navigator in the Plan inputs tab.

For each action, this tells you:

• The link name

• The regions that it commonly appears in

• What it is for and how to use it

You cannot perform all actions on all plans. For example:

• You cannot load, save, or close a plan that you have created but never launched.

• You cannot perform any action against a plan that is being saved or being re-
planned (launched).

• You cannot load, save, or copy a plan that has failed its re-plan. 
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Create Plan
Use this action to create plans.

It opens the plan definition and options page in a pop-up window with an empty plan 
name and default values. Once you create a plan, you can see it in the list of plans.

Launch Plan
Use this link to re-plan plans.

It opens a launch plan page in a pop-up window.

Field Plan shows that plan that you currently have selected and you can select another 
one instead.

If you don't have any plan selected, field Plan is blank and you can select one 

You select:

• Incremental replan: Select this option if the simulation changes made in this plan 
are adding new manual demands. Do not use if you simulated anything else, that 
is, changed forecasts, supplies, or other reference data, for example, items.

• Launch Plan, do not refresh snapshot: Select this option if you want to do a 
complete solve and if the collected data has not changed since the last time you re-
planned.

• Launch Plan, refresh snapshot: Select this option if you want to do a complete solve 
and if the collected data has changed, or if there are fresh simulations made in the 
simulation set since the last time you re-planned.

The progress bar shows the progress of the planning solver.

Schedule a Plan Run
When you are signed in under the Oracle Supply Chain Simulation Planner, you can 
schedule a plan run.

To schedule a plan run:

1. Sign in under the Oracle Supply Chain Simulation Planner responsibility.

2. Under the Other heading, click Request.

The Submit Request form pop-up window appears.



14-16    Oracle Rapid Planning Implementation and User's Guide

3. Click the Name field.

You can select the name of the concurrent request, Launch Simulation Planner.

The Parameter screen appears.

• The plans that are visible are controlled by the Security Model. Only Plan level 
security is enforced.

• Plans scheduled through the concurrent request are always launched with the 
option "Refresh Snapshot".

• Calculate Lateness Constraints can take values of YES or NO. The default value is 
NO.
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• Use fields Launch Snapshot and Use Mass updated Demand Priorities if you have 
loaded updated demand priorities. See Simulating with Updated Demand 
Priorities.

Save Options

Save options can be one of three possible values:

1. Save and Close Plan. This option ensures that the executed Rapid Planning plan, 
which was run on a defined schedule, saves and closes the plan. This guarantees 
that the updated plan is available for other downstream processes.

This is the default setting.

2. Save Plan. This option is the same as the Save and Close Plan option except it does 
not close the plan. Since the plan is not closed, it is still using a managed server.

3. Do Nothing. This option runs the Rapid Planning plan as scheduled but the plan is 
not saved and is still using a managed server.

Plan Status

Each plan has a status:

• Running Plans: Plans with a waiting sign.

• Active Plans: Plans with green tick, plans loaded in to memory.

• Inactive Plans: Plans with a red cross, they have errored out.

Load Plan
Use this action to load a plan from the database to memory.

You must load a plan before you can view, update, or simulate it.

It displays a plan status page in a pop-up window. Use this page to monitor the 
progress of each phase of the load. You can close this page and do other work and the 
load process keeps running. 

Close Plan
Use this action to close a plan that you have loaded into memory.

Save Plan
Use this action to save a plan from your workspace to the database.

It opens a save plan page in a pop-up window.

Field Plan shows the plan that you currently have selected and you can select another 
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one instead.

Select a value for field Post-Save Options > Release recommendations:

• Do not release

• Release recommendations marked for release: After the save finishes, release orders
marked for release

• Auto-release all plan recommendations: After the save finishes, release all the 
orders that the plan recommends whether or not a planner has marked them for 
release

Select a value for field Post-Save Options > Publish analytics to APCC:

• Do not Publish

• Yes, and do not archive the previous version in APCC: After the save finishes, erase
the plan analytics in Oracle Advanced Planning Command Center and send the 
analytics again

• Yes, and archive the previous version in APCC: After the save finishes, archive the 
current version the plan analytics in Oracle Advanced Planning Command Center 
and send the analytics again

After you confirm, it opens another save plan status page in a pop-up window. It 
displays the concurrent request number of the process.
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15
Plan Analysis: Output Exceptions and 

Metrics

Output Exceptions: Overview
Exception messages alert the planner to situations where the planning solver needs 
planner intervention.

These are the exception messages that the planning solver issues, see Exception 
Messages, page 15-2:

• Changes Recommended for Sales Orders

• Days of Supply Exceeds Fixed Days Supply

• Demand Quantity Not Satisfied

• Demand Satisfied Using End Item Substitution

• Forecasts Pulled-in

• Items With a Shortage

• Items Below Safety Stock

• Items with Excess Inventory

• Late Replenishment for Forecast

• Late Replenishment for a Pull-in Forecast

• Late Replenishment for a Pull-in Sales Order

• Late Replenishment for Sales Order
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• Late Supply Pegged to Forecast

• Late Supply Pegged to Sales Order

• On Time Orders

• Order Sourced from Alternate Facility

• Order Sourced from Alternate Supplier

• Order with Insufficient Lead Time

• Orders to be Cancelled

• Orders to be Rescheduled In

• Orders to be Rescheduled Out

• Past Due Orders

• Past Due Sales Orders

• Planned Order Uses Alternate BOM/Routing

• Planned Order Uses Substitute Component

• Planned Order Uses Alternate Resource

• Resource Overloaded

• Sales Order/Forecast at Risk Due to a Resource Shortage

• Sales Order/Forecast at Risk Due to Material Shortage

• Sales Orders Pulled in

• Sourcing Split Percentage Violated

• Supplier Capacity Overloaded

Exception Messages
These are explanations of the exception messages that the planning solver issues.

Changes Recommended for Sales Orders
The planning solver issues this exception message is generated each time there is a 
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change in the following:

• Material availability date

• Schedule arrival date

This is some of the information displayed for this exception:

• Sales order number with reference to line number

• Old schedule date (Suggested due date)

• New schedule date (Demand satisfied date)

Days of Supply Exceeds Fixed Days Supply
The planning solver issues this exception message when:

• You are using order modifier fixed days supply

• Days of Supply is larger than Fixed Days Supply

It usually occurs because of capacity constraints or other order modifiers that make the 
planning solver create planned orders for quantities that do not match demand for the 
FDS window.

You can access it from the Supplies view and from the Material Plan view. You can drill
from it to the Supplies, Items, BOMs, and Material Plan views.

This is some of the information displayed for this exception

• Organization

• Item

• Item Category

• From Date

• To Date 

• Days of Supply 

• Fixed Days Supply

• Excess Days of Supply: The absolute difference between Days of Supply and Fixed 
Days Supply
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Demand Quantity Not Satisfied
For any demand pegged to supplies, the supply quantities are less than the demand 
quantity. The planning solver issues this exception message for demands at all levels of 
the supply chain bill of materials.

The planning solver delays the demand until the end of the planning horizon and issues
this exception if there is no demand on the plan horizon end date.

This is some of the information displayed for this exception:

• Partial Planned Date: The date on which the order is partially planned

• Partial Planned Quantity: Quantity of the order that is planned on partial Planned 
date

• Quantity Mismatch: Quantity of the order that has not been planned; the shortage 
quantity, Demand quantity – Total pegged supply quantity

• Value of Order: Order quantity * Price

• Value of Order (Unplanned Portion): Unplanned order quantity * Price

Demand Satisfied Using End Item Substitution
The planning solver plans to satisfy an end item demand using a supply order with a 
substitute item. If it satisfies a demand with multiple planned orders, it issues an 
exception for each supply order with the substitute item. 

For example, the substitution chain is PSS7001 > PSS7002 > PSS7003 > PSS7004. The 
planning solver can satisfy demand for: 

• PSS7001 using PSS7002, PSS7003, or PSS7004

• PSS7002 using PSS7003 or PSS7004

• PSS7003 using PSS7004

The substitute quantity is from the item relationships.

A piece of the information displayed for this exception is Value of Order: Order 
quantity * Price.

Forecasts Pulled In
This message is flagged for all Forecasts that have the Revised Demand Date populated.
It indicates:

• Quantity that has been satisfied by the Revised Demand Date
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• Quantity that has been satisfied by the Demand Date

For example, there is a Forecast for Item-A, with a Firm Date (Scheduled Date) of 
January, 25th 2010 for a quantity of 100 units in Org D2. The Revised Demand Date on 
this Forecast is January, 15th 2010. The supplies pegged to this Forecast are:

• Supply1: Quantity of 50 units on January 15th, 2010 

• Supply2: Quantity of 20 units on January 12th, 2010

• Supply3: Quantity of 30 units on January 18th 2010

Quantity satisfied by Forecast's Revised Demand Date of January 15th 2010 is 70 units 
while Quantity satisfied by Forecast's Demand Date of January 25th 2010 is 100 units.

Some of this information displayed for this exception includes:

Field Explanation

Organization  

Item  

Item Category  

Demand Date Due date of the demand for the forecast (Firm 
Date)

Quantity Quantity of the line (Firm Quantity)

Revised Demand Date Pull-in due date of demand for the forecast

Customer Customer on the forecast

Customer Site Customer site

Priority Priority on the demand line

Revised Demand Priority Pull-in priority on the forecast

Demand Class Demand Class on the demand Line

Quantity Satisfied by Revised Demand Date Quantity that can be planned by the demand 
date (Scheduled Demand Date)
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Value of Delay Calculated Fact: Delayed Quantity * Price

Items With a Shortage
An item has negative projective available balance at the end of the planning bucket.

In this example, the planning solver issues these Items With A Shortage exception 
messages:

• Projected available balance -50 units

• Days 5 & 6: Projected available balance -200 units on both days

- Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7

On Hand 0 50 -50 50 0 -200 -200

New 
Supply in
bucket

100 0 200 50 100 0 200

Demand 
in bucket

50 100 100 100 300 0 0

Projected 
Available
Balance

50 -50 50 0 -200 -200 0

This is some of the information displayed for this exception:

• From Date: The start date of the first planning time bucket in which the item has a 
shortage

• To Date: The start date of the last planning time bucket in which the item has a 
shortage

• Days of Shortage: Number of workdays the item is short, based on the 
manufacturing calendar of the organization. As long the shortage quantity remains 
the same in successive planning time buckets, the planning solver issues one 
exception message and extends To Date.

• Value of Shortage: Shortage quantity * Item standard cost
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Items Below Safety Stock
Projected available balance for a planning bucket is below the specified safety stock 
level for the planning bucket.

Since Oracle Rapid Planning uses the period-of-cover safety stock basis, safety stock is 
the amount required to cover demand for the target days.

In this example, the planning solver issues these Items Below Safety Stock exception 
messages:

• Day 2: 50 [300 – 250]

• Day 3: 250 [500 – 250]

- Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7

On Hand 0 350 250 250 550 350 350

New 
Supply in
bucket

400 0 100 400 100 0 0

Demand 
in bucket

50 100 100 100 300 0 0

Safety 
Stock 
Target 
(Days)

3 3 3 3 3 3 3

Safety 
Stock 
Target 
(Quantity
)

250 300 500 400 300 0 0

Projected 
Available
Balance

350 250 550 550 350 350 350

This is some of the information displayed for this exception:

• From Date: The start date of the first planning time bucket in which the item is 
below safety stock
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• To Date: The start date of the last planning time bucket in which the item is below 
safety stock.

• Projected Available Balance : On To Date

• Quantity Below Safety Stock: Safety Stock Target (Quantity) – Projected Available 
Balance. As long the below safety stock quantity remains the same in successive 
planning time buckets, the planning solver issues one exception message and 
extends To Date

• Days of Shortage: Number of workdays the item is below safety stock, based on the 
organization manufacturing calendar

• Value of Shortage: Quantity below safety stock * Item standard cost

Items With Excess Inventory
The projected available balance on a particular day exceeds Safety Stock Target 
(Quantity) for that day

If you want to see only the exceptions above a certain threshold, specify the threshold in
the search area on the Exceptions tab.

In this example, the planning solver issues these Items With Excess Inventory exception 
messages:

• Day 1: 100 [350 – 250]

• Day 4: 150 [550 – 400]

• Day 5: 50 [350 – 300]

• Day 6: 350 [350 – 0]

• Day 7: 350 [350 – 0]

- Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7

On Hand 0 350 250 250 550 350 350

New 
Supply in
bucket

400 0 100 400 100 0 0

Demand 
in bucket

50 100 100 100 300 0 0
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- Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7

Safety 
Stock 
Target 
(Days)

3 3 3 3 3 3 3

Safety 
Stock 
Target 
(Quantity
)

250 300 500 400 300 0 0

Projected 
Available
Balance

350 250 550 550 350 350 350

This is some of the information displayed for this exception:

• From Date: The start date of the first planning time bucket in which the item has 
excess inventory

• To Date: The start date of the last planning time bucket in which the item has excess
inventory.

• Projected Available Balance: On To Date

• Quantity of Excess: Projected Available Balance - Safety Stock Target (Quantity). As 
long the excess inventory quantity remains the same in successive planning time 
buckets, the planning solver issues one exception message and extends To Date

• Days of Excess: Number of workdays the item has excess inventory, based on the 
organization manufacturing calendar

• Value of Excess: Quantity of excess * Item standard cost

Late Replenishment for Forecast
The supplies for a forecast are due later than the forecast's due date. For example, there 
is a forecast for item A due 25 January for quantity 100 in organization D2. The supplies
pegged to this sales order line are:

• Supply 1: Quantity 50 and due date 23 January

• Supply 2: Quantity 20 and due date 25 January
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• Supply 3: Quantity 30 and due date 27 January

Demand satisfied date is 27 January (from Supply 3). Days late are 2. Quantity satisfied 
by forecast date is 70 (from Supply 1 and Supply 2).

This is some of the information displayed for this exception:

• Demand Date: The Requested Date of the forecast.

• Days Late: Difference between the Planned Date and the Demand Date, based on 
the manufacturing calendar of the organization 

• Value of Forecast: Forecast Quantity * Price

• Value of Delay: Delayed quantity * Price

Late Replenishment for a Pull-in Sales Order
This exception message is flagged when the planning logic detects that supplies for a 
sales order line are due later than the sales order line's Revised Demand Date. For 
example, there is a sales order line for Item-A, with a Firm Date (Scheduled Date) of 
January, 25th 2010 for a quantity of 100 units in Org D2. The Revised Demand Date on 
this Sales Order is January, 15th 2010. The supplies pegged to this Sales Order are:

• Supply1: Quantity of 50 units on January 15th, 2010

• Supply2: Quantity of 20 units on January 12th, 2010

• Supply3: Quantity of 30 units on January 18th 2010

Demand satisfied date on this order line is January, 18th 2010. 

Days late are 3. 

Quantity not satisfied by sales order line Revised Demand Date of January 15th 2010 is 
30 units.

Some of the information shown for this exception includes:

Field Explanation

Organization  

Item  

Item Category  



Plan Analysis: Output Exceptions and Metrics    15-11

Order, Line Number  

Demand Date Due date of demand for the sales order (Firm 
Date)

Demand Satisfied Date Date when the order is currently satisfied

Order Line Quantity Quantity of the Line (Firm Quantity)

Revised Demand Date Pull-in due date of demand for the sales order

Customer Customer on the order

Customer Site Customer site

Priority Priority on the Order Line

Revised Demand Priority Pull-in priority on the Order Line

Demand Class Demand Class on the Order Line

Quantity not Satisfied by Revised Demand 
Date

Quantity that is not planned by the due date

Days Late (calculated) Calculated fact: Number of days the order is 
planned late

Value of Order Calculated fact: Quantity * Price

Value of Delay Calculated Fact: Delayed Quantity * Price

Late Replenishment for a Pull-in Forecast
This exception message is flagged when the planning logic detects that supplies for a 
forecast are due later than the forecast's Revised Demand Date. For example, there is a 
forecast for Item-A, with a Firm Date (Scheduled Date) of January, 25th 2010 for a 
quantity of 100 units in Org D2. The Revised Demand Date on this forecast is January, 
15th 2010. The supplies pegged to this forecast are:

• Supply1: Quantity of 50 units on January 15th, 2010

• Supply2: Quantity of 20 units on January 12th, 2010 
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• Supply3: Quantity of 18 units on January 17th, 2010 

• Supply 4: Quantity of 12 units on January 18th, 2010

Demand satisfied date on this forecast is January, 18th 2010.

Days late are 3. 

Quantity not satisfied by forecast's Revised Demand Date of January 15th 2010 is 30 
units.

Some of the information shown for this exception includes:

Field Explanation

Organization  

Item  

Item Category  

Demand Date Due date of the forecast (Firm Date)

Demand Satisfied Date Date when the forecast is planned

Quantity Forecast quantity (Firm Quantity)

Revised Demand Date Pull-in due date of demand for the forecast

Customer Customer on the forecast

Customer Site Customer site

Priority Priority on the Order Line

Revised Demand Priority Pull-in priority on the forecast

Demand Class Demand Class on the demand Line

Quantity not Satisfied by Revised Demand 
Date

Quantity that is not planned by the due date

Value of Forecast Calculated fact: Forecast Quantity * Price

Value of Delay Calculated Fact: Delayed Quantity * Price
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Late Replenishment for Sales Order
The supplies for a sales order line are due later than the sales order line's schedule date. 
For example, there is a sales order line on item A, with a scheduled date of 25 January 
for quantity 100 in organization D2. The supplies pegged to this sales order line are: 

• Supply 1: Quantity 50 and due date 23 January

• Supply 2: Quantity 20 and due date 25 January

• Supply 3: Quantity 30 and due date 27 January

Demand satisfied date is 27 January (from Supply 3). Days late are 2. Quantity satisfied 
by sales order line schedule date is 70 (from Supply 1 and Supply 2).

This is some of the information displayed for this exception:

• Demand Date: The Requested Date of the sales order.

• Days Late: Difference between the Planned Date and the Demand Date, based on 
the manufacturing calendar of the organization

• Value of Forecast: Sales Order Quantity * Price

• Value of Delay: Delayed quantity * Price

Late Supply Pegged to Forecast
A forecast demand will be satisfied late because supplies that peg to it are late.

This is some of the information displayed for this exception:

• Supply Order Demand Date: The date when the supply order should have been 
created to meet the forecast on time

• Supply Order Due Date: Actual supply date of the supply order

• Supply Days Late: Supply order demand date – Supply order due date, based on 
the organization manufacturing calendar of the demand

Late Supply Pegged to Sales Order
A sales order demand will be satisfied late because supplies that peg to it are late that is 
satisfied late.

This is some of the information displayed for this exception:

• Supply Order Demand Date: The date when the supply order should have been 
created to meet the forecast on time
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• Supply Order Due Date: Actual supply date of the supply order

• Supply Days Late: Supply order demand date – Supply order due date, based on 
the organization manufacturing calendar of the demand

Order Sourced from Alternate Facility
The planning solver sources a planned order from an alternate facility

This is some of the information displayed for this exception:

• Source Org: The alternate facility

• Value of Order: Order quantity * Cost

Order Sourced from Alternate Supplier
The planning solver sources a planned order from an alternate supplier

This is some of the information displayed for this exception:

• Supplier: The alternate supplier

• Supplier site: The alternate supplier site

• Value of Order: Order quantity * Cost

Order With Insufficient Lead Time
The planning solver detects that a supply order needs to be completed in less time than 
the minimum processing time required to meet the demand. If the planning solver 
plans the order according to its lead-time, it would start in the past (before the planning
horizon start date).

The planning solver issues this exception message only when an order start date is 
scheduled to be before the horizon start date. It never generates it when the plan start 
date is later than the horizon start date. 

To calculate order start date, the planning solver uses the item lead time offset (for 
unconstrained plan) or routing level processing times (for constrained plans) and then 
backward schedules from its due date. It considers all the relevant calendars associated 
with each part of the supply chain model. 

This is some of the information displayed for this exception:

• Compression Days: Number of days the order is compressed, based on the 
organization manufacturing calendar; Horizon Start – Order Start

• Value of Order: Order quantity * Item standard cost
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Orders to be Cancelled
This exception message appears when the planning solver suggests that you cancel a 
supply order. It occurs when the planning solver detects a non-firm supply order that 
you do not need to satisfy demand or safety stock requirements.

A piece of the information displayed for this exception is Value of Order: Order 
quantity * Cost

Orders to be Rescheduled In
The planning solver suggests that you reschedule an existing supply order to an earlier 
date. It occurs when the planning solver detects a non-firm existing supply order with a
due date that is later than it suggests (suggested order date). The planning solver 
continues to plan lower bill of material levels as if you accept the suggestion.

This is some of the information displayed for this exception:

• Order Number: The start date of the planning time bucket in which the supplier 
capacity is overloaded

• Original Due Date (From Date): The current due date

• Suggested Due Date: New due date that the planning solver recommends; no 
earlier than the plan horizon start date.

• Reschedule Days: Number of workdays between the original and suggested due 
dates, based on the organization manufacturing calendar.

• Value of Order: Quantity * Item standard cost

Orders to be Rescheduled Out
The planning solver suggests that you reschedule an existing supply order to a later 
date. It occurs when the planning solver detects a non-firm existing supply order with a
due date that is earlier than it suggests (suggested order date). The planning solver 
continues to plan lower bill of material levels as if you accept the suggestion.

This is some of the information displayed for this exception:

• Order Number: The start date of the planning time bucket in which the supplier 
capacity is overloaded

• Original Due Date (From Date): The current due date

• Suggested Due Date: New due date that the planning solver recommends; no 
earlier than the plan horizon start date.
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• Reschedule Days: Number of workdays between the original and suggested due 
dates, based on the organization manufacturing calendar.

• Value of Order: Quantity * Item standard cost

Past Due Orders
Supply orders and planned orders have order (start) dates or due dates in the past 
(before the planning horizon start date). 

For non-firmed supply orders, the planning solver also issues exception message 
Orders to be rescheduled out.

This is some of the information displayed for this exception:

• Order Number: The start date of the planning time bucket in which the supplier 
capacity is overloaded

• Suggested Due Date: No earlier than the plan horizon start date

• Days Past Due: Number of workdays past due, based on the organization 
manufacturing calendar; Due date – Horizon start date

• Value of Order: Quantity * Item standard cost

Past Due Sales Orders
The schedule date of the sales order line is earlier than the plan horizon start date.

This is some of the information displayed for this exception:

• Days Past Due: Number of workdays past due, based on the manufacturing 
calendar of the organization 

• Value of Order: (Quantity on Sales Order * Price) 

Planned Order Uses Alternate BOM/Routing
The planning engine uses an alternate bill of material or routing in a planned order or 
detects a firm planned order with an alternate bill of material or routing.

A piece of the information displayed for this exception is Order Value: Order quantity * 
Item standard cost

Planned Order Uses Alternate Resource
The planning engine uses an alternate resource in a planned order or detects a firm 
planned order with an alternate resource.
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This is some of the information displayed for this exception:

• Quantity: Units of the primary and alternate resources used

• Value of Order: Order quantity * Item standard cost

• Resource units from alternate: Units of the alternate resource used

Planned Order Uses Substitute Component
The planning engine uses a substitute component in a planned order or detects a firm 
planned order with a substitute component.

A piece of the information displayed for this exception is Value of Order: Order 
quantity * Cost

Resource Overloaded
In a planning time bucket, the resource required capacity is more than the resource 
available capacity. Resources could be overloaded in constrained plans because of firm 
supplies that have associated resource consumption. In unconstrained plans, resources 
could be overloaded to meet demand requirements on time.

This is some of the information displayed for this exception:

• Start Constraint Date: Date that the overload starts

• End Constraint Date: Date that the overload ends

• Resource Load Ratio (%): (Resource requirement / Resource availability) * 100

Sales Order/Forecast at Risk Due to a Resource Shortage
Typically issued in an unconstrained plan when the sales order or forecast is still 
planned on time even in the absence of resource availability. This exception message 
details the end demands that are at risk because of being pegged to supply orders with 
resources with insufficient capacity.

Sales Order/Forecast at Risk Due to Material Shortage
Typically generated in an unconstrained plan when the sales order or forecast is still 
planned on time even in the absence of material availability (because of the plan being 
unconstrained). This exception details the end demands that are at risk because of being
pegged to supply orders with material shortages

Sales Orders Pulled-in
This message is flagged for all Sales Orders that have the Revised Demand Date 
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populated. It indicates:

• Quantity that has been satisfied by the Revised Demand Date

• Quantity that has been satisfied by the Demand Date

For example, there is a Sales Order for Item-A, with a Firm Date (Scheduled Date) of 
January, 25th 2010 for a quantity of 100 units in Org D2. The Revised Demand Date on 
this Sales Order line is January, 15th 2010. The supplies pegged to this Sales Order are:

• Supply1: Quantity of 50 units on January 15th, 2010

• Supply2: Quantity of 20 units on January 12th, 2010

• Supply3: Quantity of 30 units on January 18th 2010

Quantity satisfied by Sales Order Line Revised Demand Date of January 15th 2010 is 70 
units while Quantity satisfied by Sales Order Line Demand Date of January 25th 2010 is 
100 units.

Some of the information shown for this exception includes:

Field Explanation

Organization  

Item  

Item Category  

Demand Date Due date of demand for the sales order (Firm 
Date)

Quantity Quantity of the line (Firm Date)

Revised Demand Date Pull-in due date of demand for the sales order 
line

Customer Customer on the order

Customer Site Customer site

Priority Priority on the demand line

Revised Demand Priority Pull-in priority on the Order Line
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Demand Class Demand Class on the Sales Order Line

Quantity Satisfied by Revised Demand Date Quantity that can be planned by the revised 
demand date

Value of Order Calculated fact: Quantity * Price

Sourcing Split Percentage Violated
Use this profile option to specify the tolerance that you allow between sourcing 
percentages and the actual percentages in a split sourcing window. If the difference is 
outside the tolerance, the planning solver issues the exception message.

If the last window of the planning horizon is shorter than all of the other windows, the 
planning solver does not issue the exception message. 

This is some of the information displayed for this exception:

• Item

• Supplier

• Supplier Site

• Source Organization (if the source is an organization and not a supplier)

• From Date: The start date of the first split sourcing window in violation

• To Date: The end date of the last split sourcing window in violation. When the 
percentage of variation remains the same in successive windows, the planning 
solver uses the exception message from the previous window and extends the end 
date.

• Allocated Percentage: The sourcing rule split percentage

• Planned Percentage: The actual cumulative split percentage

• Percent Variation: Planned Percentage - Allocated Percentage

Supplier Capacity Overloaded
In a planning time bucket, the supplier required capacity is more than the supplier 
available capacity.

The amount of overload is Required capacity of the bucket - Cumulative available 
capacity of the bucket. Load ratio is a percent and its calculation is (Required quantity / 
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Cumulative available quantity) * 100.

The planning solver consumes supplier capacity is through backward then forward 
netting of capacity from the demand date. The calculation of supplier capacity 
utilization is Capacity consumed / Supplier capacity per day. The planning solver issues
this exception message only on the days that have utilization over 100%.

In this example:

• Row Order Qty shows orders that use up the supplier capacity.

• Since supplier capacity is cumulative, the planning solver can consume more than 
the capacity on a specific day. For example, on day D3, the planning solver can 
backward consume up to quantity 40

- Day 0 Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7

Supplier
Capacit
y

10 10 10 10 10 10 10 10

Order 
Quantit
y

- - - 40 - - - 30

Capacit
y 
Consum
ed

0 10 10 20 10 10 10 0

Utilizati
on 
Percenta
ge

0 100 100 200 100 100 100 0

Some of the information displayed for this exception is From Date: The start date of the 
first planning time bucket in which the supplier capacity is overloaded

Output Metrics: Overview
Metrics are indicators of plan quality.

You see them in the Analytics view.

Base Metrics
The planning solver calculates these metrics based on data from the plan.
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Exception-Based Metrics
The planning solver derives these metrics from exception messages, most often by 
aggregating facts associated with the related exceptions. These metrics include:

• The count: Number of the exceptions; for example, the number of exception 
message Past Due Orders that the planning solver issues in the plan run

• Quantity: Number of pieces involved in the exception; for example, shortage 
quantity 

• Value: In functional currency of the exception; for example, the Quantity * Cost of 
exception messages Orders to be Rescheduled In

• Days: Duration of the exception; for example, days below safety stock represented 
by the exception messages Items Below Safety Stock

• Ratio: Ratio of exception occurrences to a baseline; for example; the supplier load 
ratio resulting from the exception messages Supplier Capacity Overloaded 

Base Metrics 
These are explanations of the base metrics that the planning solver calculates.

Buy Planned Order Quantity
The dimensional combination is Item-Organization-Week.

Clear to Build Component Availability %
This metric is relevant for Oracle Advanced Planning Command Center

The dimensional combinations are:

• All

• Item Category

• Organization

• Item Category-Organization

• Item-Organization

• Item Category-Organization-Week

• Item-Organization-Week
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The percentage of component requirements that are fully available on-hand:

• Aggregated to the dimensions that you specify 

• Over the clear to build horizon

The calculation is total component requirements vs component requirements in on 
hand.

Clear to Build Orders (%)
This metric is relevant for Oracle Advanced Planning Command Center

The dimensional combinations are:

• All

• Item Category

• Organization

• Item Category-Organization

• Item-Organization

• Item Category-Organization-Week

• Item-Organization-Week

The percentage of orders that are clear to build (have all their components completely 
pegged to on hand):

• Aggregated to the dimensions that you specify 

• Over the clear to build horizon 

The calculation is total make orders vs. make orders that are clear to build.

Derived Safety Stock
Derived Safety Stock is a quantity that can be viewed only in pre-seeded combinations 
All, Org, and Item-Org. Item-Org is a dimension for which Rapid Planning must pre-
compute the metrics.

Value of Derived Safety Stock is quantity multiplied by price.

Fill Rate (percentage)
Fill rate of the end demands based on quantity satisfied on time. The planning solver 
calculates it at level Item-Organization-Customer-Site. 
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Total quantity satisfied on time / Total quantity of the demand 

Forecast Quantity
The dimensional combination is Item-Organization-Week.

Forecasts Pulled In
This metric pertains to the pull-in feature. It can be viewed only in pre-seeded 
combinations.

Exception fact: Count of Exceptions

Exception fact value (functional currency): Value of order (quantity * price)

Exception fact, Quantity Satisfied by Revised Date: Quantity satisfied by revised 
demand date

Exception fact, Quantity Satisfied by Demand Date: Quantity satisfied by revised 
demand date

Pre-seeded dimensional combinations for display: All, Org, Item-Org. Oracle Rapid 
Planning must pre-compute metrics for Item-Org

Gross Margin % (percentage)
Gross Margin % (percentage)

where

Total Cost = Manufacturing cost + Purchasing cost

The planning solver calculates this at level Item-Organization-Customer-Day. Day is the
order Scheduled Ship Date.

Internal Purchase Orders / Requisitions Quantity
The dimensional combination is Item-Organization-Week.

Inventory Turns (ratio)
Annualized cost of goods sold in standard cost / Average projected available balance

where

Annualized cost of goods sold = (Item standard cost * Sum of [Independent demand 
quantity in plan * 365]) / Number of days in plan 

Average projected available balance = Average of beginning value and ending value of 
each bucket
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Late Orders Ratio (count)
Demand lateness measured as the percentage of the number of end demand lines 
unsatisfied on their due date.

Late Replenishment for a Pull-in Forecast
This metric pertains to the pull-in feature. It can be viewed only in pre-seeded 
combinations.

Exception fact: Count of Exceptions

Exception fact value (functional currency): Value of order (quantity * price)

Exception fact, Days: Days late

Exception fact, Quantity: Late Quantity: 

Pre-seeded dimensional combinations for display: All, Org, Item-Org. Oracle Rapid 
Planning must pre-compute metrics for Item-Org

Late Replenishment for a Pull-in Sales Order
This metric pertains to the pull-in feature. It can be viewed only in pre-seeded 
combinations.

Exception fact: Count of Exceptions

Exception fact value (functional currency): Value of order (quantity * price)

Exception fact, Days: Days late

Exception fact, Quantity: Late Quantity: 

Pre-seeded dimensional combinations for display: All, Org, Item-Org. Oracle Rapid 
Planning must pre-compute metrics for Item-Org

Make Planned Order Quantity
The dimensional combination is Item-Organization-Week.

Manufacturing Cost (functional currency)
Manufacturing cost value in functional currency

The standard costs collected into Rapid Planning are not rolled-up.

The planning solver calculates this at level Item-Organization-Day.

On Time Orders (percentage)
Percentage of on time demands, measured as the percentage of number of end demand 
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lines unmet on due date 

The planning solver calculates this at level Item-Organization-Customer-Day.

Planned Order Quantity
The dimensional combination is Item-Organization-Week.

Purchase Orders / Requisition Quantity
The dimensional combination is Item-Organization-Week.

Purchasing Cost (functional currency)
Purchasing cost value in functional currency.

The planning solver calculates this at level Item-Organization-Supplier-Day.

Ready to Build %
This metric is relevant for Oracle Advanced Planning Command Center

The dimensional combinations are:

• All

• Item Category

• Organization

• Item Category-Organization

• Item-Organization

• Item Category-Organization-Week

• Item-Organization-Week

The percentage of orders that are ready to build (have all their components pegged to 
on hand, but not all their total quantities pegged):

• Aggregated to the dimensions that you specify 

• Over the clear to build horizon 

The calculation is total make orders vs make orders that are ready to build.

Resource Utilization % (percentage)
Resource utilization as a ratio of resource requirements to resource availability within 
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the planning bucket

The planning solver calculates this at level Resource-Organization-Day.

Revenues (functional currency)
Sum of [(Independent demand quantity * (List price - Discount)]

The planning solver calculates it at level Item Category-Organization-Customer-Day. 
Day is the order Scheduled Ship Date.

Safety Stock Violation Days (days)
The number of days when the inventory at the end of a planning bucket is below 
minimum safety stock targets.

The planning solver calculates it at level Item-Organization-Day.

Sales Order Pulled In
This metric pertains to the pull-in feature. It can be viewed only in pre-seeded 
combinations.

Exception fact: Count of Exceptions

Exception fact value (functional currency): Value of order (quantity * price)

Exception fact, Quantity Satisfied by Revised Date: Quantity satisfied by revised 
demand date

Exception fact, Quantity Satisfied by Demand Date: Quantity satisfied by revised 
demand date

Pre-seeded dimensional combinations for display: All, Org, Item-Org. Oracle Rapid 
Planning must pre-compute metrics for Item-Org

Sales Order Quantity
The dimensional combination is Item-Organization-Week.

Stock Out Days (days)
Total number of days stocked out

Supplier Capacity Utilization % (percentage)
Ratio of supplier capacity required to supplier available capacity

The planning solver calculates this at level Item-Organization-Supplier-Day.
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Target Safety Stock
Target Safety Stock is a quantity that can be viewed only in pre-seeded combinations 
All, Org, and Item-Org. Item-Org is a dimension for which Rapid Planning must pre-
compute the metrics.

Value of Target Safety Stock is quantity multiplied by price.

Top Shortage Components
The dimensional combination is Item-Organization

The percentage of orders that are ready to build (have all their components pegged to 
on hand, but not all their total quantities pegged):

The filter criteria for this metric must have filters for specifying the end item category, 
date range, items, and organizations. 

The calculation is total pegged requirements for the component across all orders vs 
pegged requirements for the component across against non-on hand supply.

Top Shortage Suppliers
The dimensional combination is Item-Organization

The percentage of orders that are ready to build (have all their components pegged to 
on hand, but not all their total quantities pegged):

The filter criteria for this metric must have filters for specifying the end item category, 
date range, items, and organizations.

The calculation is total buy requirements against the supplier across all orders vs buy 
requirements against the supplier pegged against non-on hand supply. 

Total Demand Quantity
The dimensional combination is Item-Organization-Week.

Total Supply Quantity
The dimensional combination is Item-Organization-Week.

Transfer Planned Order Quantity
The dimensional combination is Item-Organization-Week.

Work Order Quantity
The dimensional combination is Item-Organization-Week.
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Pull-in Metrics
The table below summarizes the list of metrics that have been introduced for the pull-in 
feature, which are based on exceptions defined above. This table contains the metric 
name and type.

SN Name of Metric Metric Type

1 Late Replenishment for a 
Pull-in Sales Order (Count)

Number

2 Late Replenishment for a 
Pull-in Sales Order (Value)

Number

3 Late Replenishment for a 
Pull-in Sales Order (Days)

Number

4 Late Replenishment for a 
Pull-in Sales Order (Quantity)

Number

5 Late Replenishment for a 
Pull-in Forecast (Count)

Number

6 Late Replenishment for a 
Pull-in Forecast (Value)

Number

7 Late Replenishment for a 
Pull-in Forecast (Days)

Number

8 Late Replenishment for a 
Pull-in Forecast (Quantity)

Number

9 Sales Orders Pulled-in 
(Count)

Number

10 Sales Orders Pulled-in (Value) Number

11 Sales Orders Pulled-in 
(Quantity by Revised Date)

Number

12 Sales Orders Pulled-in 
(Quantity by Demand Date)

Number

13 Forecasts Pulled-in (Count) Number
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14 Forecasts Pulled-in (Value) Number

15 Forecasts Pulled-in (Quantity 
by Revised Date)

Number

16 Forecasts Pulled-in (Quantity 
by Demand Date)

Number
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16
Plan Analysis: Outputs

Output Views
Use the views to view, analyze, and update the plan information

Access them from the Plan links section in the Plan tab and the Plan input links in the 
Plan inputs tab.

For each view, this tells you:

• The view name

• The regions that it commonly appears in

• What it is for and how to use it 

Use the actions to act against plans. You find links to the actions in the Plan Actions 
section of the navigator in the Plan inputs tab.

For each action, this tells you:

• The link name

• The regions that it commonly appears in

• What it is for and how to use it

You cannot perform all actions on all plans. For example:

• You cannot load, save, or close a plan that you have created but never launched.

• You cannot perform any action against a plan that is being saved or being re-
planned (launched).

• You cannot load, save, or copy a plan that has failed its re-plan.
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Analytics
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view base metrics. See Rapid Planning Metrics Overview, page 15-20.

You cannot edit data in this view.

To view exception messages for a plan, load it.

Metrics Tab

You can create metrics from the list of available metrics. Specify the

• Dimensions, for example, item-organization

• Aggregation levels, for example, day or week

• Entities, for example, items and item categories

You can:

• View the results in graphs, for example, bar and line, and tables

• Specify the location of the metric on the metrics page, for example, left upper or 
right bottom

• See multiple metrics simultaneously

• Compare metrics across multiple plans or multiple runs of the same plan, for 
example, previous run and current run

Order Comparison Tab – Sales Order Comparison 

You can compare across sales order demands between two plans. You cannot compare 
forecast demands.

The comparison type describes the satisfaction status of the demand in the base plan 
(Was…) and the compared plan (…, now…) For example, Was late, now on time.

Order Comparison Tab – Supply Order Comparison 

You can compare across supply orders between two plans. You typically use this while 
solving issues that arise between Advanced Supply Chain Planning plan runs. You 
compare a baseline Rapid Planning plan (that you copy from Advanced Supply Chain 
Planning) with a Rapid Planning plan that shows a proposed solution.

See Simulating Plans from Oracle Advanced Supply Chain Planning, Comparing Plans.

Bills of Materials
You can:
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• Add a bill of material or some of its components or substitutes to a simulation set.

• Duplicate a bill of material, a component, or a substitute and make edits for 
simulation purposes

See Input Views, Bills of Materials

Clear to Build Workbench 
Use the Clear to Build Workbench to influence the allocation of clear to build on hand 
inventory. Prioritize and deprioritize make orders and sales orders.

The Clear to Build Workbench has these regions:

• A region to search and view make orders

• A region to prioritize make orders for clear to build, view contentions (make orders 
that share common components with other make orders), and deprioritize make 
orders for clear to build

The search area has these searchable attributes:

• Item

• Organization

• Component Item

• Order Type

• Due Date

• End pegged Demand Customer

• End Pegged Demand Due Date

• Resource Used 

• Clear to Build Status

• Clear to Build Date

• Clear to Build Component Available %

• Ready to Build %

 The Make Orders table has all the searchable fields and also:

• Order Number
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• Maximum Potential Ready to Build %

• Clear to Build Priority 

• Deprioritized from Clear to Build 

Phantom Items

When you evaluate the Clear to Build status of a work order, look through any 
components of the work order that are phantoms and evaluate the non-phantom sub-
components.

Viewing a Single Level Phantom

When evaluating the Clear to Build status of a work order, Oracle Rapid Planning looks
through the various phantom levels and displays only the real components. This 
provides you with clear visibility into the real component availability and requirements 
during a Clear to Build analysis. For example, in the diagram below, you see the 
components within the phantom, RealComp1 and RealComp2. You do not see any row 
for the parent phantom item IN-AA-COMP1.

Viewing Multi-Level Phantoms

The display of multi-level phantoms is identical to that of single phantoms. The 
phantoms are flattened so that only real components are displayed on the component 
allocation workbench.

For example, if there is a two-level phantom structure as shown below:

The component allocation displays only the real components. Your screen displays the 
following:
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Integration of the Component Allocation View into the Main Clear to Build 
Workbench Display

There is a new button on the Clear to Build workbench, View Contentious Orders for 
Components. The "View Contentious Orders for Components" action is enabled only 
when a component pegging row against a make order is selected.

All columns associated with the component allocation view, such as Quantity Required,
Quantity Pegged to On-Hand, and so on, are available as additional columns when you 
scroll to the right of the table.

Since the main make order table is now in a tree format, the icons used for enabling 
Query by Example are changed slightly. The icons are similar to those in 
Supply/Demand.

 All columns associated with the component allocation view (Quantity Required, 
Quantity Pegged to On-Hand, Total Components On-Hand, etc) are available as 
additional columns when scroll to the right of the table. Functionally, all the data in this 
view is identical to the erstwhile separate component allocation view.

 Since the main make order table now changes from a normal table to a "Tree" table, 
there are slight changes to the icons used for enabling Query by Example. The icons 
used will be similar to the ones in Supply/Demand (which is also a tree table).

Note: The Query by Example Mode button will be replaced by an icon 
of binoculars.

Constraint Details
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to see constraints for late and unmet demands. See also Planner Analysis: 
Late Demand Diagnosis.

You can access it for single and multiple demands and from:

• Supply & Demand View: From Late or Unmet End Demands
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• Exceptions View: From exception messages Late Replenishment for Forecast, Late 
Replenishment for Sales Order, and Demand Quantity not Satisfied

It is in the Plan Links menu as well.

Here are some specific field definitions:

• BOM Level: Bill of material level from the finished good; the finished good level is 
level 1.

• Constraint Type: Material, Resource or Supplier 

• Material Constraint Type: Lead Time, Time Fence, Date Effectivity, WIP Window

• Search Path: For the primary path, it reports exhaustive constraints.

• Requested Date: Date of the constraint

• Requested Qty: Quantity required to meet the demand on time; units for material or
supplier constraints, hours for resource constraints.

• Available Qty: Quantity available at the moment that the planning solver is 
planning this demand 

• Shortage Qty: Requested Qty – Available Qty

• Shortage %: Shortage Qty / Requested Qty

• Earliest Available Date: When the material or capacity is first available

• Constraint Duration: Earliest Available Date – Requested Date

Exceptions
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view exception messages.

You cannot edit data in this view.



Plan Analysis: Outputs    16-7

You can set up the exceptions that you want to see:

• Click on Exceptions > Set Up

• Select the exceptions that you want to see by moving them between the lists using 
the > , >> and < ,<< icons in the set up wizard

• Once you move an exception is moved from one list to another, it is removed from 
the original list.

• Use the up and down icons to specify the order of the exceptions display

To see exception messages, you must load the plan to your workspace.

Each exception message appears in a separate sub-tab. Each sub-tab has its own search 
area and search results area.

The exception message sub-tabs appear in the order that you set up. Several sub-tabs 
appear when you first see this tab.

To see another exception message sub-tab, click on the sub-tab related to the exception. 
If the exception you want is not visible, click icon double-greater than and select the 
exception from the drop down list.

To move around to other exception messages, click icons double-greater than and 
double-less than and select them.

You can:

• Save the search criteria for each exception

• Export exceptions to Microsoft Excel
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• Specify search conditions to limit the display of each exception and save it. After 
you specify the search criteria, you can drill down to other views

The meaning of each exception message is in Exceptions > Rapid Planning Exceptions 
Overview.

Items
You can:

• Make changes to items and add them to a simulation set

• Mass edit a set of rows, for example, all items of a particular category, or do a 
single-row edit to update any of these attributes

See Input Views.

Material Plan
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view a horizontal picture of the supply and demand. It is a horizontal 
plan.

You can edit data in this view.

Plan Tab

To drill down to supply and demand detail, highlight cells, then click button Supplies &
Demands
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The time bucket dates appear as the first three rows of the display. To:

• Expand a time bucket into lower level buckets, click icon Drill Expand near the date
of the higher-level bucket

• Summarize lower level bucket detail into the higher level bucket, click icon Drill 
Collapse near the date of the higher-level bucket 

Click button Setup to see the Search and Layout window where you can:

• Specify filter criteria (tab Filters)

• Specify the layout of the data columns (tab Layout)

• Specify titles for the data columns (tab Labels)

• Save the search, layout, and titles and make it your default (tab General)

You can filter on: 

• Category

• Item

• Projected available balance

• Organization

• Product family

• Model

• Global forecast: In the Filter tab, select Show Global Forecast Measures.

You can directly make edits to the following row types:

• Forecasts

• Planned orders

• Manual demands

You can create:

• Planned orders

• Manual demands

After you save a changed cell, the tab:

• Finds the increased or decreased percentage change between what was there and 
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what you changed it to

• Applies that to all supply or demand details that make up the number in that cell

• Sets the new quantity and date values as firm

For example, you have a material plan row

Organization Category Measure 16 February 23 February 2 March

TST_M1 Hard Drives Forecast 2000 2400 3000

The bucket 23 February quantity 2400 is the sum of these detail forecasts.

Organizati
on

Item Order 
Type

Date Quantity Firm Date Firm 
Quantity

TST:M1 320 GB 
External 
Hard drive

Forecast 26 
February

300 -- --

TST:M1 1 TB Hard 
drive

Forecast 25 
February

1500 -- --

TST:M1 3 TB Hard 
drive

Forecast 27 
February

600 -- --

You update bucket 23 February to quantity 3000.

Organization Category Measure 16 February 23 February 2 March

TST_M1 Hard Drives Forecast 2000 3000 3000

The tab calculates a 25% quantity increase, passes that increase to all of the detail 
forecast firm quantities, and sets their firm dates.
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Organizati
on

Item Order 
Type

Date Quantity Firm Date Firm 
Quantity

TST:M1 320 GB 
External 
Hard drive

Forecast 26 
February

300 26 
February

375

TST:M1 1 TB Hard 
drive

Forecast 25 
February

1500 25 
February

1875

TST:M1 3 TB Hard 
drive

Forecast 27 
February

600 27 
February

750-

If you are creating a supply or demand in a week or period bucket, the new supply or 
demand's firm date is the last workday of the week or period.

Measures

You can view most of these measures as low as the item, organization, and day levels. 
You can roll up to higher:

• Item levels: Category, product family, and model

• Time levels: Week, period

If you select global forecast measures, global demand schedules display in a Global 
Organization section.

These are the demand measures available in the material plan:

• Dependent Demand: Sum of order types – (Planned order demand + Discrete job 
demand)

• Expected Scrap: Sum of Expected scrap; demand resulting from applying item 
attribute 

• Shrinkage Rate to supplies

• Forecast: Forecast quantity after consumption

• Gross Requirements: Sum of all demands

• Manual Demand: Sum of manually created demand rows

• Other Independent Demand: Sum of (Hard reservation, Copied schedule demand, 
Non-standard demand, Demand class consumption)

• Production Forecast: Sum Production forecasts; can be based on exploded forecasts 
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of product families and models

• Sales Orders: Sum of Sales order quantities

• Original (Global Organization section only): The original global forecast quantity. If 
you spread the forecast to daily buckets, the spread forecast displays in place of 
Original. 

• Consumed (Global Organization section only): The global forecast quantity that 
sales orders have consumed

• Current (Global Organization section only): The global forecast quantity that 
remains after consumption

• Cumulative Current (Global Organization section only): The sum of Current for this
bucket and Current for all previous buckets

These are the supply measures available in the material plan:

• Current Scheduled Receipts: Sum of (Discrete jobs, Purchase orders, Requisitions, 
In transit, In receiving)

• Flow Schedules: Sum of Flow schedules

• In Receiving: Sum of In-receiving

• In Transit: Sum of In-transit

• Onhand: On-hand balance

• Planned Orders: Sum of Planned orders

• Purchase Orders: Sum of Purchase Orders

• Requisitions: Sum of Requisitions

• Total Supply: Sum of all supplies

• Work Orders: Sum of Discrete jobs

These are the other metrics available in the material plan:

• Projected Available Balance: Onhand + Total Supply – Gross Requirements

• Projected Onhand: Onhand + (Total Supply – Planned Orders) – Gross 
Requirements

For global forecasts, this is how the material plan rolls up:
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• Model: It uses the model defined in the organization that you specified in profile 
option MSC: Organization containing generic BOM for forecast explosion.

• Categories and product families: If you select an organization view by, it uses that. 
Otherwise, it uses the definition in the plan owning organization.

Grand Totals

You can see grand totals for Material Plan entities and drill down to their corresponding
Supplies and Demands, Items, Supply Chain Bill, and Exceptions windows.

In the Material Plan Setup page, General tab, select Grand Total.

All measures displayed at the Item level or Category level are displayed at the Grand 
Total level, except Global Forecast.

You can update values for:

• Planned Order (zero and non-zero values)

• Forecast (only non-zero values)

• Manual Demand: (zero and non-zero values)

When you update from:

• Zero to non-zero (Planned Order and Manual Demand): The page proportionally 
updates all items/dates and categories/dates to total to the new value. It uses item 
attribute Rounding Control. For example, there are four items that contribute to a 
Grand Total, their values are zero, you update Grand Total from 0 to 10, the four 
items values change to 3, 2, 3 and 2.

• Non-Zero to Non-zero (Planned Order, Forecast, and Manual Demand): The page 
proportionally updates all items/dates and categories/dates that have values to total
to the new value. It uses item attribute Rounding Control.

• Non-Zero to Zero (Planned Order, Forecast, and Manual Demand): The page 
updates all items/dates and categories/dates to zero.

After you finish updates, click Refresh View, then Yes. The page:

• Recalculates the Planned Order, Forecast, and Manual Demand items/dates and 
categories/dates to total to their new values

• Recalculates measures affected by the updates: Total Supply, Total Demand, Gross 
Requirements, and Projected Available Balance.

• Saves all changes to the database

Material Plan Display Order

The display order for Material Plan depends on your selection in the view from which 
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you navigate to the Material plan. This section provides use cases and discusses how 
the Material Plan is displayed. 

Examples, which demonstrate use cases, are given below. There are a couple of notes 
about the examples:

• The material plan displays the items you select.

• The material plan preserves the order.

• You need to determine the Item-Orgs and components that you want to view in the 
material plan.

• In these examples, your layout must be set to either Item-Orgs or Org-Item for the 
drill-downs to show properly. If your default layout is set to Cat-Org, then the 
material plan displays the Cat-Org view but only the categories for the selected 
items are displayed. Within each category, the information that is displayed is for 
the selected items only.

Material Plan in Plan Links frame: When you click on Material Plan in the Plan links 
frame, you use the set-up feature in material plan to determine the dimensions that are 
displayed. There is no change in layout in this case.

Example 1: Material Plan from Supply and Demand View

1. Select the following list of rows (pegging trees) in the Supplies and Demand view: 
Items AS66312 at TST:D2, As66312 at TST:M1, and Components CM66327, SB66324,
CM66322 at TST:M1, as shown below. Note that not all rows in a given tree are 
selected.
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2. Click Material Plan.

The Material Plan view appears.

Note: Your selection is preserved and only information that you 
selected appears on Item-Organizations.
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Example 2: Material Plan from Supply Chain Bill View

1. Select the following list of Bill-of-Material Items and components in the supply 
chain bill: AS66312 at TST:D2; AS66312 at TST:M1 and CM66322 at TST:M1. 

Note: Not all Items within a given BOM have been selected.
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2. Click Material Plan.

The Material Plan appears.

Note: Your selected Item-Orgs and your order in the Supply Chain 
Bill is preserved.
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Example 3: Material Plan from Items/BOM or Other Similar Views

1. Select a list of items from the list displayed and click on Material Plan. For this 
example, the Items View is shown.

Note: The items selected are not in consecutive order.

2. Click on Material Plan.
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The Material Plan appears.

Note: Only the selected Item-Orgs are displayed.

Resource Availability
You can:

• Search, view, analyze, and edit the resource availability used in the plan

• Add simulation set changes or manual over-rides on resource availability

• Mass edit a set of rows, for example, all dates of a particular resource, or do a 
single-row edit to update any of the following attributes

See Input Views, Resource Availability.
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Resource Plan
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view a horizontal picture of the resources.

You can edit data in this view.

Plan Tab

To drill down to resource detail, highlight cells, then click button Resource 
Requirements. 

The time bucket dates appear as the first three rows of the display. To:

• Expand a time bucket into lower level buckets, click icon Drill Expand near the date
of the higher-level bucket 

• Summarize lower level bucket detail into the higher level bucket, click icon Drill 
Collapse near the date of the higher-level bucket

Click button Setup to see the Search and Layout window where you can:

• Specify filter criteria (tab Filters)

• Specify the layout of the data columns (tab Layout)

• Specify titles for the data columns (tab Labels)

• Save the search, layout, and titles and make it your default (tab General)

You can filter on: 
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• Organization

• Resource

• Department

• Load Ratio

Measures

These are the measures available in the resource plan.

• Capacity load ratio

• Cum capacity load ratio

• Cum hours available

• Flow schedules

• Hours available

• Net ATP

• Net hours available

• Non-standard job orders

• Planned orders

• Required hours

• Run hours

• Run hour ratio

• Setup hours

• Setup hour ratio

• Sum of capacity changes

• Total resource cost

• Work orders

Resource Requirements
Most tabs share common functions, see Operating in Tabs, page 13-3.
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Use this tab to view resource requirements.

You cannot edit data in this view.

Plan Tab

You cannot firm or reschedule the resource requirements for simulation purposes

Plan Inputs Tab

You cannot make changes or add simulation changes on the resource requirements

Plan Tab and Plan Inputs Tab

Search, view, and analyze the resource requirements in the plan

Resources
You can:

• Search, view, analyze, and edit the resources in the plan and add resource changes 
to a simulation set

• Mass edit a set of rows or do a single-row edit to update attribute Bottleneck 
Resource flag.

See Input Views, Resources.

Suppliers
You can save edits in simulation sets.

See Input Views, Suppliers

Supply & Demand
Most tabs share common functions, see Operating in Tabs, page 13-3.

Use this tab to view supply and demand for an item-organization combination.

You can edit data in this view.
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It displays as a collection of trees with the pegging information collapsed under each 
supply or demand line. The pegging is based on the assignments that the planning 
solver made in its last replan.

Since the tab is a combined supply-demand display and a pegging tree, a supply or 
demand could appear multiple times, due to, for example:

• A supply pegged to multiple top-level demands

• Once as a root node as returned by search criteria and once as part of the pegging 
chain of another demand or supply

To expand all nodes completely, click Actions > Expand All

This view shows a list of column groups in the search results area.

You can set the display to show: 

• All: All columns

• Main: The major columns

• Release: Columns related to releasing

• Other: Other columns

To change the upstream (supply) or downstream (demand) orientation of the pegging 
tree, click toggle icon Supply/Demand Pegging or click Actions > Supply Pegging and 
Actions > Demand Pegging. In

• Supply pegging mode, the display begins with the top level demand and proceeds 
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to the lowest level supplies

• Demand pegging mode, the display begins with the lowest level supply and 
proceeds to the top level demands

When viewing a demand's upstream (supply) pegging, if you want to see only the 
supplies that have exceptions, click Actions > Exceptions. To cancel, click it again.

When viewing a supply's downstream (demand) pegging, if you want to see only the 
end demands that a supply pegs to and none of the intermediate levels:

• Select the supply

• Click Actions > End Demands

• To cancel, click it again 

The tab always hides these demand pegging rows:

• Transfer dependent demand

• Component dependent demand

The pegging tree shows the downstream supply pegged to the upstream supply.

The tab always hides these routing pegging rows:

• Operations for work orders

• Resource requirements for planned orders and work orders

You can click icon Add Row to add:

• Supply of type Planned order

• Demand of type Manual MDS

To delete a supply or demand that you have entered, click icon Delete Row before you 
save the row.

The fields that you can edit in each row depend on:

• Whether it is a supply or a demand

• Its order type

Since different fields apply to each order type, Oracle recommends that you perform 
mass updates on only one order type at a time. If the tab cannot update all selected 
records with the change that you want, it pops-up an error page that shows the fields 
and the rows that it cannot update with the new values.

Plan Tab
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Mass edit a set of rows, for example, priority of all orders from a customer, or do a 
single-row edit to update any of the following attributes for simulation purposes:

• Firm Status

• Firm Date

• Firm Quantity

• Alternate BOM

• Alternate Routing

• Source Organization

• Source Supplier

• Source Supplier Site

Plan Inputs Tab

You cannot edit the supplies and demands and cannot add them to simulation sets

Plan Tab and Plan Inputs Tab

Search, view, analyze, and edit the supplies and demands in the plan

Order Types

These are the demand order types that Oracle Rapid Planning works with:

• Flow schedule demand

• Flow schedule scrap

• Intransit shipment scrap

• Manual forecast

• Non-standard job demand

• Other independent demand

• Planned order demand

• Planned order scrap

• Production Forecast

• Purchase order scrap

• Purchase requisition scrap
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• Sales orders

• Work order scrap

• Work order demand

These are the supply order types that Oracle Rapid Planning works with:

• Demand class consumption

• Flow schedule

• Flow schedule by-product

• Intransit receipt

• Intransit shipment

• Non-standard job

• Nonstandard job by-product

• On hand

• PO acknowledgment

• PO in receiving

• Planned order

• Planned order co-product/by-product

• Purchase order

• Purchase requisition

• Supply adjustment

• Work order

• Work order co-product/by-product

Mass Update in the Supplies and Demand View

Similar to the Resource Availability view, mass update is available in the Mass Update 
FIRM DATE in the Supplies and Demand view. The options are:

• Reset to Original

• Set Value To
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• Sugg Due Date+

The new options and their behavior are: 

• Increment by

If Firm Date is not null: 

Firm Date = Firm Date + Entered Value

If Firm Date is null:

Firm Date = Suggested Due Date + Entered Value

• Decrement by

If Firm Date is not null:

Firm Date = Firm Date – Entered Value

If Firm Date is null:

Firm Date = Suggested Due Date - Entered Value

• Request Date +

Firm Date = Request Date + Entered Value

If you choose Request Date, the system first looks for Requested Arrival Date. If the 
Requested Arrival Date is not populated, then it uses the Requested Ship Date.

Notes:

1. Request Date + and Sugg Due Date + can have a positive or negative value.

2. For all views the mass update feature for the operators Increase by, Decrease By, 
Increase By %, Decrease By %, Sugg Due Date +, Request Date +, etc. are applied to 
the value displayed in the UI and not the value saved in the database. For this 
reason, the operators must be applied to un-saved date changes too.

Firming

You need to firm planned orders before you can process any simulation changes; click 
the planned orders to firm, then click Actions > Firm. However, you can release planned
orders that are not firm.

You can also firm:

• Work orders

• Purchase requisitions

• Purchase orders

• Forecasts
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• Sales orders

Attend to these fields for all firming:

• Firm Status

• Firm Date

• Firm Quantity

In addition, attend to these additional fields for these specific order types:

• Planned order: Alternate BOM, Alternate Routing, Source Organization, Source 
Supplier, Source Supplier Site

• Work order: <no additional fields>

• Purchase order and purchase requisition: <no additional fields>

• Forecast and sales order: Order Priority

Releasing

You can release order type planned orders in the workbench.

Before you can release them, perform some setup steps; see Releasing Planned Orders..

You can instruct the Planning Solver to automatically release some orders, see Planned 
Order Auto Release.

These are the order types that you can reschedule in the Workbench:

• Purchase orders

• Requisitions

• Work orders

• Sales orders: But not for substitute items if your source system is at release level 
12.0.

These are the order types that you can cancel in the Workbench:

• Purchase orders

• Requisitions

• Work orders

To mark an order for release, click Actions > Mark for release.

For planned orders, attend to these fields prior to release:
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• Implement Quantity

• Implement Alt BOM

• Implement Alt Routing

• Implement As

• Implement Date

• Implement Demand Class

• Implement Firm

• Implement Job

• Implement Status

• Implement Supplier

• Implement Supplier Site

• Implement WIP Class

For work orders, attend to these fields prior to release:

• Implement Quantity

• Implement Alt BOM

• Implement Alt Routing

• Implement As

• Implement Date

• Implement Firm

• Implement Job

• Implement Status

• Implement WIP Class

For requisitions and purchase orders, attend to these fields prior to release:

• Implement Quantity

• Implement As
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• Implement Date

• Implement Firm

• Implement Job

• Implement Status

• Implement Supplier

• Implement Supplier Site

For sales orders, attend to these fields prior to release:

• Firm Status

• Firm Quantity: Sales order quantity

• Firm Date: Sales order schedule date

• Order Priority

For sales orders, attend to these fields prior to release:

For sales orders, the release process:

• Actually sends fields Implement Qty and Implement Date fields to the source.

• Does not send fields Firm Status and Order Priority

• Sends field Material Available Date as sales order line Earliest Ship Date. You see 
this date in the Oracle Shipping delivery line. 

To monitor the orders during release, use field Release Status of each order. This table 
shows the values that Release Status displays.

Action Release Status 
Before Mark for 
Release

Release Status After
Mark for Release

Release Status After
Release

None available Ineligible - -

Release Release Marked for Release Released

Reschedule Reschedule Marked for 
Reschedule

Rescheduled
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Action Release Status 
Before Mark for 
Release

Release Status After
Mark for Release

Release Status After
Release

Cancel Cancel Marked for Cancel Cancelled

If you have marked an order for release, you may be able to unmark it for release. After 
you do, its Release Status returns to the value it had before you marked it for release 
(Release, Reschedule, or Cancel). Click Action > Unmark for release

Inventory Reservations

Column Reserved Quantity:

• Shows the quantity reserved from on hand against a sales order

• Displays a value only for sales orders

You cannot edit it.

If there is an inventory reservation, demand pegging for on hand displays, for sales 
orders:

• Reserved Quantity

• Pegged Qty: This can be lower than reserved quantity

In this example, sales order:

• 45678 shows a full reservation

• 12345 shows a partial reservation: The reserved and pegged quantities are different

Item Order Type Order 
Number

 Quantity Reserved 
Quantity

Pegged 
Quantity

XYZ On hand - 1000 - -

. XYZ Sales order 12345 49 49 4

. XYZ Sales order 45678 143 143 143

If there is an inventory reservation, supply pegging for on hand displays:

• For sales orders, Reserved Quantity

• For on hand, Pegged Quantity
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In this example, sales order:

• 45678 shows a full reservation

• 12345 shows a partial reservation: There are two lines for pegged quantity, one for 
the partial reservation and one for the remaining quantity that can peg to any 
supply type.

Item Order Type Order 
Number

 Quantity Reserved 
Quantity

Pegged 
Quantity

XYZ Sales order 12345 49 19 -

. XYZ On hand - 1000 - 19

. XYZ <other supply
type>

- 80 - 30

XYZ Sales order 45678 143 143 -

. XYZ On hand - 1000 - 143

The planning solver:

• Cancels the reservation if the on hand is no longer available

• Reduces the reservation if the sales order quantity is lower than the reservation

Output Plan Actions
Use the actions to act against plans. You find links to the actions in the Plan Actions 
section of the navigator in the Plan inputs tab.

Copy Plan
Use this action to make copies of plans to save or simulate.

If you want to do this in batch mode, use action Copy Simulation Plan.

Rapid Planning Plans

It opens the copy plan pop-up page with current plan as From Plan. Select Plan Type 
Rapid Planning. Once you confirm the copy, the new plan appears in the list of plans.

Baseline Plans from Oracle Advanced Supply Chain Planning

Select Plan Type ASCP. See Simulating Plans from Oracle Advanced Supply Chain 
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Planning, Copy Plan. 

Copy Simulation Plan 
Use this action to make copies of plans to simulate, for example, if you want to mass 
update demand priorities.

 If you want to do this online, use action Copy Plan.

Parameters

Source Plan Name: Select a plan.

Destination Plan Name; Enter a plan, new or existing If the copy plan exists, the process
deletes the information in it before copying.

Load Plan Parameter: Valid values are:

• Yes: This process leaves the copy plan in memory. You can view it online 
immediately after the process finishes.

• No: This process leaves the copy plan in memory. You have to open the plan to see 
it. This is the default

 You always need a managed server to run this action, regardless of this parameter 
setting.

Save Plan Parameter: 

• No: The process does not save the copy plan to the database.

• Yes: The process saves the copy plan to the database.

• Yes, Exclude KPIs: The process saves the copy plan to the database, but it does not 
save the KPI information. This is the default.

Compare Plan
Use this action to compare plans.

It pops up a list of all plans and you select one plan.

If you have any of these tabs open, they are subject to the comparison between the base 
plan and the comparison plan:

• Supply and Demand

• Horizontal plans (material & resource)

• KPIs

• Exceptions
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A tab that is subject to comparison typically:

• Automatically re-queries to show the comparison

• Gains an additional display column to show the plan name

• Does not allow for editing or drilling down of the comparison plan information

Release Plan
Use this action to perform releases, reschedules, and cancellations in the current 
selected plan.

You can release the plan if you have not loaded it into memory.

It opens a release plan page in a pop-up window and asks you to confirm the release.

After you confirm, it opens a plan status page in a pop-up window. Use this page to 
monitor the progress of each phase of the release. It displays the concurrent request 
numbers of the processes.

To see how to mark orders for release, see Rapid Planning Workbench Views, page 13-3
> Supply & Demand > Releasing.

If you are releasing a simulation that has changes to these types of data, the release 
process releases the order but does not release the component or resource requirement 
details:

• Bills of material, for example, component changes, effectivity changes

• Routings, for example, new operations

Publish Order Forecast
The publish program parameters show the available attributes that let you publish data 
from Rapid Planning to Collaborative Planning. These are very similar to the 
parameters that are enabled in ASCP-CP integration. For information on these 
parameters, refer to the Oracle Advanced Supply Chain Planning Implementation and User's 
Guide.

The table below lists the parameters that are relevant for Rapid Planning; those 
parameters that are not listed are not relevant and do not need to be published.

Parameters Description

Plan Name of the Plan inherited from the current 
Rapid Planning plan
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Organization Code Enables the publish of order forecast for a 
specific organization

Planner  

ABC Class  

Item  

Supplier Select a specific supplier

Supplier Site Select a specific supplier site – enabled for 
selection only when Supplier has been 
selected

Horizon Start Date Defaulted to current date

Horizon End Date Defaulted to current date + 1 year

Automatic Versioning Valid values: Yes or No. The default is Yes.

Last Version Published Populated with the previous version number 
that was published from the Plan in case 
Automatic Versioning is enabled

Include Purchase Orders  

Include Requisitions  

Overwrite  

Publish Supply Commits
The publish program parameters show the available attributes that let you publish data 
from Rapid Planning to Collaborative Planning. These are very similar to the 
parameters that are enabled in ASCP-CP integration. For information on these 
parameters, refer to the Oracle Advanced Supply Chain Planning Implementation and User's 
Guide.

The table below lists the parameters that are relevant for Rapid Planning; those 
parameters that are not listed are not relevant and do not need to be published.
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Parameters Description

Plan Name of the Plan inherited from the current 
Rapid Planning plan. You can change it to any
other plan.

Organization Code Enables the publish of order forecast for a 
specific organization

Planner  

ABC Class  

Item  

Customer Select a specific supplier

Customer Site Select a specific customer site – enabled for 
selection only when Supplier has been 
selected

Horizon Start Date Defaulted to current date

Horizon End Date Defaulted to current date + 1 year

Automatic Versioning Valid values: Yes or No. The default is Yes.

Last Version Published  

Publish Supplies pegged to Customer Sales 
Orders

 

Overwrite All Records (default), Horizon dates specified

Change History
Use this action to view the changes that all planners have made to a plan.

It shows the entire change log for the plan in a pop-up window.

Each change log entry shows the entity, who made the change, when they made the 
change, and the data values before and after the change.
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Clear Comparisons
Use this action after you have done a plan comparison and you want to remove the 
comparison data.

It removes all comparison plan data and returns all tabs to the base plan data.

Define Incremental Replan Scope
Use plan action Define Incremental Replan Scope to specify the scope of the replans by:

• Selecting the incremental planning mode

• Naming the entities that the planning engine plans or does not plan (supply 
selection criteria)

Supply Selection Criteria

You can limit by these selection criteria and conditions: 

• Item: Equals, Saved Selection / Favorite Equals, and That has been updated in the 
plan (updated items, bills of material, and routings)

• Org: Equals

• Resource: Equals, Saved Selection / Favorite Equals, and That has been updated in 
the plan (updated resource attributes and resource capacity)

• Item/Supplier/Supplier Site: Equals, Saved Selection / Favorite Equals, and That has 
been updated in the plan

• Pegged End Demands: Saved Selection Equals and That have been updated in the 
plan

• Supplies: Saved Selection Equals and That have been updated in the plan

These criteria are like OR searches. If a supply meets any criterion and condition, the 
action selects it.

When you select condition Saved Selection Equals, the list that you see does not include 
dynamic lists, for example top ten lists.

If you select Include pegged upstream supplies, the action selects all supplies that peg 
down to the selected supplies. 

If you select Include pegged downstream supplies, the action selects all supplies that 
peg up to the selected supplies. 

You can also use search attribute Updated in Plan = Yes to find all of the entities that the
plan updated. 
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Incremental Planning Mode 

Freeze existing plan / Replan new demands only: The planning process freezes the 
supplies and demands in the prior run of the plan and plans to meet demands that you 
add since then.

Freeze Selected Supplies / Replan all demands: The planning process replans all 
demands but does not replan the supplies that you select. It can make planned orders 
and recommend reschedule for supplies that you did not select. 

Freeze All Except Selected Supplies / Replan all demands: The planning process replans
all demands but does not replan the supplies that you did not select. It can make 
planned orders and recommend reschedule for supplies that you select.

Firm Supplies

For firm supplies, the process makes dependent component requirements and resource 
requirements firm as well.

Delete Plan
Use this action to delete plans.

This action purges the plan from memory and the database and is irrevocable.

When you run a copied plan, the planning solver needs its base plan. If you delete a 
base plan, all plans copied from it are invalid.

If you delete a plan that is a simulation from a baseline Oracle Advanced Supply Chain 
Planning plan, you receive a warning.

Release
Releasing in the Supply & Demand Tab

See Output Views, Supply & Demand.

Order Release

When you release planned orders to the execution system, this is the information that 
Oracle Rapid Planning passes.

It auto-releases planned orders within the release time fence.

Work orders:

• Job details with start date and end date timestamps of 23:59:59

• Resource details with resource scheduled start date and resource scheduled end 
date timestamps of 23:59:59

• Resource usage

• Resource hours
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• Primary or alternate bill of material and routing combination selection

• Primary or substitute component selection

• Primary or alternate resources selection

Purchase requisitions:

• Selected supplier, supplier site, and ship method

• Suggested Due Date timestamp of 23:59:59

Internal requisitions:

• Selected source organization and ship method

• Order Date timestamp of 23:59:59

Rescheduled work orders:

• End date

• If the plan determined the work order start date, all the remaining information in 
the order is new

Reschedule or cancellation of purchase requisitions:

• Order number

• Order Date timestamp of 23:59:59

Reschedule or cancellation of purchase orders:

• Order number

• Order Date timestamp of 23:59:59

Reschedule or cancellations of internal requisitions:

• Order number

• Order Date timestamp of 23:59:59

Planned Order Auto Release

You can instruct the planning solver to automatically start the release of planned 
orders, reschedules, and sales orders (auto release). After the plan completes, it starts a 
concurrent process to automatically release planned orders.

The planning solver releases planned orders and reschedules that:

• Occur in a plan that you run with a snapshot phase
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• Are for items that have a value in item-organization attribute Release Time Fence. 
You set Release Time Fence in days. 

• Have dates in their destination organization on the plan start date that are within 
their items' release time fence.

• Have Action set to Release

• Can be released manually: For example, it excludes orders for phantom items

When you run a plan with snapshot and want to use auto release, set these plan options
on the Main tab. Their default value is clear or null:

• Enable Auto Release

• If you select Enable Auto Release, enable Auto Release Reschedules

This is how the release time fence works:

• You set Release Time Fence in days. The planning solver calculates the release time 
fence as this many days after the plan start date. For example, if Release Time Fence
is 3, the release time fence date is day 4 of the plan horizon [plan start date, day 1 + 
3 days].

• The planning solver releases orders that have dates before the release time fence 
date. In this example, it releases orders in days 1, 2, and 3. But, if you run the plan 
exactly at 00:00:00, it also releases orders that have dates on the release time fence 
date.

This is how the planning solver decides whether or not to auto release:

• Planned order: Suggested start date is before (or on) the release time fence date

• Reschedule out: Old order start date is before (or on) the release time fence date

• Reschedule in: Suggested start date is before (or on) release time fence date

• Cancel: Suggested start date is before (or on) the release time fence date

During the auto release process, the planning solver:

• Does not let you view the plan

• Changes the release status of each eligible order to Released

• Updates the quantity in process of each eligible order with the released quantity

• Saves the plan to the database

• Starts a concurrent process immediately after it finishes to release eligible orders to 
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the E-Business Suite execution products. This process may start concurrent 
processes Create Releases, Requisition Import, and WIP Mass Load

• Lets you view the plan

Other auto release considerations are:

• Later simulations see the released orders as firm scheduled receipts.

• After a later replan without snapshot, those released orders remain as firm plan 
orders and marked as released. After a later replan with snapshot, the Planning 
Solver ignores them as it replans the supply and demand situation using the latest 
collected data.

Publish Sales Order Changes

You can release sales order changes to Oracle Order Management. If the sales order is 
not firmed, you can change Material Available Date and the end item substitute.

The planning solver schedules sales orders using the scheduled sales order ship date, it 
does not use the scheduled sales order arrival date. It does not suggest alternate ship 
methods to improve the scheduled arrival date. RP does not recalculate the transit lead 
time from organization to customer site. It does not schedule sales orders with schedule 
method of arrival type.

Oracle Rapid Planning does not update the source organization for sales orders with:

• Assemble to order models

• Pick to order models and their components, options, and assemble to order models. 
The planning solver does not change the source organization selected in Oracle 
Order Management as scheduled by available to promise. Sales order lines for 
components of pick to order models and kits do not receive any release 
recommendations.
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17
Plan Analysis: Late Demand Diagnosis

Overview
You can use Rapid Planning late demand diagnosis to identify:

• Late and unmet demands

• The likely reasons for them: For example, was the total lead time required less than 
the time available?

• Their impact: For example, what specific resources and suppliers should I focus on 
to make the demand satisfied on time?

As it plans to satisfy a demand, the planning solver also searches these paths: 

• Routing alternate resources 

• Bill of material substitute components 

• Alternate BOM and Routing 

• Alternate sources on sourcing rules 

• End item substitutes 

It finds these constraint failure conditions and reports them when it cannot wholly 
satisfy a demand due to any of these conditions:

• Material Constraint: Lead Time

• Material Constraint: Planning Time Fence

• Material Constraint: Date Effectivity

• Material Constraint: WIP Window
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• Resource Constraint

• Supplier Constraint

You can simulate solutions and finds the best responses.

Constraints
In this example:

• There is distribution center demand for the finished good

• The distribution center sources from manufacturing organization A, rank 1, and 
manufacturing organization B, rank 2.

• The planning solver tries to make it in organization A

• Organization A satisfies the demand two days late because of lead time constraints 
on components C1 and C2.

• The planning solver reports two constraints. 

• The planning solver tries to make it in organization B.

• Organization B satisfies the demand three days late because of lead time constraints
on components C1 and C2 and a resource constraint on resource R1.

• The planning solver reports three constraints. 

• The planning solver recommends organization A because it is the least late.
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Intermediate Level Reporting

The planning solver reports the root or leaf cause of a delay

x

• Finds a constraint failure on Sub Assembly because of a lead time constraint on 
Component C1.

• Does not report the constraint failure on Sub Assembly.

• Reports the lead time constraint on Component C1.
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Partial Quantity Shortage Constraints

If the planning solver plans to satisfy partial quantities of a demand from multiple 
organizations, it reports failure constraints from all organizations involved.

In this example:

• FG sources from organizations M1 and M2

• The planning solver satisfies a partial demand quantity on time from organization 
M1. It can't satisfy the rest because of a lead time constraint on component C1.

• The planning solver tries to satisfy the remaining demand quantity form 
organization M2. It can't satisfy it because of a lead time constraint on component 
C1.

• It reports both failure constraints.

Material Constraint Caused by Resource Constraint

Sometimes, the report of a lead time material constraint is actually caused by resource 
unavailability. For example:
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• A resource is not available on the day the planning solver needs it to complete a 
component.

• The resource is available earlier.

• The planning solver plans to use the resource earlier.

• Using the resource earlier causes a lead time material constraint on the component, 
because work on the component is scheduled to start in the past.

• The planning solver reports a lead time material constraint against the component 
and does not report a resource constraint against the resource. However, the 
resource availability is the root cause of the late demand.

• You can detect this situation by looking at the Pegging View and searching for time 
gaps.

Process
The late demand diagnosis process is:

• Copy the baseline plan to a simulation plan

• Run the simulation plan with parameter Snapshot – New demand changes and 
select launch option Calculate Lateness Constraints

• Analyze lateness using the view Analytics

• Compare the baseline and simulation plans

If you accept the latensses, continue analysis and release recommendations.

If you don't accept the latenesses, do this as many times as you need to accept the 
lateness. You can use more than one simulation plan and compare among them to 
choose the best solution:

• Check the constraints for key late demands

• Simulate corrections to fix root causes
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• Re-run the simulation plan with parameter Snapshot – New demand changes and 
select launch option Calculate Lateness Constraints

• Analyze lateness using the view Analytics

• Compare the baseline and simulation plans

You can see the late demand information in any planning mode, but the information is 
most relevant in mode Constrained – Enforce capacity constraints

Viewing
You see late demand information in the view Constraint Details.

Troubleshooting
Since the planning solver calculates constraints on all paths, it makes run times longer 
when you use it.

The planning solver exhausts all possibilities for solving a late demand only on the 
primary path.

To find all upstream constraints along the primary path, use view Constraints Detail, do
a query-by-example and filter by search path Primary.
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demand quantity, 9-44
Demantra Demand Management, 7-1
Demantra Sales, 7-1
Demantra Sales and Operations Planning, 7-6
direct change, 11-4
dock date, 8-6
due date, 8-7

E
E-Business Suite execution products, 6-1
E-Business Suite Value Chain Planning 
applications, 7-1
ECO, 9-67
editable fields, 11-4
editing plan input, 11-4
end item substitution, 8-3
End-item substitution, 9-46
engineering change cut-in scenario, 11-23
engineering change orders, 9-67, 11-1
ESG Reference Architecture, 4-1
exception messages

demand quantity not satisfied, 15-2
demand satisfied using end item substitution, 
15-2
forecasts pulled in, 15-2

items below safety stock, 15-2
items with a shortage, 15-2
items with excess inventory, 15-2
late replenishment for a forecast, 15-2
late replenishment for a pull-in sales order, 15-
2
late replenishment for forecast, 15-2
late replenishment for sales order, 15-2
late supply pegged to forecast, 15-2
late supply pegged to sales order, 15-2
order sourced from alternate facility, 15-2
order sourced from alternate supplier, 15-2
orders to be cancelled, 15-2
orders to be rescheduled in, 15-2
orders to be rescheduled out, 15-2
order with insufficient lead time, 15-2
past due orders, 15-2
planned order uses alternate bom/routing, 15-
2
planned order uses alternate resource, 15-2
planned order uses substitute component, 15-2
resource overloaded, 15-2
sales order/forecast at risk due to a resource 
shortage, 15-2
sales orders pulled in, 15-2
sourcing split percentage violated, 15-2
supplier capacity overloaded, 15-2

exceptions
overview, 15-1

execution system, 6-1

F
feature comparison, 8-3
firming, 14-
Firm supplies

firm input data, 9-42
fixed days supply, 9-15
fixed lead-time, 8-5, 8-7
flow manufacturing, 8-3
flow manufacturing items, 9-39
forecast, 3-3
forecasts, 11-1
from advanced supply chain planning, 11-15
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planed order auto release, 8-3
plan inputs, 11-1
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